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Notices
This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available
in your area. Any reference to an IBM product, program, or service is not intended to state or imply
that only that IBM product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may be used instead.
However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product,
program, or service.
IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can
send license inquiries, in writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
3-2-12, Roppongi, Minato-ku, Tokyo 106-8711
The following paragraph does not apply to the United Kingdom or any other country where
such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES
CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND,
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.
This information could include technical inaccuracies or typographical errors. Changes are
periodically made to the information herein; these changes will be incorporated in new editions of the
publication. IBM may make improvements and/or changes in the product(s) and/or the program(s)
described in this publication at any time without notice.
Any references in this information to non-IBM web sites are provided for convenience only and do not
in any manner serve as an endorsement of those web sites. The materials at those web sites are not
part of the materials for this IBM product and use of those web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
The licensed program described in this document and all licensed material available for it are
provided by IBM under terms of the IBM Customer Agreement, IBM International Program License
Agreement or any equivalent agreement between us.
Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may
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have been made on development-level systems and there is no guarantee that these measurements
will be the same on generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document should verify the
applicable data for their specific environment.
Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.
All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.
This information contains examples of data and reports used in daily business operations. To
illustrate them as completely as possible, the examples include the names of individuals, companies,
brands, and products. All of these names are fictitious and any similarity to the names and addresses
used by an actual business enterprise is entirely coincidental.
COPYRIGHT LICENSE:
This information contains sample application programs in source language, which illustrate
programming techniques on various operating platforms. You may copy, modify, and distribute these
sample programs in any form without payment to IBM, for the purposes of developing, using,
marketing or distributing application programs conforming to the application programming interface
for the operating platform for which the sample programs are written. These examples have not been
thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability,
serviceability, or function of these programs. The sample programs are provided "AS IS", without
warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample
programs.
References in this publication to IBM products or services do not imply that IBM intends to make
them available in all countries in which IBM operates.

If you are viewing this information softcopy, the photographs and color illustrations may not
appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might
be trademarks of IBM or other companies. A current list of IBM trademarks is available on the web at
“Copyright and trademark information” at www.ibm.com/legal/copytrade.shtml.
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Preface
Keeping your skills current in today's world is becoming increasingly challenging. There are
too many new technologies being developed, and little time to learn them all. The DB2 on
Campus Book Series has been developed to minimize the time and effort required to learn
many of these new technologies.

Who should read this book?
This book is intended for anyone who needs to learn the basics of database administration
and development using Data Studio, the Eclipse-based tool provided at no charge. It
replaces previous generation tools, such as Developer workbench and DB2 Control
Center. The DB2 Control Center and other DB2 tools are deprecated in DB2 9.7, so it is
important to become familiar with Data Studio and related products. The Version 3.1
release of IBM Data Studio incorporates the advanced features previously available only in
Optim Database Administrator and Optim Development Studio, making it much more
powerful for database development and administration.
Note:
This book assumes you have a basic knowledge of DB2. For more information about
DB2, see Getting Started with DB2 Express-C or the DB2 Information Center here:
http://pic.dhe.ibm.com/infocenter/db2luw/v10r1/index.jsp

A note about the third edition
Big changes have happened with IBM Data Studio since the first edition of this book was
written. The second edition of this book was updated to cover the capabilities that were
previously only available in priced versions of the database tools and have since been
consolidated into IBM Data Studio at no charge. This includes enhancements to the
database management capabilities, such as advanced change management, as well as
advanced development capabilities such as pureQuery. (Since pureQuery is the subject of
another Getting Started book, we did not cover that in this edition.) Content about basic
query tuning and the web console, previously known as the Data Studio Health Monitor
were also added in the second edition. For the third edition, this book was revised to cover
the database support for DB2 V10.1 for Linux, UNIX, and Windows as well as the
enhancements to the Data Studio V3.1.1.
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How is this book structured?
This book is structured as follows:


Chapter 1 includes an introduction to Data Studio and gets you up and running and
familiar with the Data Studio workbench (user interface).



Chapters 2 and 3 focus on database administration tasks:
o

Chapter 2 gets you connected to the database teaches you how to create and
change database objects as well as how to grant authority to others to see
those objects.

o

Chapter 3 goes into more advanced topics around maintaining the system and
providing for recoverability.



Chapter 4 introduces the new Health Monitor in Data Studio which monitors the health
of your DB2 databases, view alerts, applications, utilities, and storage.



Chapter 5 describes how to create a data development project, which is where artifacts
you create for subsequent exercises are stored. It also describes how to use the SQL
and XQuery editor (and optionally the Query Builder) to create scripts.



Chapter 6 introduces the new Job Manager which lets you create and schedule scriptbased jobs.



Chapter 7 discusses the set of basic query tuning capabilities included in Data Studio.



Chapters 8, 9, and 10 are focused on database development activities involving
creating and debugging database routines and data web services:



o

Chapter 8 covers SQL stored procedure development and debugging.

o

Chapter 9 is a short chapter on developing user-defined functions.

o

Chapter 10 is data web services development (with advanced topics in
Appendix E).

Chapter 11 provides you with more context around how Data Studio fits in with the
greater data management capabilities from IBM, and how you can build on your Data
Studio skills with use of these products for tasks such as data modeling and design,
monitoring and optimizing database and query performance, managing test data,
managing data privacy and much more.

Exercises are provided with most chapters. There are also review questions in each
chapter to help you learn the material; answers to review questions are included in
Appendix A.

A book for the community
This book was created by the community; a community consisting of university professors,
students, and professionals (including IBM employees). The online version of this book is
released to the community at no-charge. Numerous members of the community from
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around the world have participated in developing this book, which will also be translated to
several languages by the community. If you would like to provide feedback, contribute new
material, improve existing material, or help with translating this book to another language,
please send an email of your planned contribution to db2univ@ca.ibm.com with the subject
“Data Studio book feedback.”

Conventions
Many examples of commands, SQL statements, and code are included throughout the
book. Specific keywords are written in uppercase bold. For example: A NULL value
represents an unknown state. Commands are shown in lowercase bold. For example: The
dir command lists all files and subdirectories on Windows®. SQL statements are shown
in upper case bold. For example: Use the SELECT statement to retrieve information from a
table.
Object names used in our examples are shown in bold italics. For example: The flights
table has five columns.
Italics are also used for variable names in the syntax of a command or statement. If the
variable name has more than one word, it is joined with an underscore. For example:
CREATE TABLE table_name

What’s next?
We recommend that you review the following books in this book series for more details
about related topics:


Getting started with Eclipse



Getting started with DB2 Express-C



Getting started with pureQuery



Getting started with InfoSphere® Data Architect



Getting started with WAS CE
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The following figure shows all the different ebooks in the DB2 on Campus book series
available for free at ibm.com/db2/books

The DB2 on Campus book series
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Chapter 1 – Overview and installation
IBM Data Studio is a member of the IBM® InfoSphere® Optim™ family of products, which
provides an integrated, modular environment to manage enterprise application data and
optimize data-driven applications, across heterogeneous environments, from requirements
to retirement. This capability is more generally referred to as Data Lifecycle Management.
Data Studio consists of a client, which is available in two flavors, and the web-based server
console. More details about the packaging are described below, in Section 1.1.1.
The Data Studio client is built on the open source Eclipse platform, and is available on both
Windows® and Linux® platforms. You can use the Data Studio client at no charge to help
manage and develop applications for any edition of DB2® for Linux®, UNIX®, Windows®,
DB2 for i, DB2 for z/OS®, or Informix®.
Note:
A common question we get is what capabilities in IBM Data Studio are supported for
which data server. This handy document provides a matrix of supported features by
database server and release across the full client, administration client, and web console:
http://www.ibm.com/support/docview.wss?uid=swg27022148
IBM Data Studio replaces other tools that you may have used with DB2 databases in the
past. It is a great tool for working with DB2 databases and we hope that you grab a cup of
coffee or your favorite beverage, download IBM Data Studio and DB2 Express-C and put
this book to good use.
In this chapter you will:


Learn about Data Studio capabilities, packaging, and community



Make sure your environment is ready to install the Data Studio product



Install the Data Studio full client and navigate the Data Studio Eclipse workbench (the
user interface)



Install the Data Studio web console
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1.1 Data Studio: The big picture
As shown in Figure 1.1, Data Studio provides database administration and database
development capabilities for DB2. It is the primary tool for production database
administration for DB2 for Linux, UNIX, and Windows environments, but also supports
object management and routine development for DB2 for z/OS and DB2 for i. As of Version
3.1, Data Studio incorporates advanced administration and development tools from Optim
Database Administrator and Optim Development Studio, which are not being developed
any further, and Data Studio is the replacement for DB2 Control Center, which is not
developed any more and has been removed from DB2 10 for Linux, UNIX and Windows.
Version 3.1.1 of Data Studio includes support for DB2 V10.1 including Time Travel
Queries, Multi-temperature Storage, and many other enhancements to DB2.
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Figure 1.1 – Data Studio provides tools support for DB2 administrators and
developers
For data development, Data Studio enables you to:
 Use wizards and editors to create, test, debug, and deploy routines, such as stored
procedures and user-defined functions
 Use the SQL builder and the SQL and XQuery editor to create, edit, validate, schedule,
and run SQL and XQuery queries
 Format queries, view access plans, and get statistics advice to analyze and improve query
performance.
 Create, test, debug and deploy SQL or Java procedures (also including PL/SQL
procedures for DB2 in compatibility mode).
 Java procedure support is available only in the full client, described in the next section.
 Create web services that expose database operations (SQL SELECT and data
manipulation language (DML) statements, XQuery expressions, or calls to stored
procedures) to client applications. Available only in the full client, described in the next
section.
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 Use wizards and editors to develop XML applications. Available only in the full client.
 Develop JDBC, SQLJ, and pureQuery applications in a Java project. pureQuery provides
a way to accelerate Java development as well as provide insights into the Java and
database relationship. For more information about pureQuery, see the ebook Getting
Started with pureQuery. Java development is available only in the full client.
 Bind and rebind packages
 Manage routine and SQL deployments across multiple target development and test
databases.
 View and force active connections
 View and manage jobs including job schedules, success or failure notification or actions,
and job history
For data and database object management, Data Studio provides the following key
features. Typically these tasks are done on test databases that you are using to test your
applications. You can:
 Connect to DB2 data sources, filter, sort, and browse data objects and their properties
 Import and export database connections
 Monitor and view database health conditions (not available for DB2 for i)
 Use data diagrams to visualize and print the relationships among data objects
 Use editors and wizards to create, alter, or drop data objects.
 Modify privileges for data objects and authorization IDs
 Analyze the impact of your changes
 Copy tables
 View and edit table data
 These additional features are available with DB2 for Linux, UNIX, and Windows
databases:
 Manage database instances (including support for DPF and DB2 pureScale
topologies) e.g. start and stop, quiesce, configure parameters, define high availability
support, etc.
 Back up and recover databases
 Reverse engineer databases into physical models
 Compare and synchronize changes between models, databases, and the data
definition language (DDL) used to define objects in the database.
 Manage change plans to coordinate complex or related changes across objects,
including destructive changes requiring data and privilege preservation
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 Manage table data including collecting statistics, reorganizing, importing, and
exporting
 Configure automatic maintenance and logging for DB2 for Linux, UNIX, and
Windows
 Create, validate, schedule, and run command scripts
Data Studio gives you the tools you need to become immediately productive on a DB2 data
server while you build and enhance your skills into more advanced database development
and management tasks. You can read more about additional capabilities provided using
data lifecycle management solutions from IBM in Chapter 11.

1.1.1 Data Studio packaging
Data Studio is comprised of three installable images: the full client, the administration
client, and the web console.
 The full client includes all administrative capabilities as well as an integrated Eclipse
development environment for Java, XML, pureQuery, and web services. This is the client
used in this book because it provides the complete client function as well as the ability to
shell-share with other Eclipse-based tools.
 The administration client is a lighter weight subset of the full client designed specifically for
administrators to get up and running quickly and easily. You can do all the exercises in
this book with the administration client except for data web services. Java development,
pureQuery development, data web services development, and some other features are
not included in the administration client. View a list of the differences in features between
the full client and the administration client at
http://www.ibm.com/support/docview.wss?uid=swg27022148. Information about installing
the administration client is in Appendix C.
 The web console provides health monitoring, job management, and connection
management. It uses a browser interface, but you can access commonly used tasks such
as viewing database status, listing connection, viewing job history, and so on from the
Eclipse-based clients.
Note:
For more information about how these components work together and how you can
use them in a team environment, see the following topic in the Data Studio information
center:
http://publib.boulder.ibm.com/infocenter/dstudio/v3r1/topic/com.ibm.datatools.ds.releas
e.doc/topics/getstarted.html
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1.1.2 Career path
Getting skilled with Data Studio can help you prepare for a path as a DB2 database
administrator or developer. Data Studio works with all members of the DB2 family –
whether on DB2 for Linux, UNIX, and Windows, DB2 for i, or DB2 for z/OS – so the skills
you learn are transferable across those varied platforms.
At this point, there are no specific professional certifications for Data Studio; however, Data
Studio is used in DB2 certification courses such as the one to become an IBM Certified
Solution Developer – SQL Procedure Developer (Exam 735).

1.1.3 Popular community web sites and discussion forum
There is a vibrant community around DB2 data servers, which includes discussions and
information about Data Studio, including ChannelDB2.com for videos and social
networking, db2university.com for free online courses, and PlanetDB2.com as a blog
aggregator. You can read more about these communities in the ebook Getting Started with
DB2 Express-C.
There is also a developerWorks discussion forum on the Data Studio product that many
people in the community and in the software labs monitor and respond to at
www.ibm.com/developerworks/forums/forum.jspa?forumID=1086

1.1.4 Related free software
Data Studio is often used with DB2 Express-C and WAS CE. Both are software products
from IBM that you can use at no charge.
1.1.4.1 DB2 Express-C
DB2 Express-C is the free version of the DB2 database server. You can use it for
development, test, deployment in production, and also embedded in your applications. It is
built using the same code base as fee-based DB2 editions; this means that applications
developed to work on DB2 Express-C will work with no modification on other DB2 editions.
DB2 Express-C includes the Oracle compatibility feature which allows Oracle professionals
to easily work with PL/SQL, and other Oracle features in DB2. This book uses DB2
Express-C for all exercises. For more information visit www.ibm.com/db2/express or review
the ebook Getting Started with DB2 Express-C.
1.1.4.2 WebSphere® Application Server Community Edition
Data Studio (full client) lets you build and deploy web services from database objects or
queries. The examples used later in this book assume you are using IBM WebSphere
Application Server Community Edition (WAS CE) version 2.1 as the application server for
deployment of those web services. WAS CE is a lightweight Java™ EE 5 application server
available free of charge. Built on Apache Geronimo technology, it harnesses the latest
innovations from the open-source community to deliver an integrated, readily accessible
and flexible foundation for developing and deploying Java applications. Optional technical
support for WAS CE is available through annual subscription. For more information, visit
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www.ibm.com/software/webservers/appserv/community/ or review the ebook Getting
Started with WAS CE.

1.2 Getting ready to install Data Studio
This section explains the software prerequisites for Data Studio and provides links to
downloads for other software that you may find useful when going through this book:
1. Ensure that your computer is using any of the following operating systems:
Linux
- Red Hat Enterprise Linux 5.0 AS/ES x86-32 or x86-64 running in 32 bit mode
- Red Hat Enterprise Linux Desktop 6.0 AS/ES x86-32 or x86-64 running in 32 bit
mode
- Red Hat Enterprise Linux Server 6.0 AS/ES x86-32 or x86-64 running in 32 bit
mode
- SUSE Linux Enterprise Server 10 x86-32 or x86-64 running in 32 bit mode
- SUSE Linux Enterprise Desktop 10 x86-32 or x86-64 running in 32 bit mode
- SUSE Linux Enterprise Server 11 x86-32 or x86-64 running in 32 bit mode
- SUSE Linux Enterprise Desktop 11 x86-32 or x86-64 running in 32 bit mode
Note:
Other distributions of Linux, such as Ubuntu, may also be used, but are not
officially supported. Use at your own risk.

Windows
- Microsoft Windows XP Professional (SP2 & SP3) x86-32 or (SP2) x86-64 running
in 32 bit mode
- Microsoft Windows Vista (Business, Enterprise, Ultimate) x86-32 or x86-64 running
in 32 bit mode
- Microsoft Windows 7 x86-32 or x86-64 running in 32 bit mode
For the latest hardware and software prerequisites, see the system requirements on
the web at http://www.ibm.com/support/docview.wss?uid=swg27024588.
2. Review the installation prerequisites in the installation roadmap in the IBM Data Studio
Information Center:
http://publib.boulder.ibm.com/infocenter/dstudio/v3r1/topic/com.ibm.datatools.base.inst
all.doc/topics/c_roadmap_over_product.html
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You should also check the system requirements on the web for any late-breaking
changes to installation prerequisites:
http://www.ibm.com/support/docview.wss?uid=swg27024588
3. Ensure you have proper privileges. For a launchpad installation, which is what is
shown in this chapter, you must be an administrative user, which means that you can
write to the default common installation location.


On Linux operating systems, this is the root or any user who is using sudo to start
Installation Manager.



On Microsoft Windows XP operating systems, a user with write administrative
privileges is any user who is a member of the Administrators group.



On the Microsoft Windows Vista and Windows 7 operating systems, this is the user
who can use the Run As Administrator option.

4. Ensure that your user ID does not contain double-byte characters.
Note:
To perform a non-administrative installation, you cannot use the launchpad.
You must instead switch to the InstallerImage_<platform> folder in the disk1
directory, and run userinst.exe (for Windows), or userinst (for Linux).

5. If you don’t already have a DB2 data server installed, you can download and install
DB2 Express-C Version 10.1.
We will use the free version of DB2, DB2 Express-C, for this book, although any
supported version of DB2 you already have is fine as well. To download the latest
version of DB2 Express-C, visit www.ibm.com/db2/express and select the appropriate
file to download for the operating system you are using. Ideally, you should install DB2
Express-C before you install Data Studio. Refer to the free ebook Getting Started with
DB2 Express-C for more details.
6. Optionally, if you are planning on doing any data web services exercises, you can
download and install WebSphere Application Server Community Edition (WAS CE)
Version 2.1.
https://www14.software.ibm.com/webapp/iwm/web/preLogin.do?lang=en_US&source=
wsced_archive&S_PKG=dl
7. Optionally, download the Sample Outdoor Company (GSDB) sample database.
Although you can use the SAMPLE database included with DB2 for many of the
exercises in this book, we use another database, called GSDB that enables us to
illustrate more capabilities. This database represents the sales and customer
information for the fictional Sample Outdoor Company. You can download the sample
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database from the following URL:
http://publib.boulder.ibm.com/infocenter/dstudio/v3r1/topic/com.ibm.sampledata.go.doc
/topics/download.html
Figure 1.2 shows the link that you click to get the sample database used in this book. It’s
fairly large (about 43 MB), so it might take some time to download depending on your
download speed.

Figure 1.2 – Link to the GSDB database from the IBM Data Studio Information
Center
We will cover how to set up the database later in the next chapter where you will also
learn how to create a connection to the database.
8. Download the IBM Data Studio product.
To download Data Studio, find the link to the package you want on the Data Studio
download page on developerWorks (Figure 1.3):
http://www.ibm.com/developerworks/downloads/im/data/
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Figure 1.3 – Links to Data Studio downloads on developerWorks
The exercises in this book assume you are using the full client, but you can download
the administration client if you prefer and then follow the instructions in Appendix C to
install. If you want to work with the web console, you can go ahead and download that
as well.
Note:
The Installation Manager method shown in Figure 1.3 actually downloads a very small
executable file. Once that file is invoked, if you already have Installation Manager on your
machine, it'll reuse that instance of Installation Manager to install Data Studio from a
remote repository. If you don't already have Installation Manager on your system, it will
then install both Installation Manager and Data Studio, also from remote repositories.



A direct link to the registration page for the full client is here:
http://www.ibm.com/services/forms/preLogin.do?lang=en_US&source=swg-idside



A direct link to the registration page for the administration client is here:
https://www14.software.ibm.com/webapp/iwm/web/preLogin.do?lang=en_US&source=
swg-idssa
Note:
If you do not have an IBM ID already, you will need to create one. You may need to
wait for some time (perhaps even as long as a day) before being allowed to download
the code.
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After you register, you can select the Linux or Windows package. We will walk through the
installation process in the next section.

1.3 Installing the Data Studio full client
The Data Studio full client can be installed using the Launchpad GUI, which launches IBM
Installation Manager, or silently, which means you create a response file of your chosen
installation options, and then run that response file. Silent install is mainly useful for larger
installations in which installation must be pushed out to many machines.
IBM Installation Manager is a program for installing, updating, and modifying packages. It
helps you manage the IBM applications, or packages, that it installs on your computer.
Installation Manager does more than install packages: It helps you keep track of what you
have installed, determine what is available for you to install, and organize installation
directories. For more in Installation Manager, see the following topic in the Data Studio
Information Center:
http://publib.boulder.ibm.com/infocenter/dstudio/v3r1/topic/com.ibm.datatools.base.install.d
oc/topics/c_plan_imover.html
This chapter focuses on the Launchpad installation. It assumes you do not have IBM
Installation Manager installed. This means that installing Data Studio starts by installing
IBM Installation Manager. If you choose to install additional products that also use that
release of Installation Manager, you do not need to install Installation Manager again.
Figure 1.4 shows the installation process described in this chapter.
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Figure 1.4 – A basic installation flow
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Follow these steps to install the Data Studio full client:
1. After you extract the download package, start the launchpad as follows:


Windows: Run the setup.exe file located in the
ibm_data_studio_full_client_v311_windows directory as shown in Figure
1.5.

Figure 1.5 – Open the setup file from the extracted Data Studio package


Linux: Run the setup command from the root path where you extracted the image.
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2. The Welcome screen opens. Click Install Product as shown in Figure 1.6.

Figure 1.6 – Click Install Product to launch Installation Manager
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3. You are given the option for administrative and non-administrative installations. If you
have administrative privileges, click Administrative Installation to continue.

Figure 1.7 – Choose an installation type
Installation Manager opens. First, you should select which packages to install.
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4. Keep all of the default selections on the Install Packages page. The package list is
shown in Figure 1.8. Click Next to continue the installation.

Figure 1.8 – Install Data Studio packages
5. Accept the license, and then click Next.
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6. If you have not yet installed a product with Installation Manager, you should see a
screen that lets you specify the location directory for shared resources. You can keep
the default settings; however, you should plan to use a hard drive that has more space
than you think you will need for Data Studio, in the case that you want to shell-share
Data Studio with other Eclipse-based products in the future. The shared resources
page of the installation wizard is shown in Figure 1.9.

Figure 1.9 – Select a location for shared resources
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7. On the next screen, you can either create a new package group or extend an existing,
compatible package group. Because we are installing the product on a computer that
does not already have any existing or compatible package groups, we select the option
to create a new package group, as shown in Figure 1.10.

Figure 1.10 – Create a new package group for Data Studio
8. On the next screen, select any additional language translations that you want or
require, then click Next.
9. On the next screen, the list of features for Data Studio is listed. Make sure that all of
the features are selected, and then click Next.
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10. On the next screen, configure how Data Studio should access the help content. The
default setting is to access help content from the web, but you can change this setting
after you install the product. After you make your selection, click Next.

Figure 1.11 – Configuring the help system
11. Finally, review the installation options that you selected, and then click Install. This
screen is shown in Figure 1.12.

Figure 1.12 – Review summary information and then click Install
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Installation Manager begins the installation. There may be a pause in the progress bar at
some point; be sure to wait and not interrupt the processing. When the product
successfully installs, you see the screen shown in Figure 1.13.

Figure 1.13 – Congratulations! Data Studio is installed
12. Click Finish to close Installation Manager.
Now that you have installed Data Studio, you should open the product and create a
workspace.
To start Data Studio for the first time:
1. Open Data Studio:


Windows: Open the workbench from the Start menu: Start > All Programs > IBM
Data Studio > Data Studio 3.1.1 Full Client.



Linux: installation_directory/eclipse (where installation directory is the
directory where you installed Data Studio).
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2. Specify a workspace name. We use the name GettingStarted for our workspace. An
example of this is shown in Figure 1.14.

Figure 1.14 – Specifying a workspace name
Note:
A workspace is a location for saving all your work, customizations, and
preferences. Your work and other changes in one workspace are not visible if
you open a different workspace. The workspace concept comes from Eclipse.

The Data Studio workbench opens. You see the default Database Administration
perspective, including the Task Launcher, as shown in Figure 1.15.

44 Getting Started with IBM Data Studio for DB2

Figure 1.15 – The Database Administration perspective, including the Task Launcher
Note:
If by some chance you already had a workspace named GettingStarted, the perspective
appears with the default views under which you had previously saved it.
The Task Launcher highlights key tasks that are available in each phase of the data
management lifecycle. You can use the Task Launcher to open the initial context (for
example, a wizard) for these tasks. Click a tab in the Task Launcher to view the tasks that
are specific to that phase of the data management lifecycle, then click a task to get started.
The Task Launcher also links to online resources in the Learn More box. Feel free to
explore some of these materials. When you are finished with the Task Launcher, you can
click the X to close the view.
In the next section, you will learn more about perspectives, views, resources, and editors.
A perspective is a customizable configuration of views and actions that are linked to certain
tasks. A view shows the resources that are available to you, and some views contain
editors that you can use to edit data objects and items that are related to those objects.
The default perspective in Data Studio is the Database Administration perspective. Each
view is contained in a tab. Explore the views. You will learn more about the views in the
Database Administration perspective in Section 1.4.
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1.4 Touring the Data Studio Client workbench
The term workbench refers to the desktop development environment. This concept is from
Eclipse. If you are familiar with Eclipse, you may skip this section. The workbench aims to
achieve seamless tool integration and controlled openness by providing a common
paradigm for the creation, management, and navigation of workspace resources.
Each workbench window contains one or more perspectives. Perspectives contain views
and editors and control what appears in certain menus and tool bars based on a certain
task or role. So you will see different views and tasks from the Debug perspective (for Java
debugging) than you will for the Database Administration perspective.
Let’s look at the Java perspective for fun.
One way to open a different perspective is to click the Open Perspective icon shown below
in Figure 1.16 and then select Java. An alternate way to open a perspective is to use the
main menu by clicking on Window -> Open Perspective -> Java.

Figure 1.16 – Opening up a different perspective
As you can see by comparing Figure 1.15 with Figure 1.17, the Java perspective has a
different task focus (Java development) than the Database Administration perspective. The
outline in this case, for example, would work with Java source code in the editor. The
explorer shows Java packages as opposed to database objects.
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Figure 1.17 – The default Java perspective
Click the Database Administration button to switch back to that perspective. We will
describe in more detail the capabilities of the Database Administration perspective.
Tip: An easy way to open and switch between commonly used perspectives is through the
Task Navigator.

Figure 1.18 – The Task Navigator
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Note:
For more information about perspectives and views, see the ebook Getting Started with
Eclipse.

1.4.1 Touring the Database Administration perspective and its views
As we described earlier, views are the tabs you see in the workbench, such as
Administration Explorer and Properties. A view is typically used to navigate a hierarchy of
information, open an editor, or display properties for the active editor. The changes that
you make to the views (their sizes and positions), and the resources that you create in the
views are saved in your workspace, as we mentioned previously.

Figure 1.19 – Database Administration perspective views
The views shown in Figure 1.19 are described in Table 1.1.
View

Description

Administration
Explorer

This view allows you to administer a database. It automatically displays
detected databases, but you can add new database connections.
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View

Description

Editor area

Typically used to view and manipulate data. For example, the object list
editor lets you view and manipulate the objects within a database.

Outline

Displays an outline of a structured file that is currently open in the editor
area and lists structural elements. So if you were editing an XML file,
you would see the elements of the XML file in an outline format.

Properties

This view shows the properties of the object currently selected in the
workspace. For some objects, you can use this view to edit properties,
such as making changes to database objects selected in the
Administration Explorer. From this view you can also see the SQL
Results view, which opens that view, described below.

SQL Results

Shows results after you run SQL or XQuery statements.

Job Manager

If you decide to open the web console embedded in the Data Studio
client, the web console will not have all the features that the web
console opened in a web browser has. Only the job manager interface
and health monitoring pages are included in the embedded interface. In
addition, the Task Launcher and Open menu are not included in the
embedded web console. To get the full featured web console interface
you must open the web console in an external browser. However, these
extra configuration tasks are normally not needed for the day to day use
of web console.

Data Project
Explorer

This view is used by a database developer. It shows data
development projects (which you will use for SQL and XQuery
scripts, stored procedures, functions and data web services) and
data design projects.

Table 1.1 – Views in the default Database Administration perspective
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1.4.2 Manipulating views
The basic view controls are shown in Figure 1.20.

Figure 1.20 – View controls
To close a view, click on the X to the right of the view name as shown in Figure 1.19.
There’s no need to panic if you close a view accidentally. Simply open Window -> Show
View and select the view you want to re-open. (See Figure 1.21 for an example.) If you
don’t see the view that you want, click Other.
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Figure 1.21 – Opening a closed view
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1.4.3 Resetting the default views for a perspective
We encourage you to play around with the views and perspectives in the workbench. For
people not familiar with Eclipse, it can seem a bit strange to have views appearing and
disappearing. If you get to the point where you just want it back to the way it was before
you started playing, you can reset the perspective from the Window menu as shown in
Figure 1.22.

Figure 1.22 – Reset the views to the defaults for the currently open perspective
Note:
The Reset Perspective menu option shown in Figure 1.22 only resets the current
perspective. If you want to modify or reset a different perspective, you can open Window
-> Preferences, and then select General -> Perspectives. On that page, you can select a
perspective and click the Reset button. The next time that you open the perspective, it
will be restored to the default layout.

1.5 Getting ready to install Data Studio web console
The web console part of Data Studio consists of a server and a client that you use in a web
browser. The server must be running to provide its intended functionality such as health
monitoring and alerts, or scheduling of jobs. You will learn more about these capabilities in
Chapter 4 and Chapter 6, respectively. If you want to use these capabilities you must install
and configure the Data Studio web console, and this section helps you prepare for that.
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For the purposes of this book you will install Data Studio web console on your local
computer. In a production environment you would install the Data Studio web console on a
dedicated computer.

1.5.1 Installation overview and first steps
In the subsequent sections, you will learn how to install the web console. This chapter
describes the installation for single user access to the Data Studio web console using the
default administrative user ID that you create during the installation. To learn more
advanced topics such as integrating the Data Studio web console with Data Studio full
client and running the Data Studio web console in multi-user mode, see Appendix B.

Figure 1.23 – Up and running tasks
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1.5.2 Before you install
Before you install Data Studio web console, perform the following steps:
1. Review the installation requirements at:
http://www.ibm.com/support/docview.wss?uid=swg27024588
2. Review the installation prerequisites in the installation roadmap in the Data Studio
Information Center at:
http://publib.boulder.ibm.com/infocenter/dstudio/v3r1/topic/com.ibm.datatools.db.web.h
ealth.install.doc/topics/dshm_roadmap.html
3. Download the IBM Data Studio web console from here:
http://www.ibm.com/developerworks/downloads/im/data/

1.6 Installing the Data Studio web console
The server-side component of the Data Studio web console can be installed either using
the graphic user interface (GUI), through a command-line console, or through the silent
install option. The silent install option lets you edit a sample response file with your chosen
installation options, and then run that response file. Silent installs are mainly useful for
larger installations in which installations must be deployed to many computers.
Follow these steps to install the Data Studio web console:
1. After you extract the files from the download package, start the installation program as
follows:


Windows: Run the DSWC.v3.1.1.install-on-windows-x86_64.exe file
located in the Data Studio web console installation media.



Linux and UNIX: Run the DSWC.v3.1.1.install-on-<platform>.bin
command from the root path where you unzipped the image.

2. The splash screen opens. Select a language, if applicable, and then click OK to
continue with the installation.
3. The Welcome screen opens. Close all other applications and click Next.
4. Accept the terms of the license agreement, then click Next to continue.
5. Select Install a new product to install the Data Studio web console as shown in Figure
1.24. You can select a directory of your choice, or you can use the default installation
directory. Click Next.
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Figure 1.24 – Install a new copy of Data Studio web console
Note:
You can also use the installation program for the Data Studio web console to update an
existing installation of IBM Data Studio Health Monitor (the predecessor product to the
Data Studio web console). If you choose to update an existing Data Studio Health
Monitor installation, all of the existing product settings except for the port numbers and
the default administrative user ID are transferred over from the previous installation. You
must specify new product port numbers and a new default administrative user ID for the
Data Studio web console.
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6. Specify a user ID and password for the default administrative user as shown in Figure
1.25, then click Next.

Figure 1.25 – Specifying a user ID and password for the web console
Note:
You can use the default administrative user ID to log in to the web console in single-user
mode, and to perform web console administrative tasks such as adding database
connections and configuring email alerts. The web console default administrative user ID
is separate from the other administrative user IDs that are used with the product, such as
the database user IDs that are required when you add database connections. If you want
to allow additional users to log in with their own user IDs, you must configure the Data
Studio web console for multi-user access. For more information, see Appendix B.
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7. Specify the port numbers that will be used to connect to the Data Studio web console.
You must enable at least one port to be able to log in to the web console. In addition to
the web console URL ports, you must also specify a control port that is used locally by
the application as shown in Figure 1.26. Make sure that the three ports you selected
are not used by any other products that you have installed on your computer.

Figure 1.26 – Specifying the port numbers that the web console uses
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8. Verify that the installation information is correct as shown in Figure 1.27. If you need to
make changes to anything you have entered, click Previous to step back through the
installation program and correct the entry. Then click Install to install Data Studio web
console on your computer.

Figure 1.27 – Review your installation preferences, then install
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9. After the installation program completes you can select the option to open the web
console to log in to the product locally, as shown in Figure 1.28. Then click Done to
close the installation program.

Figure 1.28 – Optionally open the web console
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10. Log in to the Data Studio web console with the default administrative user ID and
password that you specified during the installation.

Figure 1.29 – Log in to the web console
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1.6.1 Accessing the web console
You can access the web console in the following ways:


Manually enter the web console URL in a browser



Use the Windows Start menu on the computer that has Data Studio web console
installed



Open it from within the Data Studio full or administration client

To access the web console from this computer or from a computer other than the one you
installed the product on, enter the following URL in a web browser:
http://<IP_address>:<port_number>/datatools/

Note:
The following URLs are the default URLs for the Data Studio web console:
http://localhost:11083/datatools/
https://localhost:11084/datatools/
Important:
Before you open the web console from your web browser, make sure that you have the
Adobe Flash Player plug-in installed in the browser.

On Windows you can also open the web console on the computer on which you installed
the web console from the Start menu by clicking Start -> All Programs -> IBM Data Studio > Data Studio Web Console V3.1.1 -> Web Console or Web Console (Secure).
If you use the Data Studio full client or administration client, you can also open the Data
Studio web console that is embedded within the workbench. You can use the health pages
of the embedded web console to view alerts, applications, utilities, storage, and related
information and use the job manager pages to create and manage script-based jobs across
your connected databases. You can also schedule scripts as jobs directly from the Data
Studio client SQL script editor.
For more information on how to embed the Data Studio web console in Data Studio client,
see Appendix B.
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1.7 Exploring the web console’s Task Launcher
When you are logged in to Data Studio web console, you will see the Task Launcher page,
which lists a number of key tasks and getting-started tasks as shown in Figure 1.30.
Note:
For a complete list of the available web console tasks, click the Open menu.

Figure 1.30 – The web console opens on the Task Launcher page
The Task Launcher shows you the most common Data Studio web console tasks, such as
the following tasks:


Add database connections: Before you can do most tasks in the web console, you
must have a connection to the database.



View health summary: View a summary of health alerts and indicators by severity and
time for all of your databases.



View alerts: View and respond to alerts for your databases.



Manage database jobs: Create jobs and schedule them to run on your databases.
View status details for jobs.
Important:
More information about adding database connections is described in Chapter 4, Section

62 Getting Started with IBM Data Studio for DB2
4.3. Depending on your environment, you might have one or more databases running.
Once your database connections have been added, you can use the Data Studio web
console to begin monitoring the health of these databases (Chapter 4). You can also
create and schedule scripted jobs on these databases using the job manager (Chapter
6).
Note:
This book is written with the assumption that you will use the default administrative user
as the only user that will log in to the web console. To add additional users for the web
console you must select a repository database, set up access to the repository database,
and then grant log in privileges to the web console to the users of the repository
database. For more information about configuring Data Studio web console for multiple
users, see the Getting Started part of the Task Launcher and also Appendix B.

1.8 Exercises
In this set of exercises, you will install Data Studio, get comfortable using the
workbench/Eclipse controls, and install the Sample Outdoor Company database.
1. Install Data Studio following the instructions in this chapter.
2. Spend some time getting comfortable with the Data Studio workbench. For example,
perform some of the following tasks:


Change to the Data perspective.



Close the Outline view.



Minimize and maximize some of the view windows.



Find the menus for each of the views.



Reset the Data perspective to its default setting.

3. Optionally, set up the Sample Outdoor Company database by using the instructions
here:
http://publib.boulder.ibm.com/infocenter/idm/docv3/topic/com.ibm.sampledata.go.doc/t
opics/config_interactive.html
See Appendix D for more information about the Sample Outdoor Company database.
We’ll show you how to create a connection to the GSDB database in the next chapter.
4. Explore the product documentation. For Data Studio, the online information topics are
included in the IBM Data Studio information center at
http://publib.boulder.ibm.com/infocenter/dstudio/v3r1/index.jsp and shown in Figure
1.31. Read the product overview and take the relevant tutorials.
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Figure 1.31 – IBM Data Studio Information Center Welcome screen
Note:
As shown in Figure 1.31, the Data Studio Information Center also includes information
about IBM InfoSphere Optim pureQuery Runtime, because there is a development-only
license of pureQuery Runtime included for use on the same computer as Data Studio.
In addition, the information center includes links to previous releases of the products (in
pale gray bar) and to other products in the InfoSphere Optim Data Lifecycle Tools
portfolio (under the task-oriented tabs in the black bar).
In the next set of exercises you will install Data Studio web console, add a database
connection to the Sample Outdoor Company database, and use the task launcher to get
comfortable using the web console interface.
1. Install Data Studio web console using the instructions in this chapter.
2. If you haven’t already done so, set up the Sample Outdoor Company database using
the instructions you can find here:
http://publib.boulder.ibm.com/infocenter/idm/v2r2/topic/com.ibm.sampledata.go.doc/top
ics/config_interactive.html
3. Explore the Data Studio web console overview documentation. For Data Studio web
console, the online information topics are included in the Data Studio Information
Center at http://publib.boulder.ibm.com/infocenter/dstudio/v3r1/index.jsp

1.9 Summary
IBM Data Studio provides tools support for database administration and data development
tasks for any member of the DB2 family, making it much easier to learn skills for a
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particular database system and to transfer those skills to other database systems and
platforms.
Data Studio is provided at no charge for download and full IBM support is provided for
anyone who has a current license of a DB2 data server or Informix server. There is also an
active discussion forum at
www.ibm.com/developerworks/forums/forum.jspa?forumID=1086 that can provide informal
support.
The Data Studio client is built on the open source Eclipse platform and, if you are using the
full client, it can shell share (be installed into the same Eclipse instance) with other
products that are on the same release of Eclipse, including other InfoSphere® Optim and
Rational® products. This creates a rich and seamless environment in which you can tailor
the capabilities of your workbench to the roles you perform on the job. You will learn more
about some of these other products and capabilities in Chapter 11.
This chapter also covered the details of installing the Data Studio full client. Installation
instructions for the administration client are described in Appendix C.
We also reviewed how to navigate the Eclipse workbench for Data Studio, including how to
open up different perspectives and how to manipulate views in a perspective.

1.10 Review questions
1. What open source platform is the Data Studio client built on?
2. Which IBM products does Data Studio support?
3. What are “perspectives” in an Eclipse-based product such as Data Studio?
4. What is the default perspective after you install the Data Studio client?
5. True or false: Data Studio can be used at no charge with supported databases.
6. Which of the following development capabilities is not included in Data Studio?
A. Development of SQL and Java stored procedures
B. Development of SQL and Java user-defined functions
C. .NET development
D. SQL and XQuery scripting
E. Web Services development
7. Which of the following database administrative capabilities is provided in Data Studio?
A. Browse data objects and view their properties
B. Recover databases
C. Create, alter, and drop database objects
D. Authorize users to access database objects
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E. All of the above
8. Which of the following correctly reflects the installable components for the Data Studio
product?
A. Binary and source
B. Full client, administration client, and web console
C. C++ and Java
D. Free and chargeable
E. None of the above
9. What is the name of the Eclipse view that is used to browse of the projects that hold
SQL scripts, data web services artifacts, and stored procedures?
A. Thin Client
B. Data Source Explorer
C. Data Project Explorer
D. Outline
E. None of the above
10. In which Eclipse view do results of SQL operations appear?
A. Data Source Explorer
B. Properties
C. Data Project Explorer
D. Editor
E. None of the above
11. What is the default user ID of the default administrative user that is created for the Data
Studio web console when you install the software?
12. True or False: The Data Studio web console can be viewed by itself within a browser or
embedded within the Data Studio full or administration client.
13. Which of the following capabilities is not supported from the Data Studio web console:
A. Configure and view health alerts for supported databases
B. Deploy data web services
C. Schedule jobs to run automatically, such as SQL scripts or utilities.
D. Configure database connections.
14. What is the default page that opens the first time you log into Data Studio web
console?
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15. What additional configuration steps are required to start using Data Studio web console
after you have added your first database connection?
A. Configure alert thresholds for all alert types
B. Add a repository database
C. Add web console users and configure their privileges
D. Configure all Data Studio web console services
E. No additional steps are required
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Chapter 2 – Managing your database
environment
Whether you are a developer or database administrator, everyone working with or
connecting to a database, needs to understand the basics of managing their database
environment. This chapter discusses how to manage your DB2 database environment
using Data Studio.
In this chapter you will learn:


How to stop and start a DB2 instance



How to create and connect to a database and navigate through the database.



How to create tables, views and indexes and deploy them using a change plan



How to manage users and grant them access to database objects



How to generate entity-relationship diagrams



How to work with existing tables to edit data and generate DDL

Note:
This book does not explain basic DB2 concepts, but shows you how to work with them. If
you are not familiar with DB2 Express-C, review the Getting Started with DB2 Express-C
book, which is part of this DB2 on Campus series.

2.1 Managing your database environment: The big picture
As mentioned in Chapter 1, Data Studio is the successor of other tools, such as the DB2
Control Center. Control Center was officially deprecated in DB2 9.7, which means it is still
supported in DB2 9.7 but will no longer be enhanced and will be removed from a
subsequent release of DB2. Data Studio includes support for many database administrator
tasks, which are shown in Figure 2.1.
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Figure 2.1 – Database administrators have a wide range of responsibilities
Figure 2.1 shows the basic tasks that any database administrator needs to perform. There
are other responsibilities such as complying with data privacy requirements that are
beyond the scope of Data Studio but are covered in other IBM solutions. You can read
more about this in Chapter 11.
This chapter briefly explains some basic things database administrators need to know,
such as managing instances and connections, and then goes into managing objects, views
and indexes and granting privileges. In the next chapter, we will describe tasks required to
support availability and maintenance, such as managing table spaces, updating statistics,
importing and exporting data, managing user privileges, and managing buffer pools.

2.1.1 Database Administration perspective
The Database Administration perspective, as the name suggests, focuses on database
administration tasks. You may notice that this perspective is similar in many ways to the
Data perspective, and you can do the same tasks in the Data perspective; however, the
Database Administration perspective is tailored to suit the needs of database
administrators and is laid out to provide a more straightforward user interface for those
tasks.
You can switch to the Database Administration perspective by going to Window -> Open
Perspective -> Other and selecting Database Administration. Figure 2.2 shows the views in
the Database Administration perspective. For more details regarding the perspectives and
their views refer to Chapter 1.

Chapter 2 – Managing your database environment

69

Figure 2.2 – The default Database Administration perspective
The Administration Explorer displays an overview of your databases. When Data Studio
starts, it reads the local DB2 client catalog and then automatically creates connections to
databases on the local machine. You can also create your own connections as explained in
the following sections.
When you expand the All Databases folder, the Administration Explorer will display the
machines that your DB2 servers run on. Under each machine, the databases are organized
into instances, which will be explained in the following section. Below the instance nodes,
you will see connection objects to each database.
The object list editor allows you to sort, and filter lists of database objects such as tables,
views, and indexes. When you select a folder of objects in the Administration Explorer, the
object list editor will display a list of the objects of that type in the database.
The Properties view displays the attributes of the current selection in Data Studio. When
you select a database object in the object list editor, the Properties view displays the
attributes of that object.
The Data Project Explorer shows the projects created to keep track of your work in Data
Studio. Some projects will be created automatically to store your changes to databases.
You may also create new projects to organize your own scripts, stored procedures and
packages.
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2.2 Working with your DB2 databases
In this section you will learn how to create a new database, or work with an existing
database. You will also learn how to connect to a database, create connection profiles, and
explore database objects.

2.2.1 Creating a new database
To create a new database in the Administration Explorer:
1. In the Administration Explorer, click on the down arrow next to the New drop-down
arrow to expand the options. Select New Database as shown in Figure 2.3.

Figure 2.3 – Creating a new database from the Administration Explorer
2. In the New Database window, complete the required fields for the instance where the
database will reside. The instance detail fields are explained in Table 2.1 and
illustrated in Figure 2.4.

Chapter 2 – Managing your database environment

71

Figure 2.4 – Instance details for a new database
Field
Host name

Description
The IP address or host name of the system where the DB2
server is installed. You can use localhost for a database on
the local machine.

Port

The port number where the instance is listening. By default,
DB2 instances use port 50000.

Instance name

The name of the instance where the database will reside. The
default instance is DB2.

Instance version

The version of DB2 installed for this instance

User name

The user ID that will be used to create the database

Password

The password of the specified user

Table 2.1 – Instance detail fields for a new database
3. After completing the fields in the New Database window, verify that you can connect
to the data server instance by clicking Test connection. This step verifies that the
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details that you have entered are valid. If you can successfully connect to the data
server instance, you will see a message that the connection was successful.
4. Click Finish. The database creation assistant opens in the editor view, as shown in
Figure 2.5.

Figure 2.5 – Reviewing and completing the database creation assistant
In Figure 2.5, we specify that the database name is NEWDB and that the C:\ drive is
the database location. We use the default values for the rest of the options. We will talk
more about the database options in next chapter. You can see the command that will
run by clicking on the Preview Command link (you may need to scroll down the editor
window to see the command).
5. Click Run. This action may take a minute or slightly more time to complete. After the
command runs successfully, you see NEWDB database in the Administration Explorer.
The new database is shown in Figure 2.6.
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Figure 2.6 – The new database is created in the Administration Explorer

2.2.2 Connect to a database in the Administration Explorer
To connect to a database from Data Studio, such as the NEWDB database that was created
above, ensure that it is visible in the Administration Explorer. If it is visible, select it, rightclick on it and select Connect. The Properties window for the database opens, as shown in
Figure 2.7.
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Figure 2.7 – Reviewing the properties for a database in Data Studio
The database name and the URL will be completed by default. Specify the user ID and
password and click OK. You can select Save password option to save the password to
easily connect in the future.
Note:
If for any reason the window shown in Figure 2.7 above does not open automatically,
or if you get an error message, right-click the database, and then select Properties.
Review all of the properties and make sure that all the values are correct for your
database. If anything is wrong, fix it and try the connection again.

2.2.3 Adding an existing database to the Administration Explorer
By default, the Administration Explorer displays a list of databases on the same machine
with Data Studio. If you want to connect to a database on another machine, you can add
that database to the Administration Explorer. To do this, click the New drop-down arrow in
the Administration Explorer, then select New Connection to a database. In the New
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Connection window, select the data server type, and then complete the fields. An example
of a new connection is shown in Figure 2.8.

Figure 2.8 – Connection to an existing database
As shown in Figure 2.8, specify the database name, host, port number, user ID, and
password for the database connection. The details in Figure 2.8 create a connection to the
SAMPLE database, but you could also connect to a database on another machine if you
have one available. Click the Test Connection button on the bottom left side of the panel to
test the connection. If you can connect, click Finish.
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2.2.4 Reusing connections with connection profiles
When you created a connection to an existing database in the previous section, you
created a connection profile. Connection profiles store the details about how to connect to
a database in a file so that other members of your group can share and re-use the same
connections. Connection profiles also allow you to save the password and standardize the
JDBC driver for each connection.
Note:
To learn more about exporting and importing connection profiles, see the following topic
in the Data Studio Information Center:
http://publib.boulder.ibm.com/infocenter/dstudio/v3r1/topic/com.ibm.datatools.connection
.ui.doc/topics/cdbconn_impexp.html
For a more advanced solution that gives database administrators an efficient way to
share connections with others on the team, see the developerWorks article entitled
Managing database connections using the Data Studio web console, which you can find
here:
http://publib.boulder.ibm.com/infocenter/dstudio/v3r1/topic/com.ibm.datatools.connection
.ui.doc/topics/cdbconn_impexp.html

2.2.5 Organizing databases with instances
A DB2 instance is a logical database manager environment where you catalog databases
and set configuration parameters. When you install DB2 on Windows, the installer creates
a default instance called DB2. On Linux and UNIX, you select the name of the initial
instance during installation. Data Studio has tools to help you manage instances, however,
to create or drop instances, you will need to use another tool such as the DB2 command
line processor on Windows, or from a Linux/UNIX shell.

2.2.6 Stopping and starting instances
To view the instance associated with your current database, in the Administration Explorer,
expand the tree under the machine node that your database server runs on as shown in
Figure 2.9.
Note:
For instances that are automatically created by Data Studio, you might see the port
number instead of the actual instance name. This is automatically updated once you
connect to any database under that instance.
To start or stop the instance, select the instance and right-click it. You will see the options
to start or stop it, as shown in Figure 2.9. You can also perform other operations at the
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instance level, such as instance configuration, quiescing an instance, and so on. You can
explore these options on your own.

Figure 2.9 – Performing a database action, such as stopping or starting an instance

2.3 Navigating the database
So far, we used the Administration Explorer to navigate between databases. By expanding
a database in the Administration Explorer, we can select a folder of objects, such as
schemas, and explore a list of those objects in the object list editor. The object list editor
can narrow down the list of objects using several kinds of filtering.

2.3.1 Filtering the object list editor
Since a database might have hundreds or thousands of tables, schemas, and other
objects, you should filter the object list editor to display only the objects you are interested
in. If you know the name of the object, you can filter the object list editor to show objects
that have that name.
To filter in the object list editor:
1. Connect to the GSDB database, as described in Section 2.2.2.
2. Expand the folders under the GSDB database and select the Schemas folder.
A schema organizes database objects, such as tables and views. When you select
the Schemas folder in the Administration Explorer, the object list editor displays a list
of all of the schemas in the GSDB database.
3. Type the first few letters of the object name in the search box, as shown in Figure 2.10.
For example, type GOS to filter out the system schemas and display only the schemas
that are part of the GSDB data model.
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Figure 2.10 – Filtering schemas in the object list editor
You can also use special characters to further filter the items in the object list editor:


Use the % character as a wild card that matches any number of characters in the name. For
example, GOSALES% would match the GOSALES and GOSALESCT schemas.



Use the underscore (_) character to match any single character. For example, if you type
GOSALES_T, the list displays only the GOSALESCT schema.

2.3.2 Exploring objects with the Show menu
Data Studio also provides a way to navigate to other objects that are related to an object
displayed in the object list editor. When you right-click on an object, the Show sub-menu
displays options for navigating to related objects.
Let's briefly explore the Show sub-menu by displaying a list of tables in a schema. Rightclick the GOSALES schema in the object list editor. In the Show sub-menu, select Tables,
as shown in Figure 2.11. The object list editor will display the list of tables under the
GOSALES schema. You can return to the list of schemas by clicking on the back button in
the top left of the object list editor’s toolbar.
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Figure 2.11 – Locate related items with the Show menu

2.4 Creating database objects
After you create or connect to a database, you can create database objects such as tables,
views, and indexes. This section will show you how to create these objects, and how to
create a schema to collect these new objects into a group.
In previous versions of Data Studio, you needed to deploy each change to the database
individually. Starting in version 3.1, Data Studio allows you to create change plans that
group one or more related changes together and deploy them in a single step. This section
will show you how to create a new schema and deploy it. Then, you will create a new table,
a new index, and a new view that you will deploy in the same change plan. You will then
deploy the change plan to create these objects in the database at the same time in Section
2.4.5.

2.4.1 Creating schemas
A DB2 schema allows you to organize database objects together and prevent name
conflicts when two objects may share the same name. While some of the schemas are
already created by the DB2 installation to store system catalog tables, you can create your
own schema to group together objects that you create.
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To create a schema:
1. In the Administration Explorer, expand the tree under your database (you may need to
make sure that you are connected to the database first). Right-click the Schemas folder
and select Create Schema as shown in Figure 2.12.

Figure 2.12 – Creating a new schema
2. In the General tab of the Properties view, specify a name for the new schema (we used
MYSCHEMA) and do not change any other default attributes.
In the object list editor, you will see a blue delta button (
) next to the new schema
and a blue bar across the top of the object list editor. This planned changes bar opens
when you have made changes to the database that have not yet been deployed to the
database.
To deploy MYSCHEMA to the database:
1. Click the Review and Deploy Changes button (
) in the planned changes bar. The
Review and Deploy window opens, as shown in Figure 2.13.
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Figure 2.13 – Deploying MYSCHEMA to the database
2. In the Review and Deploy window, click Run.
In the upcoming sections, you will use the same steps to deploy multiple database objects
at the same time.

2.4.2 Creating tables
To create a table:


Right-click the Tables folder and select Create Table. This opens a window where you
must select the schema in which to create the table. Select the MYSCHEMA schema and
click OK. The Properties view displays the attributes of the new table, as shown in
Figure 2.14.
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Figure 2.14 – Creating a new table
2. Enter the name of the table in the General tab. We used MYTABLE in this example.
3. Use the Columns tab to define the columns for this table. Click the New icon (
create a new column. This step is shown in Figure 2.15.

) to

Figure 2.15 – Adding columns to a new table in the Properties view
4. Fill in the details for the column (you may need to resize the object editor window to
see all the fields). In the example shown in Figure 2.15, we have added three
columns:
 EMP_NAME, which uses the VARCHAR(248) data type


EMP_ID, the primary key, which uses the CHAR(5) data type



ADDRESS, which uses the XML data type

Table 2.2 below describes each of the fields.
Field
Name

Description
Name of the column.
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Field
Primary Key

Description
Click this box if you want this column to be the primary key for the
table.

Data Type

Data type of the column. Click in the field to activate it for editing and
then open the pull down menu to see all the data types supported in
the drop down menu.

Length

The length of the column. For some of the data types it is fixed and in
those cases you cannot edit this.

Scale

Specify the scale for the column type wherever applicable. Again, if it’s
not applicable to this data type, you won’t be able to edit this.

Not Null

Click the box if the column value cannot be null. This option is
automatically selected for primary key columns, because primary keys
are not allowed to be null.

Generated

Click this box if you want the DB2 system to automatically generate
the value of this column based on a default value or expression that
you provide.

Default
Value/Generate
d Expression

If the Generated box is selected, you need to specify a default value or
an expression that the DB2 system will evaluate to generate the value
of this column whenever a value is not specified in the INSERT
statement. For example a total salary column can be the sum of basic
salary (column name basicSalary) and allowances (column name
allowances). You can specify for salaryColumn as Generated
expression of basicSalary + allowances

Table 2.2 – Column details
In the planned changes bar of the object list editor, you will see the count of changed
objects update to include the new table. In Section 2.4.5, you will deploy the new table to
the database with other objects in a change plan.

2.4.3 Creating indexes
To create an index on a column of the table:


Right-click the Indexes folder in the Administration Explorer and select Create Index.
You must specify what table will use this index. Expand the MYSCHEMA node and select
the MYTABLE table, as shown in Figure 2.17, and click OK. The Properties view for the
new index opens.
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Figure 2.16 – Defining a new index for a table


In the General tab, specify a name for the index (or use the default name).



In the Columns tab, select the columns that will be used for the index. To select the
column, click the ellipsis button (…). The Columns tab is shown in Figure 2.17. In this
figure, the mouse is hovering over the ellipsis button.
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Figure 2.17 – Choosing columns for an index
The Select Columns window opens.


Select the columns for the index, as shown in Figure 2.18. Select the EMP_NAME
column and click OK.

Figure 2.18 – Selecting the columns of the index
In the planned changes bar of the object list editor, you will see that the count of new or
changed objects updated to include the new index. In Section 2.4.5, you will deploy the
new index to the database with other objects in a change plan.
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2.4.4 Creating views
Views provide another way of representing the data that exists in the tables of a database.
Views don’t contain the data, but they allow you to write SELECT and JOIN statements to
represent data stored in tables without exposing the details of how the data is actually
structured. You can use a view to select an entire table, join together multiple tables, or
omit specific columns as a way to restrict access to the data.
To create a view of columns in a single table or in multiple tables:
1. Right-click the Views folder in the Administration Explorer and select Create View. You
must select the schema in which to create the view. Select MYSCHEMA and click OK.
The Properties view will display the attributes of the new view, as shown in Figure 2.19.

2.19 – Defining a new view
2. In the General tab, specify the name of the view, MYVIEW.
3. In the SQL tab, define the columns for this view, using an SQL query. Type the
following query in the Expression field to select the EMP_ID and ADDRESS columns
from MYTABLE:
SELECT "EMP_ID", "ADDRESS" FROM "MYSCHEMA"."MYTABLE"
4. Click Update to update your view definition.
In the planned changes bar of the object list editor, you see the count of new and changed
objects updated to include the new view. In the next section, you will deploy the new view
to the database, along with the other objects in the change plan.

2.4.5 Deploying multiple changes with a change plan
In the previous sections, you created a set of changes to a database in a change plan. A
change plan groups multiple related changes together and allows you to deploy them in a
single step. This section will show you how to deploy the changes to the database.
To deploy the change plan to the database:
1. In the object list editor, review the number of new and changed objects by clicking the
delta icon. Then, click the Review and Deploy Changes button, shown in Figure 2.20.
Data Studio opens the Review and Deploy window, with a preview of the commands
that will be used to deploy the changes to the database.
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Figure 2.20 – Review and deploy the changes from the object list editor
The Review and Deploy window opens, as shown in Figure 2.21. The options in this
window determine how the commands will deploy the changes to the database.
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Figure 2.21 – Running the commands from the Review and Deploy window
The Save data path defines the location where Data Studio will store any backup files
that are needed to preserve the contents of the database tables. When you enable the
Save data option, Data Studio will create backup files for any dropped tables and
changes that require you to drop and recreate a table.
To control how Data Studio maps the columns of an existing table to the columns of
the changed table, you click the Column Mapping button. If you add and remove
columns from a table, you should review how Data Studio plans to map the columns.
The Advanced Options window specifies which supporting commands Data Studio
should generate with the commands that change the objects. For example, if you do
not want Data Studio to generate RUNSTATS commands for changed tables, you can
disable the Generate RUNSTATS commands option in the advanced options.
You could also edit the commands in the SQL and XQuery editor by clicking the Edit
button. Or you could schedule the changes for a future time by clicking Schedule.
2. Deploy your changes by clicking Run.
The progress of the deployment commands is shown in the SQL Results window, as
shown in Figure 2.22. When you deploy the commands to the database, the planned
changes bar no longer opens in the object list editor because your local objects match the
objects in the database. You can review past change plans by selecting the Change Plans
folder in the Administration Explorer.
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Figure 2.22 – The SQL Results view shows the progress of the commands

2.4.6 Altering tables
The object list editor provides an object editor that can be used to create new or alter
existing objects, including tables. In order to make changes to an existing table, right-click
the table in the list of tables and select Alter. The attributes of the selected table
(GOSALES.PRODUCT) are displayed in the Properties view, as shown in Figure 2.23.
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Figure 2.23 – Using the Properties view to alter a table
Use the Properties view to alter several properties of a database table, including its name,
compression, privileges, distribution key, data partitions and dimensions, table spaces and
table columns. You can also view the table’s statistics and relationships in the Properties
view, as well as the list of objects possibly impacted by changes to the table.
After you have made the changes you want to apply to the table, you can deploy the
changes by clicking the Review and Deploy Changes button in the object list editor, as
described in Section 2.4.5.

2.5 Managing database security
Securing data against unauthorized access is one of the most important tasks for the
database administrator. You can secure data by granting only the specific privileges that a
user needs. This topic will cover adding users and managing privileges on those users.

2.5.1 Creating users
Data Studio can help you to create and manage roles in the same object list editor that
you used in the previous section to manage database objects. In the following steps, we
will create a role to allow developers to create and alter database objects in a single
schema.
Note:
Though the Data Studio menus use the phrase Create User, this may incorrectly give
you the impression that you can create and store users in a DB2 database by default;
this is not the case. User creation is left by default to an external facility such as the
operating system, LDAP, active directory, and so on. If you would like to create and store
users in the DB2 system you can create your own plug-in to accomplish such
mechanism as described in the article Develop a security plug-in for DB2 database
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authentication, which can be found at:
http://www.ibm.com/developerworks/db2/library/techarticle/dm0802kligerman/index.html). In this section we use the phrase Add User instead.

To add a new user:
1. In the Administration Explorer, expand the Users and Groups folder. Right-click on
the Users folder and click Create User.
2. The attributes of the new role are displayed in the Properties view. In the General
tab, enter the name of the new user, MYUSER, in the name field.
3. In the Privileges tab, click the >> drop-down arrow and select Schema, as shown
in Figure 2.24.

Figure 2.24 – Navigating to schema privileges for the new user
4. Click the Grant New Privilege button (
the GOSALES schema, and click OK.

). In the Select a Schema window, select

5. Select the check boxes in the grid to grant ALTERIN, CREATEIN, and DROPIN
authority to MYUSER, as shown in Figure 2.25.

Figure 2.25 – Granting privileges to a user
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6. In the object list editor, click on the Review and Deploy Changes button and run
the DDL to deploy the role to the database, following the steps outlined in Section
2.4.5.

2.5.2 Assigning privileges
Whenever you create an object, you can give the privileges associated with that object to
the different users available. Figure 2.26 shows the Privileges tab that opens for table
creation in Data Studio. You can use the same Privileges tab to change an existing object
by right-clicking the object and selecting the Manage Privileges action.

Figure 2.26 – Privileges option while creating a table
If you don’t see the user already in the Privileges tab, click the Grant New Privilege button.
A new row is created, which will allow you to select the grantee, and then grant privileges
to the user on that object.
You grant the user the appropriate privilege by selecting the check boxes in the row of the
grid. If you click on an option twice, you can also give the user the authority to grant the
privilege to others (WITH GRANT OPTION). This authority on the MYUSER user is shown in
the ALTER privilege, displayed in Figure 2.26.
For most of the objects that you create in Data Studio, you will find a Privileges tab
wherever applicable, and you can use the above method to give appropriate privileges to
the different users. You can also find the Privileges tab in the Properties view of a user,
where it will allow you to grant privileges on multiple objects for that specific user.
Note:
For more information about privileges, see the following topic in the DB2 information
center:
http://pic.dhe.ibm.com/infocenter/db2luw/v10r1/topic/com.ibm.db2.luw.admin.sec.doc/do
c/c0005548.html
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2.6 View relationships between objects
When you are learning the structure of an existing database or planning changes to a
database, it is useful to find out how the database objects are related to each other. While
Data Studio will help you manage dependent objects when you alter or drop an object, it
also lets you visualize relationships among objects.

2.6.1 Analyze impact
Before making changes to a database object, it is wise to verify that no dependent objects
will become invalid because of your changes. Data Studio can detect dependencies in
database objects, so that you can see a summary of the objects affected by the changes.
To detect dependencies by using the impact analysis functionality:
1. Right-click the table and select Analyze Impact.
The Impact Analysis window opens.
2. To locate the objects that depend on the table, select the Dependent objects option,
and then click OK.
The workbench locates the dependencies. The Model Report view opens and lists the
dependent objects, and the impact analysis diagram editor also displays a visual
representation of all of the dependencies, as shown in Figure 2.27.
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Figure 2.27 – Impacted objects for the PRODUCT table
The impact analysis shows that there are several objects impacted by changes in the
PRODUCT table, including foreign key objects, tables and views. When you alter the
PRODUCT table, the workbench ensures that the changes that you make do not invalidate
the dependent objects by offering to drop or recreate those objects. However, when a
dependent object is composed of SQL, such as a view, you must verify that changes will
not invalidate the SQL of the dependent object.
You can experiment with the other options such as contained and recursive objects in the
Impact Analysis window to learn more about the relationships between objects. To select
another object, close the impact analysis diagram editor or return to the object list editor
view.

2.6.2 Generating an entity-relationship diagram
Entity-relationship (ER) diagrams are a conceptual way to represent data and are
commonly used in database modeling. ER diagrams are useful for documenting and
analyzing relationships among several entities. For database modeling, diagramming is a
handy tool to help you understand the relationships among different tables.
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To generate an overview ER diagram in Data Studio, right-click on a database table and
select Show -> In Overview Diagram, as shown in Figure 2.28.

Figure 2.28 – Generating overview ER diagram
In the Overview Diagram Selection window, you can select the tables that you want to
include in the overview diagram. Select the following tables, as shown in Figure 2.29:
PRODUCT, PRODUCT_BRAND, PRODUCT_COLOR_LOOKUP, PRODUCT_LINE,
PRODUCT_NAME_LOOKUP, PRODUCT_SIZE_LOOKUP, and PRODUCT_TYPE.

Figure 2.29 – Selecting tables to include in overview diagram
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After you select the tables, click OK. The overview diagram is generated, as shown in
Figure 2.30.

Figure 2.30 – Entity-Relationship diagram for selected tables
Using ER diagrams during development can be crucial to understand the database design
and increase your productivity.
Note:
You can better visualize your existing database structure by generating an ER diagram.
To create logical models using UML or to create physical models that can be deployed,
you need to use a data modeling product, like InfoSphere™ Data Architect. Refer to the
ebook Getting Started with InfoSphere Data Architect:
https://www.ibm.com/developerworks/wikis/display/db2oncampus/FREE+ebook++Getting+started+with+InfoSphere+Data+Architect

2.7 Working with existing tables
Data Studio also has tools that assist in maintenance of the existing data, which is stored in
tables. In this section we will show how to edit the data contained in a table and look at the
DDL to recreate the table. The Run Statistics task will be covered in more detail in Chapter
3. Figure 2.31 shows the actions that you can run on database tables from the object list
editor.
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Figure 2.31 – Available actions for database tables

2.7.1 Editing table data
When developing database applications, you will frequently need to update table data so
that you can force a complete exposure of your application’s code path and induce error
conditions to test the application’s error handling. With Data Studio, you can edit the table
data by right-clicking the table and selecting the Edit Data action. The table data editor
opens to display the existing data in the table, as shown in Figure 2.32.
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Figure 2.32 – Editing table data
You can edit the table’s contents by selecting a cell and changing its value. After you have
changed a value, be sure to press the Enter key or select another cell. The cell is
highlighted, and an asterisk appears in the tab name of the view to show that the table was
changed, but the changes have not yet been saved and committed to the database. You
can commit changes to database by saving the editor changes, either by using the
keyboard shortcut, Ctrl+S or by selecting File -> Save.
Note:
After you update a value in the table, you must press the Enter key or select another cell
in the table. If you do not perform this step and close the tab, you will not be prompted to
save the changes, and the changes will not be saved to the database.

2.7.2 Generate DDL
When you must duplicate a database table, the simplest way to complete this task is to
generate a DDL script that can be run on the target database. You can generate DDL
directly from many database objects, including tables, by right-clicking those objects in the
object list editor and selecting Generate DDL.
The Generate DDL wizard lets you select several options to be included in the generated
DDL, including drop statements, fully qualified and delimited names, dependent object, and
so forth. After choosing the options, the generated DDL is displayed and you can specify
whether to run this DDL against a database server or simply save it into a local project for
later use. For example, Figure 2.33 shows the generated DDL for the PRODUCT table.
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Figure 2.33 – Generating DDL for table PRODUCT
If you want to use the DDL generation feature to recreate a database object in another
schema or database, deselect the Run DDL on Server option, and select the Edit and run
DDL in the SQL editor option. After you click Finish, you can edit the file to change the
schema and name of the object. After you change the schema name, you can run the
script from the SQL editor or save the DDL to a file.
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2.8 Exercises
In this chapter you learned how to start and stop instances, create and connect to
databases, create tables, views, and indexes, and how to grant access to users. Here are
some exercises to practice what you learned. You can use any of the connection you
created in this chapter whenever the name of the database is not mentioned explicitly in
the exercise.
Exercise 1: You created a GSDB database in the previous chapter and learned to connect
to it using Data Studio in this chapter. Browse the database tree to find out the various
schemas in the database and the various objects associated with those schemas.
Exercise 2: Try creating a table with various data types and insert some values into it. Try
creating an index of single or multiple columns on this table.
Exercise 3: Try creating a table with a primary key including single or multiple columns.
Does an index automatically get created? What columns does it contain?
Exercise 4: Try adding a user and see how many privileges you can give. Browse through
all the possible privileges.
Exercise 5: Create a table where the value for a specific column will always be generated
by the DB2 based on an expression defined by you.

2.9 Summary
In this chapter you have learned how to create and connect to a database and how to
navigate the databases. You also learned how to use change plans to create objects in the
database. You also learned how to manage different database objects, and view the
relationships between objects. You learned how to add users and grant privileges using
Data Studio as well as how to create an overview diagram that shows the relationships
among the objects.

2.10 Review questions
1. How do you generate an entity-relationship diagram in Data Studio?
2. Related database objects are grouped together in a _________.
3. Why are connection profiles useful?
4. When creating a new user in Data Studio, which tab in the object editor enables you to
specify which objects that person has access to?
5. When connecting to a database, which of these is a mandatory parameter?
A. Port number
B. Host name/IP address
C. User ID/password
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D. All of the above
E. None of the above
6.

In Data Studio, where would you alter the attributes of a table?

A. SQL editor
B. Properties view
C. Routine editor
D. Database table editor
E. All of the above
7.

While creating a table, when is an index automatically created?

A. When you define the primary key
B. When you define a NOT NULL constraint for the column
C. When the column value is defined as auto-generated
D. No index gets created automatically
E. All of the above
8.

You can create a view using:
A. A full SELECT statement on a table
B. A SELECT statement with specific columns from a table
C. A JOIN statement for multiple tables
D. All of the above
E. None of the above
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Chapter 3 – Maintaining the database
In the previous chapter, you learned how to connect to a database and create various
objects. During the course of this chapter, you will learn more about data placement, data
movement, and backup and recovery, all of which are critical database administrator
activities.
In this chapter, you will learn:


How to manage storage and memory



How to move data within the database



How to make a backup of a database and restore from it

3.1 Database maintenance: The big picture
Data Studio provides most of the maintenance functionality that database administrators
need to perform their day-to-day tasks, as shown in Figure 3.1.

Figures 3.1 – Database administrators are responsible for storage and availability
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In the previous chapter, we covered basic database administrator tasks related to creating
and managing database objects such as tables, and indexes. In this chapter, you will learn
operational tasks that are critical to keeping the database up and running efficiently and to
help prevent and recover from failures. These tasks become more and more critical as an
application moves to a production environment, when database performance and
availability become critical success factors for an application. This chapter outlines how
some of these tasks can be performed with Data Studio.
Note:
You can learn more about related products in Chapter 11 to learn about advanced
capabilities that are not included in Data Studio.

3.2 Managing storage and memory for better performance
A DB2 data server can use the file system or raw devices to store data. The data storage in
a DB2 data server is defined using table spaces. While you can create tables using a
default table space, many database administrators need more control over how data is
placed in storage and how to manage the characteristics of that storage and will want to
explicitly place tables into specific table spaces, depending on their performance and
access requirements.
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When a query runs, the DB2 system fetches the required data into main memory for
processing. The memory areas used to fetch the data from storage are called buffer pools.
Again, because the performance requirements of tables and applications can differ, you
may wish to have more control over memory usage by different tables.
This section will define these storage and memory areas and explain how you can create
and work with them.

3.2.1 Creating and managing table spaces
A table space is a logical database object that maps the logical objects like tables, indexes,
and so on, to the physical storage memory. It consists of containers, which could be an
operating system file, directory, or a raw device. In this section, we will concentrate on files
and containers. Raw devices, although supported, are not widely used in a typical
database due to advances in disk and file system performance.
A DB2 data server can have multiple types of table spaces depending on how the memory
is managed and how the containers are defined:


A system-managed table space is managed by the operating system and can have
directories as its containers.



A database-managed table space is managed by the database manager and can have
files and raw devices as its containers.



An automatic storage table space is the alternative system-managed and databasemanaged storage in which DB2 itself manages the containers. You just need to specify
the path where the containers should be created and the maximum size that the DB2
server can use for these containers.

A table space can also be categorized based on the type of data it stores–regular, large, or
temporary.
3.2.1.1 Creating a table space
To create a table space by using Data Studio:
1. Right-click the Table Spaces folder and select Create Regular Table Space, as
shown in Figure 3.2.
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Figure 3.2 – Creating a new table space
A new table space is created in the object list editor.
2. Select the new table space and review the default properties in the Properties view.
Provide basic information (like a name) in the General tab. In the Management field,
you can select the type of the table space. For this task, select the System Managed
management type, as shown in Figure 3.3.

Figure 3.3 – Defining basic table space properties
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3. Create a new container. In the Containers tab, click the New button. A new container is
created.
4. Then, select a container type; in this case, select Directory, as shown in Figure 3.4.

Figure 3.4 – Creating a container
In our example, since we have specified that the system will manage storage, the only
available container type is Directory.
If you have specified that the database will manage storage, you can select the device
or file container type. However, if you have selected automatic storage, you do not
need to define containers. In this case, you need to define the Initial size, Increase
size, and the Maximum size under the Size tab. Initial size will be allocated at the time
of creation and will be increased by increase size whenever more storage memory is
required until the time maximum size limit is reached.
5. Optionally, you can move the tables stored in other table spaces to this new table
space, by selecting the table names in the Tables tab as shown in Figure 3.5 below.
For this example, do not move any tables.
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Figure 3.5 – Moving tables to the table space
6. Now click on the Change Plan link on top of the object list editor for an overview of
the changes, circled in Figure 3.6. The number 1 in the change plan link indicates
that there is one changed object in the current change plan.
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Figure 3.6 – Opening the change plan from object list editor
7. From the change plan overview, click the Review and Deploy Changes button to
review the changes in detail, and deploy them to the database, as shown in Figure
3.7.

Figure 3.7 – Change plan – reviewing and deploying changes
8. In the Review and Deploy window, click Run. The changes that you are deploying
in the Review and Deploy window are shown in Figure 3.8.
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Figure 3.8 – Deploying the table space to the database
9. The deployment succeeds and creates a new regular system-managed table
space in the database. Figure 3.9 shows the SQL Results view that displays the
result of every command that runs. The Status tab on the right displays the
command syntax, any command output or error, and how long it took for the
command to run.
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Figure 3.9 – SQL Results view displays the results of deployment
3.2.1.2 Use the new table space
Now you have a new table space that you can associate with tables, indexes, or other
objects that you create. This association specifies that the DB2 data server should use this
table space for physical storage of those objects. To associate any existing objects with
this new table space, you can right-click the object, then select Alter.
3.2.1.3 Drop a table space
You can drop a table space by selecting the table space from the object list editor.
However, be careful whenever you drop a table space, because any associated tables and
data is dropped, as well. To drop a table space, select the Table Spaces folder in the
Administration Explorer, right-click on the table space in object list editor on the right, and
select Drop. You can see an example of a drop action in Figure 3.10. To deploy the change
to the database, follow the deployment steps from Section 2.4.5 of Chapter 2.

Figure 3.10 – Dropping a table space
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If you have associated any objects with this table space, Data Studio will ask if you want to
drop these impacted objects at the same time. The drop may fail if you choose to not drop
the impacted objects. Unless you want to drop the table space and all of its impacted
objects, you should first alter the impacted objects to disassociate them from the table
space, and then drop the table space.

3.2.2 Creating and managing buffer pools
A buffer pool is the database memory cache that is used to store data and indexes for
faster access. This memory cache is also where the changes made by an application to a
database object are performed, before persisting it to the database. Data is fetched from
the table spaces to this buffer pool for every query before returning the result to the
application. To fetch data from a table space, a buffer pool with the same page size must
exist.
Normally, once the data is fetched into the buffer pool, it remains in the buffer pool until the
buffer pool gets full, in which case the old data is wiped out to make space for the new
data. You can greatly improve performance if you store the data that is required by any
query in the buffer pool, instead of retrieving that data from the disk.
By default, a buffer pool named IBMDEFAULTBP is created when you create the database.
This default buffer pool is used for all objects unless you explicitly assign the objects to
another buffer pool.
3.2.2.1 Creating a buffer pool
To create a buffer pool:
1. Right-click the Buffer Pools folder and select Create Buffer Pool. The menu is shown in
Figure 3.11.

Figure 3.11 – Creating a new buffer pool
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2. As shown in Figure 3.12, specify the buffer pool name, total size, page size, and other
basic attributes in the General tab. If you want to create this buffer pool immediately
after you run the DDL script, the Create type field should be set to IMMEDIATE;
otherwise you can set the script to run the next time that the database starts by
selecting the DEFERRED option.

Figure 3.12 – Defining the buffer pool properties
3. Deploy the new buffer pool by following the deployment steps from Section 2.4.5 of
Chapter 2.
3.2.2.2 Use the new buffer pool
You have a new buffer pool that you can associate with table spaces that you create. Both
the table space and buffer pool must be of the same page size. This association tells the
DB2 data server to use this buffer pool to fetch the data from this table space. For existing
table spaces, you can alter them to associate them with this new buffer pool.
3.2.2.3 Drop a buffer pool
You can drop a buffer pool by selecting the buffer pool from the object list editor. The list of
buffer pools can be viewed by clicking on the Buffer Pools folder in the Administration
Explorer. To drop a buffer pool, right-click it in object list editor, and select Drop. This is
shown in Figure 3.13. To deploy the drop on the database, follow the deployment steps
from Section 2.4.5 of Chapter 2.
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Figure 3.13 – Dropping a buffer pool
If you have associated any table space with this buffer pool, Data Studio will prompt you to
drop the impacted table space at the same time. The drop will fail unless you select the
option to drop the impacted table space. Alternatively, you can alter the corresponding
table space first to disassociate it from this buffer pool (you can associate it with the default
or some other buffer pool) and then try dropping this buffer pool again.

3.2.3 Reorganizing data
Normally, data is written to memory in a sequential manner. However, frequent operations
on the database objects can fragment the data, which may mean that data is stored nonsequentially and can increase the size of the table as the data spans multiple data pages.
Fragmentation of the data may result in multiple I/O operations to fetch the same data that,
without fragmentation, would have taken only a single I/O operation. You should reorganize
the tables and indexes to defragment the data, improving the I/O cost and, in some
instances, reducing memory usage.
To reorganize data:
1. Open the Tables folder in the Administration Explorer and select a table from the
object list editor.
2. Open an editor to configure the reorganization operation by right-clicking the table
and selecting Manage -> Reorg Table. Figure 3.14 shows the Reorg options for the
ORDER_DETAILS table in the GOSALES schema.
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Figure 3.14 – Reorganization options for tables
A new editor opens. You use this editor to configure the reorganization operation.
3. Specify options for the reorganization operation. The editor is shown in Figure 3.15.

Figure 3.15 – Options for reorganizing a table
You can reorganize a table in two ways:
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In-place reorganization (called Incrementally reorganize the table in place in the
Options tab shown in Figure 3.15) allows reorganization to occur while the table or
index is fully accessible. If you select this option, you can set the table access
control to allow read, or read and write access.



Offline reorganization (called Rebuild a shadow copy of the table in the Options
tab) means that reorganization occurs in offline mode. You can specify whether to
allow read access or not during offline reorganization.

While offline reorganization is fast and allows perfect clustering of the data, online
reorganization lets the table remain online to applications. If applications must write to the
table while reorganization is occurring, use the in-place reorganization method. When you
use in-place reorganization, you have more control over the process, and you can pause
and restart the process. However, in-place reorganization requires more time to complete.
You can reorganize the table by using an existing index. When you reorganize by using an
existing index, the data is accessed more quickly while data is being reorganized.
When you choose offline reorganization, you can use the temporary table space to store
the copy of the reorganized table. You can use the temporary table space by selecting the
Use system tempspace to temporarily store a copy of the reorganized table option. You
can also reorganize long fields and large object data, as well as the option to reset the
dictionary if data compression is enabled.
4. After you choose the options that are required for your organization, you can run
the command by clicking Run, as shown in Figure 3.15 above.
5. Close the editor before you start the next task.

3.2.4 Gathering statistics
When an application runs a query, the DB2 optimizer compiles the query and creates an
access plan, which describes the sequence of steps to run the query and fetch the data
that is returned. Access plans give estimations of the cost and time that is required to run a
query. The sequence of steps that is created as part of the access plan depends on a
number of factors, such as:


Size of the database table, indexes and views



Distribution of data in the specific columns of the tables



Average length and the cardinality of the column values



Amount of null values and the highest and lowest values of the columns

As update, insert, and delete transactions happen on a database, the data grows or shrinks
and often changes its distribution. This means the statistics that the optimizer currently
knows about are outdated and no longer reflect reality. If the information stored in the
catalogs is not up to date, the steps created as part of the access plan may not be accurate
and can generate a less than optimal access plan, which may negatively affect
performance.
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You should gather statistics regularly so that DB2 optimizer generates optimized and
efficient access plans. Statistics can be collected on tables, indexes and views. You can
use Data Studio to help you determine how and when to run statistics. See Chapter 7 for
more details.
Note:
Even though you can automate the update of table statistics, in a production
environment, you should manually update the statistics for the most critical tables in
order to provide continuous enhanced performance for workloads that use those tables.
To gather the statistics:
1. Click the Tables folder in the Administration Explorer and select a table from the
object list editor.
2. Right-click the table and select Manage -> Run Statistics. Figure 3.16 shows the
Run Statistics option for the BRANCH table in the GOSALES schema.

Figure 3.16 – Updating the statistics for a table
A new editor view opens, where you can specify how statistics should be run on the
database, as shown in Figure 3.17.
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Figure 3.17 – Profile options for updating the statistics for a table
The RUNSTATS utility of the DB2 data server helps you to register and use a statistics
profile that specifies the type of statistics that should be collected for a particular table,
such as table statistics, index statistics, or distribution statistics. You can use this
feature to simplify how statistics are collected by saving your RUNSTATS options to
use in the future.
3. In the Profile tab, select the Update statistics now option to update the statistics
immediately.
4. Open the Statistics tab to specify the type of statistics you want to collect. You can
gather statistics on all columns, with an option to collect data distribution statistics. You
also have an option to collect basic statistics on indexes, including optional extended
statistics with data sampling that is useful for large indexes. As shown in Figure 3.18,
you can leave the default settings, which are the recommended options.
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Figure 3.18 – Options for updating statistics on a table
5. After you select the options that are appropriate for your organization, you can run the
command by clicking Run, as shown in Figure 3.18 above.
6. Close the editor before you start the next task.

3.3 Moving data
With Data Studio, you can move your data from the database tables to the file system
(Export) and bring back the data from file system to the tables (Import or Load). Using
these features lets you transfer the data from a table in a database to another table in the
same or different database. Exporting and importing is also useful when you want to import
a large volume of data into a table that includes large objects. This section will outline how
to export data into the file system and import the data from the file system into a table.
Note:
The location of the data files that you use to export or import data should be on the
computer where your DB2 database server exists when you select the following types:


Unload -> With Export Utility



Unload -> With Optim High Performance Unload



Load -> With Import Utility
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Load -> With Load Utility

However, when you use the Unload -> With SQL and Load -> With SQL types, the
location of the data file should be on the same computer as the Data Studio workbench.

3.3.1 Exporting data
To export the data from a table to the file system:
1. Select the Tables folder in the Administration Explorer. Browse through the tables in
the object list editor. Right-click the table that you want to export and select Unload ->
With Export Utility, as shown in Figure 3.19.

Figure 3.19 – Exporting data
2. A new editor opens which will let you select the file name and the format for the
exported data in Target tab. As shown in Figure 3.20, specify the delimited format, and
specify a path and file name for output.
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Figure 3.20 – Specifying the format and the file name for the exported data
The three file formats that are supported are delimited, integrated exchange, and
worksheet.


Delimited (DEL) format is generally used when you plan to exchange the data
between different database managers and file managers. The data is stored in a
delimited text file, where row, column, and character strings are delimited by
delimiting characters.



Integrated exchange format (IXF) is a rich format, which stores the data in a binary
format. Structural information about the table (DDL) can also be stored, and you
can use this to recreate the table when you import the file.



Worksheet format (WSF) is used when you plan to exchange the data with
products like Lotus® 1-2-3® and Symphony™.

3. You can also specify whether to export large object (LOB) data into a separate file or
files. Similarly, XML data can also be exported to a separate file or files.
4. In the Source tab, you can specify an SQL statement that selects the data to export. As
shown in Figure 3.21, a full SELECT is automatically created; however, you can edit the
generated SQL statement to select any specific columns.
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Figure 3.21 – Reviewing the source SQL to export the data
5. After you select the options that are appropriate for your organization, run the
command by clicking Run, as shown in Figure 3.21. The data is exported to the file
system at the location that you specified.
6. Close the editor before you start the next task.

3.3.2 Importing data
You can load and import data into a table. To load or import data, you should have the data
in your file system in one of the supported formats (DEL, IXF, or WSF), as described in the
previous section.
Note:
If you are importing a large amount of data, you may need to increase the database log
size as described in Section 3.4, or specify automatic commit in the Advanced Options of
the Import editor that is shown in Figure 3.24.

To import the data into a table:
1. Select the Tables folder in the Administration Explorer. Browse through the tables in
the object list editor. Right-click the table that you want to load and select Load -> With
Import Utility, as shown in Figure 3.22.
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Figure 3.22 – Importing data
An import editor opens.
2. Complete the File tab of the editor:
a. Specify the name and the format of the data file to import, as shown in Figure
3.23.
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Figure 3.23 – Selecting the data files format and the location
b. Specify an import mode:
◦

INSERT: The imported data will be appended to the existing data in the
table.

◦

INSERT_UPDATE: A row is updated if that particular row already exists;
otherwise a new row is inserted.

◦

REPLACE: Existing data is overwritten.

3. Open the Advanced Options tab, and complete the page. In this example, select
Automatically commit as shown in Figure 3.24:

Figure 3.24 – Selecting advanced options for Import
For more information about these options, see the DB2 documentation for the IMPORT
command here:
http://pic.dhe.ibm.com/infocenter/db2luw/v10r1/topic/com.ibm.db2.luw.admin.cmd.doc/
doc/r0008304.html
4. Use the Columns tab to specify where data is retrieved from if you are importing large
objects and XML data.
5. When you are done providing all of the necessary options, you can click the Run button
to import the data into the table, as shown in Figure 3.24.
6. Close the editor before you start the next task.
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Note:
You can also use the Load utility to load the data into the table. When you use the Load
utility, the results are almost identical, but the Load utility can be faster for large
quantities of data. When you run the Load utility, you complete a multi-step process,
whereas the Import utility can process most data in a single step. To learn more about
the Load utility, refer to the documentation in the DB2 information center:
http://pic.dhe.ibm.com/infocenter/db2luw/v10r1/topic/com.ibm.db2.luw.admin.dm.doc/doc
/c0004587.html
After you understand the Load process, you can try to run the process on your
databases with Data Studio.

3.4 Planning for recovery: Configuring DB2 logging
The DB2 logging facility logs any SQL statement updates done on the database. These
logs help in recovering a database state in case of any system failure. DB2 logging can be
categorized as follows:


Circular logging: the changes are logged only for those transactions that are not
committed. With this kind of logging, you can recover the data from the latest backup
only. This is the default when you create a database.



Archive logging: all the changes including the committed ones are logged here. With
this kind of logging, a roll forward can be done after restoring from a backup. The roll
forward process applies all the transaction that occurred since the last backup. In
addition, archive logging is a must for online backup operations.
Note:
To learn more about database logging and the logging options, see this DB2 information
center topic:
http://pic.dhe.ibm.com/infocenter/db2luw/v10r1/topic/com.ibm.db2.luw.admin.ha.doc/doc/
c0006073.html

You can change the logging type by right-clicking the database and selecting Set Up and
Configure -> Configure Database Logging, as shown in Figure 3.25 below.
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Figure 3.25 – Configuring Database logging
A new editor opens, where you select the kind of logging that you want to enable. If you
select archive logging, you need to specify the location of the archive logs (in the Logging
Type tab), and location of the new backup (in the Backup Image tab). A new backup of the
database is required so that in case of failure, a roll forward is possible after restoring the
database. You will find more information about restore and roll forward in the next section.
Figure 3.26 below shows the options for configuring logging.

Figure 3.26 – Configuring archive logging
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After providing the logging type and backup image details, you can click on the Run button
as shown in Figure 3.26 to configure the required logging. As always, close the editor when
you are done with the task.

3.5 Backing up and recovering databases
Backups allow the database to be recovered in case of crash or database failure. Backups
also allow you to move complete databases from one location to another. You can take the
backup of a database and recover it in the same or a different compatible system;
however, not all system combinations are supported. For more details on system
compatibility, refer to the documentation in the DB2 information center:
http://pic.dhe.ibm.com/infocenter/db2luw/v10r1/topic/com.ibm.db2.luw.admin.ha.doc/doc/c0
005960.html.

3.5.1 Backup
You can create a backup of your database using Data Studio. The database can be
restored at a later point in time by using this backup.
Note:
For more information about backup, see the following topic in the DB2 information
center:
http://pic.dhe.ibm.com/infocenter/db2luw/v10r1/topic/com.ibm.db2.luw.admin.ha.doc/doc/
c0006150.html

To create a backup of a database:
1. In the Administration Explorer, right-click the database that you want to back up select
Back Up and Restore -> Backup, as shown Figure 3.27.

Figure 3.27 – Back up database
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A new editor opens.
2. In the Backup Image tab, you can provide the media type where you want to take the
backup and the location of the backup image. This step is shown in Figure 3.28.

Figure 3.28 – Taking a backup on a file system
3. Open the Backup Type tab to specify whether you want to backup the entire database,
or backup selective table spaces. Select Back up the entire database as shown in
Figure 3.29.

Figure 3.29 – Taking a backup of entire database
4. Specify more options for the backup in the Backup Options tab. You can create three
types of backups:


A full backup contains a complete backup of the entire database.



An incremental backup contains any data that is new or has changed since the last
full backup.
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A delta backup contains any data that is new or has changed since the last backup
of any type: full, incremental or delta.

Availability: You can specify if you require the database to be online during the
backup process. Online backup is possible only when archive logging is being used.
Figure 3.30 shows these options.

Figure 3.30 – Backup options
5. Click Run button to create the backup of the database.
6. Close the editor you start the next task.

3.5.2 Restore
If something happens to your database, you can restore it from a backup.
Note:
For more information about restoring a database, see the following topic in the DB2
information center:
http://pic.dhe.ibm.com/infocenter/db2luw/v10r1/topic/com.ibm.db2.luw.admin.ha.doc/doc/
c0006237.html

To restore a database from a backup image:
1. Right-click the database that you want to restore, select Back Up and Restore ->
Restore as shown in Figure 3.31 below.
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Figure 3.31 – Restoring a database
2.

A new editor opens, as shown in Figure 3.32. In the Restore Type tab, you can
specify that you want to restore to an existing database or create a new database.

Figure 3.32 – Selecting the restore type
3. Open the Restore Objects tab. Here, you can select to restore only the history file,
entire database, or specific table spaces. A history file contains the information
regarding the backups taken in the past. This file helps the recover command to find

Chapter 3 – Maintaining the database 131
the appropriate backups to be used for recovering the database. For this example,
select the Restore the entire database option, as shown in Figure 3.33.

Figure 3.33 – Specifying what to restore to the database
Note:
RESTORE and RECOVER are two different commands. RECOVER, as we will see in a later
section, provides a simplified command to perform a RESTORE followed by a
ROLLFORWARD command.

You can specify whether you want to manually specify the backup image location, or if
you want to select from the list that DB2 has maintained in a history file. If the system
where the backup resides is the same as the one that you want to restore to, and you
have not manually moved the backup files, you will see the backup images in the list.
However, if you have moved the image manually, you can select that location
manually.
4. Figure 3.34 shows how to select an image from a list that was generated by DB2. You
can select one of the images to restore.
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Figure 3.34 – Selecting the objects to restore
5. In the Restore Containers tab, you can specify new container for the table spaces in
the database to be restored. This option is useful when the backup image is going to
be restored on a different system, where the same container paths do not exist.
6. In the Restore Options tab, you can select if you want to replace the history file. You
can also select if you want to just restore a backup image or if you also want to restore
the transactions that would have happened between the time the backup image was
taken and a restore operation is performed. This operation is called roll forward. For
this example, leave all the defaults as shown in Figure 3.35, and just select the option
to remove all connections to the database before starting the restore operation, so that
the restore operation does not fail.
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Figure 3.35 – Selecting additional options for restore
7. Click Run to restore the database.
8. Close the editor you start the next task.

3.5.3 Roll forward
A roll forward operation applies transactions on the restored database, which are recorded
in the database logs. The roll forward operation applies transactions that were recorded in
the database log files to a restored database backup image or table space backup image.
Note:
For more information about the roll forward operation, see the following topic in the DB2
information center:
http://pic.dhe.ibm.com/infocenter/db2luw/v10r1/topic/com.ibm.db2.luw.admin.ha.doc/doc/
c0006256.html
To roll forward a database to a specific point:
1. Right-click the database and select Back Up and Restore -> Roll Forward, as shown in
Figure 3.36.

Figure 3.36 – Starting the roll forward operation for a database
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2. A new editor opens. In the Roll-forward Type tab, you can select if you want to apply all
the logs or up to a specific point in time. This is shown in Figure 3.37.

Figure 3.37 – Choose the type of roll forward operation
3. In the Roll-forward Scope tab, you can select if you want to roll forward the complete
database or just a particular table space. However, if you restored an entire database
before, you will not see the option to roll forward selective table spaces.
4. In the Roll-forward Final State tab, you can select if you want to complete the roll
forward operation or want the database to remain in roll forward pending state. If you
decide to leave the database in the roll forward pending state, you can complete the
roll forward at a later point in time by right-clicking the database and selecting Back Up
and Restore -> Complete Roll Forward. For this example, select the option to complete
the roll forward operation, as shown in Figure 3.38.
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Figure 3.88 – Specifying how to complete the roll forward operation
5. Click Run to roll forward the database and complete the roll forward operation.
6. Close the editor before you start the next task.

3.6 Other maintenance tasks
In addition to what we discussed so far, Data Studio provides additional options to perform
more database maintenance operations:


Recovering a database: Recovery is a combination of restoring followed by a roll
forward. You can specify a point in time or end of logs, and DB2 restores the database
with appropriate backup image (depending on the specified time and the history file),
and then does a roll forward on that database to the specified time. This can be
performed using Data Studio by launching the appropriate utility by right-clicking the
database, and selecting Back Up and Restore -> Recover.



Completing a roll forward recovery: This option completes a roll forward recovery by
stopping the roll forward of log records, rolling back incomplete transactions, and
turning off the roll forward pending state. Users regain access to the database or table
spaces that are rolled forward. As explained in Section 3.5.3, Data Studio provides a
single step to initiate the roll forward operation as well as complete it. However, it also
provides another option to just complete the roll forward explicitly if required. This can
be performed by launching the appropriate utility by right-clicking the database and
selecting Back Up and Restore -> Complete Roll Forward.



Canceling a roll forward recovery: You might need to cancel a roll forward operation
that is in progress but cannot be completed. This can be performed using Data Studio
by launching the appropriate utility by right-clicking the database and selecting Back
Up and Restore -> Cancel Roll Forward.



Configuring automatic maintenance: The database manager provides automatic
maintenance capabilities for performing database backups, keeping statistics current,

136 Getting Started with IBM Data Studio for DB2
and reorganizing tables and indexes as necessary. This can be configured using Data
Studio by launching the appropriate editor by right-clicking the database, and selecting
the option Set Up and Configure -> Configure Automatic Maintenance.


Configuring database or instance parameters: The database manager provides
many parameters at the database level as well as database manager level that can be
configured for specific behavior and tuning of a database or database manager. This
can be achieved using Data Studio by launching the appropriate utility by right-clicking
the database, and selecting Set Up and Configure -> Configure. This option is also
available on the instance node in the Administration Explorer.

3.7 Exercises
To practice what you have learned in this chapter, try out the following exercises.
1. Create a table space, Tb1. Now create a table, T1 and make sure it’s stored in table
space Tb1. Now create an index on the T1 table and store it in the default table space
(USERSPACE1).
2. Create a table space Tb2 and check what privileges are available. Give all of the
possible privileges to another user.
3. Create an online backup of the GSDB database. Update some of the tables. Now
restore the database and perform a roll forward until the end of the logs.

3.8 Summary
In this chapter, you were introduced to some DB2 concepts such as table spaces, buffer
pools, and logging. Using Data Studio, you learned how to create these objects, perform
REORG, RUNSTATS, BACKUP, RESTORE, RECOVER and ROLLFORWARD operations. For
more detail about these DB2 concepts, refer to the ebook Getting Started with DB2
Express-C.

3.9 Review questions
1. What are the three types of table spaces in DB2 data servers?
2. What are the file formats supported for exporting data?
3. Which file format allows you to create the table while exporting?
4. Name the two different logging methods supported in DB2 data servers.
5. What two operations are combined to compose the Recover operation?
6. A system-managed table space can have containers of the following type:
A. Directory
B. File
C. Raw Device
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D. All of the above
E. None of the above
7. A buffer pool is used mainly:
A. To store the intermediate results of queries
B. To fetch data from disk to volatile memory/RAM
C. To store updates to the data
D. To process the data before returning it to the application
E. All of the above
8. An online table reorganization is preferred when:
A. Access to database tables is critical while reorganization is occurring
B. Data needs to be clustered perfectly
C. More storage space is required
D. Index rebuild is required
E. All of the above
9. When is statistics collection recommended?
A. When the data is fragmented
B. After many selects on the data
C. After many updates on the data
D. All of the above
E. None of the above
10. An incremental backup contains:
A. All of the data
B. Only the modified data after the last full backup
C. Only the modified data after the last full or incremental backup
D. Only the modified data after any kind of backup
E. None of the above
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Chapter 4 – Monitoring the health of your
databases
In this chapter you will learn:


How to identify which databases to monitor



The meanings of the various health monitor displays



How to configure and collaborate with alerts, including how to send alerts via e-mail

4.1 Health monitoring: The big picture
The Data Studio web console allows you to monitor the health and availability of your DB2
(for Linux, UNIX, and Windows and z/OS) databases, and view alerts, applications, utilities,
storage, and related information. You can open the health monitoring pages from the web
console in a web browser, or seamlessly launch it from the Data Studio client. For more
information about installing the web console, see Chapter 1.

4.2 Getting started
Important: Before you open the web console from your web browser, make sure that you
have the Adobe Flash Player plug-in installed in the browser.
To open the web console for health monitoring in a web browser:
1. Start the web console server. From Windows, you can start the server from the Start
menu at All Programs -> IBM Data Studio -> Data Studio Web Console -> Start Web
Console Server, or directly from the Control Panel. If you are using the web console in
a Linux or UNIX environment, use the start.sh script from the Data Studio web
console installation /bin directory.
2. Connect to the Data Studio web console server from a web browser, using a URL with
the following information:
http://<host>:<port>/datatools
where <host> is the IP address or host name of the machine where the Data Studio
web console is installed, and <port> is the web console port number that you
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specified during installation. If this is the first time you are logging in to the web
console, you will need to log in as the administrator, using the password you provided
during the installation.
Note:
The following URLs are the default URLs for the Data Studio web console:
http://localhost:11083/datatools/
https://localhost:11084/datatools/

4.3 Identifying databases to monitor
Before you can see any monitoring activity, you need to indicate which databases to
monitor, which requires that you add the database for monitoring. This is basically creating
a connection to the database, similarly to what you have done previously in the Data Studio
client. You will add the database using the Databases page of the web console, which you
can get to in the following ways:


From the Getting Started tab of the Task Launcher, click Add database connections.



From the Open menu, select Databases, as shown in Figure 4.1:

Figure 4.1 – Open menu on the Data Studio web console
From the Databases page, as shown in Figure 4.2, you can add the databases that you
want to monitor by clicking the Add button:

Figure 4.2 – Add databases to monitor
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Add the information for the database you want to monitor, as shown in Figure 4.3, then
click Test Connection to validate that you entered your credentials correctly. Then click OK
to add the database to the list of monitored databases.

Figure 4.3 – Specifying database connection information
Note:
As you can imagine, for an environment with a large number of databases, it is tedious
to add each connection manually. When you click the Import button, you can also import
a list of databases from comma-separated files. You can use the
DatabaseConnectionsImportCSV.txt file in the samples folder in the installation
directory as an example of importing from a file.
When you add the database, health monitoring is automatically enabled, and you are ready
to monitor your databases! To see the results, go to Open -> Health -> Health Summary.
Because the default monitoring interval is 10 minutes, it may take that length of time to see
results on the Health Summary, which is described in the next section.

4.4 Overview of the Health Summary page
The web console monitors the health of the databases by periodically querying the
database and displaying the health status, including alert conditions, on the Health
Summary page.
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You can configure the web console to send you an alert when it identifies a problem with a
database that it is monitoring. The web console generates alerts based on the thresholds
and settings that you specify. When you add a new database for monitoring, a default
configuration of thresholds and settings is already specified for you. You can alter the
default configurations from the Health alert configurations page as described in Section
4.5.4. You can view the generated alerts by clicking the Open menu, and then selecting
either Health -> Health Summary or Health -> Alerts.
The Health Summary provides a grid of summary health information for each monitored
database, as shown in Figure 4.4.

Figure 4.4 – The health summary
The alert icons in the grid cells identify a database status (Normal, Warning, or Critical)
across categories such as data server, connections, storage, and recovery. A double dash
(--) in a cell indicates that no alerts were issued in the selected time frame, as indicated by
the time duration selection in the upper left hand corner of Figure 4.4. Each icon represents
a summary of one or more individual alerts that were encountered for the selected duration
of that specific database. For example, if you had two Storage alerts for a database, one
Critical and one Warning, then the alert summary icon would identify this as Critical. When
you click on the cell, you can drill down to the individual alerts themselves that detail the
problems, including any appropriate actions you should take.
You can view alerts for specific time periods by selecting the Summary time drop-down
menu, currently set at 60 minutes in Figure 4.4. If you set your recent summary to 60
minutes, as shown in Figure 4.5, the Recent view will give you a summary of alerts that
occurred during the last hour. The refresh summary is set for 5 minutes, which means the
status will be checked every 5 minutes. You should set the refresh time to be more
frequent than the total summary period. Note that it is possible that no alerts are raised
during the most recent period.
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Figure 4.5 – Selecting the time period to display

4.5 Working with alerts
While the alert summary is good to quickly detect possible problems, you will likely want to
drill in deeper to find out more information about the condition causing the alert. You will
learn how to perform the following tasks:


Drilling down on an alert from the Health Summary and how to view alerts in a tabular
format



Commenting an alert and share that comment with others



Configuring alerts, including how to send alerts via e-mail

4.5.1 Seeing alert details from the Health Summary
You can view alerts generated by the Data Studio web console for the following categories
and situations:


Data Server Status: Creates an alert for different data server states including:
Available, Unreachable, Quiesced, Quiesce Pending, and Rollforward.



Operations: Creates an alert for daily operations or maintenance that must be
addressed.



Partition Status: An alert is generated when the status of a partition is OFFLINE.
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Member and CF Status: Generates alerts for pureScale members and cluster
facilities:
o

An alert is generated if any of the DB2 pureScale members is in ERROR,
STOPPED, WAITING_FOR_FAILBACK, or RESTARTING state.

o

An alert is generated if the DB2 pureScale cluster facility is in any of the
following states: ERROR, STOPPED, PEER, CATCHUP, RESTARTING.

o

An alert is generated if the DB2 pureScale cluster host status is INACTIVE.



User-Defined Alerts: Alerts are generated based on user-defined script values.



Connections: An alert is generated when the number of connections to the database
exceeds the threshold. This alert is disabled by default.



Storage: An alert is generated for the following situations:





o

Table space utilization exceeds the threshold

o

Table space container utilization exceeds the threshold. This alert is disabled
by default.

o

Table space container is inaccessible

o

Table space is in Quiesced state

o

Table space is Offline

Recovery: An alert is generated for the following situations:
o

Table space is in Restore Pending or Rollforward Pending state

o

Table space is in Backup Pending state

o

Table space is in Drop Pending state

o

Primary HADR is disconnected

z/OS System Logging: Alerts are generated whenever DB2 messages that are
related to logging are written to the z/OS system log.

For example, look at the Data Server Status Alert category. When the GSDB database is
available, the Data Server status summary cell has a green diamond, as shown in Figure
4.6.
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Figure 4.6 – The data server status indicator
Now let's say the database GSDB has been quiesced. With the default configuration
settings, a critical alert will be generated for the GSDB database as shown in Figure 4.7

Figure 4.7 – Critical data server status
You can view more information about the alert by clicking on the red icon under Data
Server Status. This opens the details shown in Figure 4.8.
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Figure 4.8 – Data server status details
Figure 4.8 also shows the list of individual alerts for the Data Server Status category. The
Data Server Status is a special category that represents the status of the monitored
database. It displays the status as green when the database is available and reachable.
The Start Time and End Time columns show when the alerts originated, and if and when
they ended. An alert without an end time indicates that the problem is still ongoing. In the
example above, the alert is caused because the database is quiesced. When the database
is unquiesced, the next monitoring cycle for this database will identify this situation, and the
critical alert will be closed.

4.5.2 Displaying a tabular listing of alerts on the Alert List page
While the Health Summary page provides an aggregated view, the Alerts List page
provides a detailed view of the individual alerts and lets you review either recent alerts or
even go back in tie using a historical view.
There are two ways to open the Alert List page:


From the Open menu, select Health -> Alerts.



From the Health Summary page, double click the alert icon, and from detailed alert
status click the Open Full List button (circled in Figure 4.8).

A sample Alerts List page is shown in Figure 4.9. From this page, you can configure health
alerts, configure to send alerts by e-mail, and add comments to alerts.
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Figure 4.9 – The alert list

4.5.3 Sharing alerts with others
You can add comments for an alert and share them with other users to help you keep track
of your own investigations or responses to a problem. To get to the comments field shown
in Figure 4.10, select an alert on the Alert List page and then click the Add Comment
button.

Figure 4.10 – Add a comment to an alert

4.5.4 Configuring alerts
By default, health monitoring is enabled automatically for all databases that are added from
the Databases page. The web console checks the state of each database every 10
minutes, but you can disable monitoring entirely, or change the frequency of monitoring
from the Health Alerts Configuration page, shown in Figure 4.11. The currently selected
warning and critical threshold values are also listed once you select a database.
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Figure 4.11 – Configuring health alerts
Click Edit to modify the default threshold values, or to disable alerts for an alert type. Only
users that have the Can Manage Alerts privilege for a selected database can edit alert
configuration settings, as described in the Database Privileges section in Appendix B. The
user in Figure 4.12 is editing the Database Availability alert type.

Figure 4.12 – Setting alert parameters
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4.5.5 Configuring alert notifications
You can set up to be notified for certain alert types and a database on the Alert Notification
page via email or SNMP traps. You can open the Alert Notification page by gong to Open > Health -> Alerts and opening the Alert Notification tab, shown in Figure 4.13.

Figure 4.13 – Using the Alert Notification tab to add alerts
To add an alert notification:
1. Before you can add an alert notification, you need to configure the email/SNMP
service. To configure the email or the SNMP service, select the Services page in
the Open menu. Select the email or the SNMP service from the grid and click
Configure, as shown in Figure 4.14.

Figure 4.14 – Configure the email service
2. After you configure the service, open the Alerts page again. Select a database
from the drop down, then click the Add button and select the alert types, as shown
in Figure 4.15.
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Figure 4.15 – Edit the alert parameters

4.6 Displaying current application connections
The Current Applications Connections page, as shown in Figure 4.16, displays a list of the
applications that are currently connected to the selected database.
To get to the Current Applications page, select Health -> Current Application Connections
from the Open menu.
From this page, you can view information about these connections, such as the Name, Idle
time, and User authorization. If a connection has been idle for a period of time, you can
disconnect the connection, or you can force an application to disconnect.
Note:
For more information about forcing applications, see the following document:
http://pic.dhe.ibm.com/infocenter/db2luw/v10r1/topic/com.ibm.db2.luw.admin.cmd.doc/d
oc/r0001951.html
For more information about disconnecting connections, see the following document:

http://pic.dhe.ibm.com/infocenter/db2luw/v10r1/topic/com.ibm.db2.luw.sql.ref.doc/doc/r0
000943.html
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Note that in the Current Applications Connections page, you will need to connect to the
selected database with your credentials to retrieve data and perform other actions, like
forcing applications. If you do not have the right privileges on the database, then the
operation will fail. The prompt screen provides you with the option to save your credentials
for subsequent logons to make this easier.

Figure 4.16 – Listing the current applications that are active for a database

4.7 Getting information about current table spaces
The Current Table Spaces page, as shown in Figure 4.17, displays live information about
all the table spaces in the selected database. You can also view the table space container
information for a selected table space.
To open the Current Table Spaces page, select Health -> Current Table Spaces from the
Open menu.
Note that in the Current Table Spaces and Current Utilities pages, you will need to connect
to the selected database with credentials to retrieve data and perform other actions, like
forcing applications. If the user ID you use to connect does not have the right privileges on
the database, the operation will fail. The prompt screen provides you with the option to
save your credentials for subsequent logons to make this easier.
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Figure 4.17 – Viewing current table spaces

4.8 Display current utilities
The Current Utilities page, as shown in Figure 4.18, displays the status of any utilities
currently running in the selected database, such as RUNSTATS or BACKUP.
To open the Current Utilities page, select Health -> Current Utilities from the Open menu.

Figure 4.18 – Viewing current utilities

4.9 Accessing Health Monitoring features from the Data Studio client
You can use the Data Studio client to access the health monitoring features in the Data
Studio web console.

4.9.1 Configuring the Data Studio web console
Before you can open the web console from the Data Studio client, you must configure it
from the Preferences window.
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To configure the Data Studio web console for the Data Studio client:
1. From the client, open the Preferences window by clicking Window -> Preferences, then
select Data Management -> Data Studio Web Console.
2. When you access a health monitoring feature, if you have not previously specified the
web console URL or your login credentials, or selected the Save password option, then
you will be prompted to enter these credentials to log in into the server as shown in
Figure 4.19.

Figure 4.19 – Configuring access to the Data Studio web console from the Data
Studio client
To connect to web console server during this session or future sessions, specify the URL.
It is the same URL that you use to log in with a web browser and has this format:
http://<host>:<port>/datatools
where <host> is the IP address or host name of the machine where the Data Studio web
console is installed, and <port> is the web console port number that you specified during
installation. You should also specify a valid user ID and password.
Optionally, you can select the Save password option to save the password for subsequent
logins to the web console server. If the Save password option is not selected, you must
enter your user ID and password every time that a health monitoring feature is launched.

4.9.2 Opening the Health Monitor from the client
You can open the various health monitoring tasks from either the Data Studio client Task
Launcher, from a selected database in the Administration Explorer, or from the
Administration Explorer view toolbar, as shown in Figure 4.20.
When you open the Health Monitor from the Administration Explorer, the health of the
selected database is displayed. When you open the Health Monitor from an application
connection, table space usage, or utility task in the Task Launcher, its parent database is
already selected on the Monitor page.
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From the Monitor tab of Task Launcher, if you select any one of the view health
summary, view alerts list, view application connections or view table space storage
usage monitoring tasks, the corresponding page opens in the Data Studio web console
Monitor view.



From the Administration Explorer, right-click a database and explore the monitoring
options.



The same Monitor menu is available from the View menu in the Administration
Explorer.

Figure 4.20 – The embedded Data Studio web console interfaces.

4.10 Exercises
In this section, you will create a variety of error scenarios so that you can get a better
understanding of how this product works, and how you can take advantage of its features.
For the purposes of this exercise, we recommend that you use the GSDB sample database
as your test database. For more information on how to install the GSDB database, see
Chapter 1.
To keep this exercise simple, you will create these error scenarios in a controlled manner,
and you will use lower thresholds to quickly cause situations that will be flagged as alerts.
This section includes scenarios for the following alert types:


Database Availability: This generates a data server status alert.
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Connections: This generates a connections alert.



Table Space Quiesced: This generates a storage alert.

4.10.1 Adjust the monitoring frequency
First, navigate to the Health Alerts Configuration page in the Data Studio web console and
select a database. You will see the default refresh value is 10 minutes, which means that
the monitoring of this database will happen every 10 minutes. For this exercise, change
this value to 1 minute, so you will not have to wait as long to see the alerts being
generated.

4.10.2 Adjust the page refresh rates
Navigate to the Health Summary page, and find the option to change refresh intervals.
Click the down arrow next to the Recent xx minutes label. A window opens that lets you
change how often the Health Summary pages will auto-refresh itself to display recently
found alerts. The default is set to 5 minutes. For this exercise, change it to 1 minute to
minimize testing wait times.

4.10.3 Database availability
The Database Availability Alert checks the following status types for a database: Normal,
Quiesce Pending, Quiesced, Rollforward, and Unreachable. By default, a warning alert is
generated if the database is in Quiesce Pending or Rollforward state. A critical alert is
generated if the database is in Quiesced or Unreachable state.
The following error scenario will put the database in Quiesced state, so that a critical alert
will be generated.
1. Open a DB2 command window.
2. Connect to the database with the following command:
db2 connect to GSDB user db2admin using db2admin
3. Quiesce the database with the following command:
db2 quiesce db immediate
4. Navigate to the Health Summary page. Wait for one minute to see the Data Server
Status change from Normal (green) status to Critical (red) status. The Critical Count
should also now be raised by 1. Click the Critical Status icon, or the Critical Count
Number, to get more information on the alert.

4.10.4 Updating the alert configuration
In this section, follow these steps to generate a warning for a database in Quiesced state,
instead of the currently defined critical alert.
1. Navigate to the Health Alerts Configuration page.
2. Select the database that is in Quiesced state.
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3. Highlight the Database Availability row and click Edit.
4. Ensure that the Enabled option is selected.
5. In the Critical section, deselect the Quiesced option.
6. In the Warning section, select the Quiesced option.
7. Click OK.
After the monitoring refresh occurs on the Health Summary page, you will see the Data
Server Status change from Critical (Red) to Warning (Yellow). The Warning Count should
now be raised by 1. Do not be alarmed if the Critical Count is still showing 1. The counts
are a cumulative (summary) history of how many alerts have occurred within the past xx
minutes. If you select the critical alert, you will also see that there is now an end time for it,
meaning that the alert has closed. The start-end time duration is the time during which this
problem was present.
Finally, follow these steps to un-quiesce the database:
1. Open a DB2 command window.
2. Connect to the database with the following command:
db2 connect to GSDB
3. Unquiesce the database with the following command:
db2 unquiesce db
After the monitoring refresh occurs on the Health Summary page, you should see the Data
Server Status change from Warning (yellow) back to Normal (green). The previous warning
alert should also end. After the situation has returned to normal, you can still determine that
the database was quiesced because this information is reflected in the summary counts, as
well as in the Alert List page for that time duration.

4.10.5 Connections
The Connections Alert warns you when there are too many connections to a database at
the same time. By default, the Connections Alert is turned off, but preset to generate a
warning alert if the number of connections detected is greater than or equal to 100, and a
critical alert if greater than or equal to 150. Typically, you need to decide what number
constitutes a critical level, and what constitutes a warning level. What may be a perfectly
reasonable limit for one database may not be so for another database.
For this exercise, follow these steps to lower the thresholds for the alert, so you don't have
to create over 100 connections to trigger the alert:
1. Navigate to the Health Alerts Configuration page.
2. Select the database that you want to use for this scenario.
3. Highlight the Connections row and click Edit.
4. Select the Enabled option if it is not already selected.

Chapter 4 – Monitoring the health of your databases 157
5. Lower the values for Warning threshold to 1, and Critical threshold to 5.
6. Click OK.
Connect to the monitored database from the DB2 command line, or from the Data Studio
client, and leave the connections active. Once the monitoring refresh occurs on the Health
Summary page, you should see the Connections status change from No Alerts to either
Critical (red) or Warning (yellow), depending on how many connections are currently active
on that database.
If you close the connections to below the threshold value, this should close the alerts. Note
that the critical or warning summary icon would still be present to indicate that there had
been problems in that selected duration, but that these alerts now have an end time. This is
unlike the Status summary icon with the Data Server Status alert category.
Remember to reset this alert parameter (or disable the alert) to whatever is appropriate for
your database when you finish with this exercise

4.11 Summary
In this chapter, you've gotten a detailed look at the health monitoring features in Data
Studio web console, and learned how to alter configurations to better suit your monitoring
requirements for each database. You also learned how to try out some of the alerting
features of Data Studio web console, as well as how to start the monitoring features from
within Data Studio client.

4.12 Review Questions
1.

Can you modify the threshold for the alerts supported by Data Studio web console? If
so, how do you modify them?

2.

List the different alerts supported by Data Studio web console.

3.

How can you share the alerts generated by the web console with colleagues?

4.

How can you open the Data Studio web console from Data Studio client?
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Chapter 5 – Creating SQL and XQuery scripts
In this chapter, we will describe some basic data development tasks using SQL and
XQuery scripts in Data Studio.
The SQL and XQuery editor helps you create and run SQL scripts that contain SQL and
XQuery statements. This chapter describes how to use some of the features of the editor to
help you develop your SQL scripts more efficiently. The features in the editor are available
for all the data servers that are supported in the workbench, except for any that are
specifically noted as not supported. The editor includes the following capabilities:


Syntax highlighting



SQL formatting



Content assist



Statement parsing and validation with multiple version-specific database parsers



Semantic validation

You can run scripts serially against multiple database connections and choose an
execution environment, such as JDBC or the command line processor (CLP). The editor
provides you with flexibility by letting you change special registers to modify the current
schema and current path. In addition, you can export SQL scripts from and import SQL
scripts to the editor.
Through the editor, you can also schedule scripts for execution using the Job Manager
described in Chapter 6 and access the query tuning capabilities of Data Studio, described
in Chapter 7.
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5.1 Creating SQL and XQuery scripts: The big picture
In a nutshell, SQL and XQuery scripts assist with data development, which involves the
development, testing and deployment of database objects. You can store these scripts in
different types of data projects within the Data Project Explorer view. The primary projects
to store SQL and XQuery scripts in Data Studio are the data development project and the
data design project. Figure 5.1 shows both projects.

.
Figure 5.1 – Use data design and data development projects to store SQL scripts

5.1.1 Creating a data development project: SQL and XQuery scripts
Previously, we described the many perspectives available in Data Studio, including the
Data perspective. In this chapter, we will use the Data perspective for our data
development tasks. We will also focus on SQL scripts.
The first step is to create a data development project. You use data development projects
to develop and test database artifacts such as PL/SQL packages, SQL scripts, stored
procedures, user-defined functions, data web services, and XML documents. Related
artifacts such as web Services Description Language (WSDL) documents, XML schemas,
XML style sheets, and XML mappings are all stored in the project.

Chapter 5 – Creating SQL and XQuery scripts 161
To create a new data development project, make sure you are in the Data perspective, and
then select File -> New -> Data Development Project, as shown in Figure 5.2.

Figure 5.2 – Creating a new data development project
The New Data Development Project wizard, as shown in Figure 5.3, opens, guiding you
through the steps necessary to create a data development project. On the Data
Development Project page, specify a project name. Call it DataDevelopmentProject,
as this is the project name we’ll use throughout this chapter.

Figure 5.3 – Specifying the name for the new data development project
Select a database connection that should be used with the data development project on
the Select Connection page, as shown in Figure 5.4. You can select an existing connection
or create a new one by clicking the New button. In our case, we will select the GSDB
database connection.
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Figure 5.4 – Selecting a database connection
After you select a database connection, you can either click Next or Finish. If you click
Next, you can specify some application settings, such as default schema and default path,
as shown in Figure 5.5. If you decide to click Finish instead, the default values are used for
these settings.
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Figure 5.5 – Default Application Process Settings
Here are the descriptions of the fields shown in Figure 5.5:
 The Default schema setting is used to set the database CURRENT SCHEMA register
when deploying and running database artifacts like SQL scripts, stored procedures,
and user-defined functions. The CURRENT SCHEMA register is used to resolve
unqualified database object references.
 The Default path setting is used to set the database CURRENT PATH register when
deploying and running database artifacts. The CURRENT PATH register is used to
resolve unqualified function names, procedure names, data type names, global
variable names, and module object names in dynamically prepared SQL statements.
Note:
The application process settings that are available in this wizard depend on the
database server you are connecting to. The example shown lists the settings available
for DB2 servers.
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The default values for the schema and path are based on the database server and the
connection user ID. Since all of the tables we will be using from the GSDB database are in
the DB2ADMIN schema, you should change the application settings to include that schema
in the path and use it as the default schema, too.
You can do this by clicking in the drop down list for default schema and selecting
DB2ADMIN, as shown in Figure 5.6.

Figure 5.6 – Selecting a value for Default schema
One useful thing about Data Studio is that it provides content assist in several different
contexts. As you’ve just seen, it lists all the existing schemas in the database so that you
can just select one from a drop down list for the default schema. Content assist is only
available when you have an established connection to the database, either in live or offline
mode.
You also need to change the current path to account for the DB2ADMIN schema, as shown
in Figure 5.7.

Figure 5.7 – Default path for current path value
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Now that you have specified your project’s application settings, click Finish, and the new
project is created in your workspace in the Data Project Explorer view, as shown in Figure
5.8.

Figure 5.8 – A sample data development project
Figure 5.8 also shows that data development projects contain sub-folders that can be used
to create and store database artifacts that you develop. The sub-folders of a project
depend on the database server product and version used. For example, the PL/SQL
Packages sub-folder is displayed only for projects associated with a DB2 for Linux, UNIX
and Windows server that is version 9.7 or above.

5.1.2 Creating a data design project
Next we will create a data design project. You use data design projects to store data
modeling objects like logical data models, physical data models, domain models, glossary
models, and SQL scripts, including DDL scripts. Other file types such as document files,
text files, presentations, or spreadsheets are also stored in the project.
To create a new data design project, make sure you are in the Data perspective, and then
select File -> New -> Data Design Project, as shown in Figure 5.9.

Figure 5.9 – Creating a new data design project
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The New Data Design Project wizard, as shown in Figure 5.10, opens, guiding you through
the steps necessary to create a data design project. On the Create a data design project
page, specify a project name. Call it DataDesignProject, as this is the project name
we’ll use throughout this chapter.

Figure 5.10 – Specifying the name for the new data design project
Since you do not need a database connection to create a data design project, no additional
steps are needed. Clicking the Finish button will create the new project in the Data Project
Explorer view, as shown in Figure 5.11.
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Figure 5.11 – A sample data design project
Figure 5.11 also shows that data design projects contain sub-folders that you can use to
create data diagrams and data models. In this chapter we will focus on just the SQL Scripts
folder.

5.1.3 Creating new SQL and XQuery scripts: Using Data Projects
Data Studio provides development of SQL scripts for all database servers it supports. In
this section, you will learn how to create a new SQL script.
To create a new SQL script, right-click the SQL Scripts folder and select New -> SQL or
XQuery Script, as shown in Figure 5.12.

Figure 5.12 – Creating a new SQL or XQuery Script
Note:
You can develop XQuery scripts when you connect to a server with XQuery support,
such as DB2.
When you select SQL or XQuery Script, the New SQL or XQuery window opens, as shown
in Figure 5.13.
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Figure 5.13 – Creating a new SQL script using the SQL or XQuery editor
You can create SQL or XQuery script in two different ways: by opening a new SQL and
XQuery editor, or by using the SQL Query Builder.
Note:
The SQL Query Builder does not support XQuery.
The recommended way to develop SQL or XQuery scripts in Data Studio is by using the
SQL and XQuery editor. In this book, we describe both approaches; first with the editor and
then achieving the same result using the SQL Query Builder.
To create an SQL script using the editor, select the SQL and XQuery editor option on the
Script and Tool page of the New SQL or XQuery Script wizard, as shown in Figure 5.13.
When you click Finish, the SQL and XQuery editor opens for the newly created
Script1.sql, as shown in Figure 5.14.
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Figure 5.14 – SQL and XQuery editor for Script1.sql
Figure 5.14 shows the empty script in the editor. At the top of the editor is the editor
toolbar, which displays the database connection information. In this case, Connection:
localhost – DB2 – GSDB. You can show or hide the detailed database connection
information in the editor toolbar by clicking the control arrow next to the connection, as
shown in Figure 5.15.

Figure 5.15 – Reviewing the database connection information
You can use the command pane, found below the editor toolbar, to control the
configuration, validation, special registers, and performance metrics preferences for your
scripts. You can show or hide this pane. We will discuss these tabs in depth in the next
sections of this chapter.

5.2 Changing the database connection
As we saw in the last section, the editor toolbar shows information about the current
connection to the associated database. When you are developing your SQL script, the
database connection determines the information that is available in content assist, and the
vendor and version of the database determines the syntax validation of your SQL
statements. The database connection also might affect the results when you run the SQL
script. You can change the database that the script is connected to by clicking the Select
button on the Configuration tab, as shown in Figure 5.16.
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Figure 5.16 – Changing connection preferences with the Configuration tab
If you have connections to two or more databases in the Data Source Explorer view, then
select a different connection profile in the Select Connection Profile wizard, as shown in
Figure 5.17.

Figure 5.17 – Selecting a database connection
Alternatively, if you are connected to only one database, you can click New in the Select
Connection Profile wizard, and then define a new connection in the New Connection Profile
wizard.
You also can disconnect the script from a database. This is useful, for example, when you
want to work offline. To disconnect the script, select No Connection from the list of
connections, as shown in Figure 5.18.
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Figure 5.18 – Disconnecting the script from the database to work offline
After you select No Connection, the command pane is hidden automatically, as shown in
Figure 5.19, but you can restore the pane when you want to reconnect to the database. Do
this by clicking the No Connection link on the editor toolbar. This will bring the command
pane to view where you can select the connection profile for the database that you want to
connect to.

Figure 5.19 – When you work offline, the command pane is hidden
We will discuss the settings for Run method and Run options in Section 5.5.

5.3 Designing a script
The Validation tab of the command pane, as shown in Figure 5.20, contains controls that
you can use while you are creating the statements in your SQL script. You can validate the
syntax, the semantics, or both in the statements that you are creating. You can also
change the statement terminator for all the statements in the script.

Figure 5.20 – Validation tab
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5.3.1 Validating the syntax in SQL and XQuery statements
As you enter statements in the editor, the syntax of the statements is validated. The
statements are parsed to determine whether keywords and their location in the statements
are valid. The validation options that you specify determine the parser that is used.
By default, the selected parser is based on the type of database that the script is
connected to. As you can see in Figure 5.20, the Validate statement syntax for current
configuration option is selected, which means the selected parser is based on the type of
database that the script is connected to on the Configuration tab.
For example, suppose you develop a script that creates a SALES table with an index in the
DB2ADMIN schema of the GSDB database. In Figure 5.21, the script shows no syntax
errors with the DB2 for Linux, UNIX and Windows (V10.1) parser.

Figure 5.21 – Statements validated with current configuration associated with the
script
However, if you want to eventually run this script on a different database server, you can
validate it against that server type without changing your current database connection.
Simply select the option to validate the statement syntax and select a different parser from
the list. Currently, parsers for the following types of databases are available in the SQL and
XQuery editor:


DB2 for Linux, UNIX, and Windows (V10.1)



DB2 for Linux, UNIX and Windows (V9.8)



DB2 for Linux, UNIX, and Windows (V9.7)
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DB2 for z/OS (V10)



DB2 for z/OS (V9)



DB2 for i



Informix
Note:
Version-specific syntax checking for DB2 for Linux, UNIX, and Windows prior to V9.7
uses the DB2 V9.7 parser.

For example, suppose you want to use the script that creates the TESTTABLE table with its
index in a database on a DB2 for z/OS V10 server. To validate the script for the target
database, you can simply change the parser to DB2 for z/OS (V10), which you can do
while the script is still connected to the current database.
In this case, the ALLOW REVERSE SCANS clause in the CREATE INDEX statement is
invalid with the DB2 for z/OS V10 parser. The editor flags the validation error with red
markers in the left and right margins and underlines the invalid syntax with a red squiggly
line. As shown in Figure 5.22, you can review the message for a syntax error by hovering
over the error marker in the margin.

Figure 5.22 – Script statements validated with the DB2 for z/OS (V10) parser

174 Getting Started with IBM Data Studio for DB2
If you prefer, you can stop validating the syntax by selecting the No validation option from
the Validate statement syntax list.
If you are working offline (that is, with No Connection selected on the Configuration tab),
you can still validate the syntax in the SQL and XQuery statements that you are writing. On
the Validation tab, select the parser for the appropriate database type from the drop down
list for Validate statement syntax option, as shown in Figure 5.23. After you validate for one
database type, you can proceed to validate statements with the parser for a different
database type.

Figure 5.23 – Validating SQL statements offline with no database connection

5.3.2

Validating the semantics in SQL statements

You can also validate the references to tables and stored procedures in the database that
the script is connected to. Database object references are validated only in SQL data
manipulation language (DML) statements not data definition language (DDL). The state of
the Validate database object references option determines whether semantic validation
occurs as you type.
Semantic validation is associated only with the database that the script is currently
connected to. The parser that you select in the validation options has no effect on semantic
validation. You can select the option at any time during script development, whether or not
you select a parser for syntax validation.
Figure 5.24 shows a semantic error for a reference to the SALES table, which does not
exist in the GOSALESTEST schema of the GSDB database. The editor shows the same error
indicators for semantic and syntax errors.
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Figure 5.24 – Validate database object reference error in a DML statement

5.3.3

Changing the statement terminator

When you have multiple statements in an SQL script, each statement must be separated
from the one that follows by a statement terminator. By default, the SQL and XQuery editor
uses a semicolon (;) as the statement terminator. You can change the default statement
terminator for all scripts that you create in the editor by specifying the new default
statement terminator in Window -> Preferences.
You can specify a statement terminator for a specific script in the Validation tab. The
statement terminator that you set in an SQL script persists every time that you open the
script in the SQL and XQuery editor.
In a given script, you can use only one statement terminator. That is, all the statements in
an SQL script must use the same statement terminator. When you set the statement
terminator in an SQL script that contains existing statements, the editor does not update
the existing statement terminators automatically. Instead, you must manually update all of
the existing statement terminators in the script.
Figure 5.25 shows an example of the syntax validation error that occurs after you set the
statement terminator to an exclamation point (!), and do not update an existing statement
terminator. You will get an unexpected token error if you run the script after you stop
validating the syntax.
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Figure 5.25 – Invalid statement terminator after change from default

5.3.4

Content assist in the SQL and XQuery editor

Like many other Data Studio features, the SQL and XQuery editor provides content assist
to help you create SQL statements. Similar to the Java editor in Eclipse, content assist can
be triggered by pressing the key combination Ctrl+Space.
To create your SQL statement with content assist, type the expression select * from
and then press Ctrl+Space. This sequence of steps will display the content assist for
selecting database tables. When referencing fully qualified table names, you can take
advantage of content assist for multiple steps, as shown in Figure 5.26. Label 1 shows
content assist for the selecting a schema name, Label 2 for the table name, and Label 3 for
the column name.
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Figure 5.26 – Content assist in the SQL and XQuery editor
After you add the required table to the FROM clause of the SQL statement, the content
assist can also help you find additional columns from that table. You can use this capability
to help you complete the SQL statement. Figure 5.27 shows the COLOR column being added
to the SELECT clause of the SQL statement.
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Figure 5.27 – Content assist to reference table columns

5.4 Special registers
In the Special Registers tab, you can specify the current schema and path that you want to
use to run the SQL or XQuery statements against.
The Current schema register is used when you deploy and run database objects with your
SQL scripts. It resolves unqualified database object references. By default, the database
name from the current connection profile on the Configuration tab will be displayed if your
SQL does not specify a schema. To change it, click the Select button, then select a
different schema in the Select a schema window, as shown in Figure 5.28.

Figure 5.28 – Changing the current schema to different one
The Current path register is used when you deploy and run database objects with your
SQL scripts. It resolves unqualified function names, procedure names, data type names,
global variable names, and module object names in dynamically prepared SQL statements.
You can add schemas to the current path by clicking the Select button, as shown in Figure
5.29. Select one or more from the Select schemas window that opens.
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Figure 5.29 – Select multiple schemas for the current path

5.5 Running the script
To determine if an SQL script you are developing returns the expected results, you need to
run it. But first, you may want to modify how the SQL script will run. You can do this with
the run preferences on the Configuration tab, as shown in Figure 5.30.

Figure 5.30 – Run method and run options

Run method
Set the environment in which scripts run. The available environments are JDBC and
command line processor.
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Refresh explorer view after script is run
You can select this option to refresh the Data Source Explorer or Administrator Explorer
view after you run the script.

Open new connection when script is run
You can select this option to create a new connection to the target database that is used to
run your scripts.
By default, this option is selected. The Run method must be set to a JDBC environment if
you wish to deselect it. If you do, the information from the Connection field is used and the
Commit on completion of script and Roll Back on completion of script options are disabled.

On Success
These options specify how statements are handled when they are run successfully. The
availability of each option depends on the run method you select. More information is
available in the next section.

On Error
These options specify how statements are handled when an error occurs. The availability
of each option depends on the run method you select. More information is available in the
next section.

5.5.1 JDBC result preferences
Table 5.1 describes the behavior when statements are run successfully or encounter errors
in a JDBC environment:
On Success

On Error

Result

Commit after each
statement

Continue

If a statement is successful, it is committed
to the specified database.
If an error occurs, the next statement will
run.

Commit after each
statement

Stop

If a statement is successful, it is committed
to the specified database.
If an error occurs, the script will stop
running.

Commit on completion of
script

Continue

If all of the statements in the script are
successful, all statements are committed to
the specified database.
If an error occurs, the next statement will
run, and all successful statements are
committed to the specified database.

Commit on completion of

Stop and Commit

If all of the statements in the script are
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On Success

On Error

script

Result
successful, all statements are committed to
the specified database.
If an error occurs, the script will stop
running, and any statements that were
successfully run are committed to the
specified database.

Commit on completion of
script

Stop and Roll
Back

If all of the statements in the script are
successful, all statements are committed to
the specified database.
If an error occurs, the script will stop
running, and all successful statements are
rolled back.

Roll Back on completion
of script

Continue

If all of the statements in the script are
successful, all statements will be rolled
back.
If an error occurs, the next statement in the
script will run, and any successful
statements are rolled back.

Roll Back on completion
of script

Stop and Roll
Back

If all of the statements in the script are
successful, all statements will be rolled
back.
If an error occurs, the script will stop
running, and all successful statements are
rolled back.

Table 5.1 – Choosing success and error behavior in JDBC

5.5.2 Command line processor result preferences
Table 5.2 describes the behavior when statements are run successfully or encounter errors
in the command line processor.
On Success

On Error

Result

Commit after each
statement

Continue

If a statement is successful, it is committed
to the specified database.
If an error occurs, the next statement will
run.

Commit after each
statement

Stop

If a statement is successful, it is committed
to the specified database.
If an error occurs, the script stops running.
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On Success

On Error

Result

User managed commit

Continue

If a COMMIT statement is included in the
script, the statement is committed at that
point.
If an error occurs, the next statement will
run.

User managed commit

Stop and Commit

If a COMMIT statement is included in the
script, the statement is committed at that
point.
If an error occurs, the script will stop
running, and any statements that have run
are committed to the specified database.

Table 5.2 – Choosing success and error behavior in the command line processor
environment

5.5.3 SQL Results view
Now that you have explored the Run preferences, you are ready to run your SQL script.
Click the Run SQL button (
) on the editor toolbar. The script is run against the
database that the script is currently connected to. The progress and results of running the
script are then displayed in the SQL Results view.
Figure 5.31 shows the result of SQL statements with JDBC run method and with JDBC
preferences in the SQL Results view.
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Figure 5.31 – JDBC run method and with JDBC preferences
Figure 5.32 shows the result of SQL statements with the command line processor run
method and with command line processor preferences in the SQL Results view.
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Figure 5.32 – Command line processor run method and with command line
processor preferences

5.6 Creating SQL statements with the SQL Builder
In this section, you will learn how to develop a query using the SQL Query Builder instead
of the SQL and XQuery editor.
Right-click your data development project in the Data Project Explorer and then select New
->SQL or XQuery Script and select the SQL Query Builder option, as shown in Figure 5.35.
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Figure 5.35 – Build an SQL script using Query Builder
When using the SQL Query Builder, you can select from several SQL statement types, as
shown in Figure 5.36.

Figure 5.36 – Selecting a statement type
After you have selected the statement type, click Finish. In this example, choose the
SELECT statement type.
After you click Finish, the new file, Script2.sql is stored in the SQL Scripts folder of
your project. The SQL Builder also automatically opens so that you can construct your
statements, as shown in Figure 5.37.
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Figure 5.37 – Script2.sql opened in the SQL Builder
The SQL Query Builder provides an easy-to-use interface to create SQL statements. You
can specify which tables will be included in the statement and, from those tables, select the
columns to be returned or used for filtering.
Start by following the instructions in the editor to add a table:
1. Right-click in the middle pane and select Add table to select a table from the database.
Select the GOSALES.BRANCH table, which adds this table automatically to your script.
2. Then select the table columns you want to include in your SQL SELECT statement. You
can select the columns directly from the pane that opens when you selected the table.
Select the CITY column, as shown in Figure 5.38.
3. In the Conditions tab, add the value filter by selecting the column PROV_STATE, the
operator =, and typing in the value ‘CA’, as shown in Figure 5.38. When you move
your mouse from this input table, this WHERE clause is added to the script.
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Figure 5.38 – Using the SQL Builder to create a SQL statement
The SQL Builder is useful when you need to create queries that use joins, full selects, and
sub-selects, because the builder lets you add several tables, select multiple columns from
different tables, and specify conditions, grouping, and sort order.
Here are a few examples that show how SQL Builder can help you create more complex
queries:
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Example 1: Figure 5.39 shows a join query created by using ROUTINEDEP and ROUTINES
tables from the SYSCAT schema. You can see how the interface lets you create the join
query by specifying the columns, conditions, groups and group conditions.

Figure 5.39 – Using the SQL Builder to create a JOIN query statement
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Example 2: Figure 5.40 shows a full select statement (UNION ALL) of the tables
SYSCAT.ROUTINEDEP and SYSCAT.ROUTINES that also includes an ORDER BY clause.

Figure 5.40 – Using the SQL Builder to create a full select statement
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Example 3: Figure 5.41 shows an INSERT statement created with a sub select.

Figure 5.41 – Using the SQL Builder to create an INSERT with sub select statement

5.7 Summary
In this chapter we described some basic tasks that can help you develop SQL scripts more
efficiently, with features such as syntax highlighting, SQL formatting, content assist,
semantic validation, statement parsing, and validation. SQL script development is
simplified when you can run SQL scripts with multiple database vendors and navigate the
SQL results from a single view.

5.8 Review questions
1. Which are the two available types of data projects for creating SQL scripts in the Data
Project Explorer?
2. List and describe the DB2 application process settings that you can configure when
creating a data development project.
3. The Data Project Explorer is part of which Data Studio perspective?
A. Database Development perspective
B. Data perspective
C. Database Debug perspective
D. Resource
E. None of the above
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4. Which tab in the command pane of SQL and XQuery editor helps you to change the
database connection?
A. Configuration
B. Validation
C. Special Registers
D. None of the above
5. What are the available database vendors and versions for syntax validation under the
Validate statement syntax option?
6. Is content assist available in the SQL and XQuery editor?
7. What special registers are available in the SQL and XQuery editor?
A.

Current schema

B.

Current path

C.

Current schema and Current path

D.

None of the above

8. What are the available run methods?
9. Is the rollback preference option is available for the command line processor run
method?
10. In which Data Studio view can you see the results of executing your SQL statements?
A.

Data Source Explorer

B.

Project Explorer

C.

SQL Outline

D.

SQL Results

E.

None of the above

11. What other capability is supported by the SQL and XQuery editor?
A.

Visual Explain

B.

InfoSphere Optim Query Tuner

C.

Performance Metrics

D.

Job Manager

E.

All of the above
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12. Which tool or tools can be used to create SQL scripts?
A.

SQL editor

B.

SQL and XQuery editor, SQL query builder

C.

Database object editor, SQL query builder

D.

Routine editor, SQL and XQuery editor

E.

None of the above

13. Which of the following set of commands represent all the commands that are available
for creating SQL statements with the SQL Query Builder?
A.

SELECT, INSERT, UPDATE, DELETE

B.

SELECT, INSERT, UPDATE, JOIN, FULLSELECT, WITH

C.

SELECT, INSERT, UPDATE, DELETE, FULLSELECT, WITH

D.

SELECT, INSERT, UPDATE, DELETE, JOIN, FULLSELECT, WITH

E.

None of the above.

14. What are the major features that differentiate the components of the SQL Query
Builder and the SQL and XQuery editor?
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Chapter 6 – Managing jobs
Job management is a feature of the Data Studio web console component that is intended
to replace the DB2 Control Center Task Center and other scheduling tools that you might
have used with DB2 databases in the past. The job manager provides you with the tools
needed to create and schedule script-based jobs on your DB2 for Linux, UNIX, and
Windows and DB2 for z/OS databases from a web console interface.
In this chapter you will:


Learn about the job scheduling capabilities of the Data Studio web console



Create a SQL script-based job



Run the job manually



Schedule the job to run on the sample database



Set up monitoring of the job and check the job history

6.1 Job management: The big picture
As mentioned in Chapter 1, Data Studio web console contains both health monitoring and
job management features. This chapter gives an overview of the basic capabilities of the
job manager feature of the web console.
For the purpose of this chapter, you will be using the Data Studio web console default
administrative user (default user ID: admin) for all job creation and scheduling. You created
this user when you installed the Data Studio web console. The default administrative user
has administrative access to the web console.
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The default administrative user privileges only apply to the web console interface. The
default administrative user does not have any privileges on the databases that you want to
schedule jobs on. When you schedule or run a job on a database, you must provide a user
ID that exists on the database on which you want to run the job. That user ID must have
permissions to run the commands contained in the script part of the job on the database.
Note:
Optionally, you can set up the Data Studio web console to allow users other than the
default administrative user to log in to the web console. To do this, you must add a
repository database and configure the Data Studio web console to allow users of that
database to log in to the web console. For more information on how to use the Data
Studio web console with multiple users, see Appendix B.

6.2 Job management in the Data Studio web console
To manage jobs with Data Studio you must install the Data Studio web console. If you have
not installed the web console, follow the instructions in Chapter 1. After you log in to the
web console, you can open the job manager by selecting Open -> Job Manager, as seen in
Figure 6.1.

Figure 6.1 – Opening the job manager from the web console
Note:
You can open the job manager embedded in the Data Studio client to extend the
function of the client with health monitoring and job management. For information about
how to embed the Data Studio web console in the Data Studio client, see Appendix B.1
Integrating Data Studio web console with Data Studio full client.
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6.3 Jobs and job components
A job is a container that holds the components that are required to run a script on one or
more databases. When you create a job, you can either schedule it to run on one or more
databases, or you can leave the schedule component of the job empty. A job can also be
run manually from the Job List tab of the job manager. You can also configure multiple jobs
to run sequentially by adding a chain of jobs to the job that you are creating.
The job does not contain any information about which databases that the job will run on.
The database information is included in one or more schedules that you can create for
each job.

6.3.1 The components of a job
A job consists of several components, all of which can be defined when you create a job.
The only job components that are required to create a valid job are the job name, the job
ID, and the script. These components are described in Table 6.1.
Job
component

Description

Job ID and
name
(required)

The job ID is the unique identifier of the job and is generated automatically by
job manager. The job name that you specify can be used as a descriptive way
to easily identify the job in the job list or when scheduling jobs.

Script
(required)

The script is the executable part of a job and defines the actions that are done
on the database when the job is run. You can enter one script per job.
Important: The job manager does not provide a script editor and does not
verify that the scripts that you enter are valid. Run the script on a database or
use other methods to verify that the script is correct and that it produces the
expected results before you schedule the job in the job manager.

Schedule

A schedule defines when a job will be run, whether the job is repeating, and
whether the schedule is limited in number of runs or in time. The schedule
also defines one or more databases on which to run the job.
A job can have any number of schedules attached to it, but each schedule
only applies to one job. A schedule must be active to run the job. Each
schedule has a unique ID that is based on the job ID with an integer
appended at the end of the ID.
Example:
The first schedule that is attached to job ID 1234 will have schedule ID 12341. The second schedule that is attached to the same job will have schedule ID
1234-2, and so on.
A schedule is not required; you can also run jobs manually from the job
manager. When you schedule a job on a single database, you can define the
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user ID that will run the job. If you schedule a job to run on more than one
database, the job is run on each database by the user ID that is stored in the
database connection for that database.
Notification

Notifications are one of two methods that you can use to determine whether
your jobs ran successfully. Use notifications to alert you by email on the
successful or failed run of a job on your databases.
The other method of determining the outcome of your jobs is to look in the job
history tab of the job manager, where you can see the status of all jobs on all
databases that are configured for your system.

Chains

You can add a chain of subsequent jobs that run depending on the outcome
of the primary job. A job chain can consist of three consecutive jobs: the
primary job, a job that runs if the primary job is successful or a job that runs if
it is unsuccessful, and finally an ending job that runs at the end of the chain
regardless of the outcome of the preceding jobs.
Important:
When a job is run as part of a chain, any schedules and chains that are
associated with that job are ignored.

Table 6.1 – Components of a job

6.3.2 Job types
The job manager supports three default job types. The job type indicates the way that the
job manager connects to the databases to run the scripts.
Job type

Connection method

SQL-only script

The job manager connects to the database and runs the SQL
commands that are included in the job script directly on the
database.

DB2 command line
processor script

The job manager logs in to the database server by using SSH as
the user ID defined in the database connection, and then it runs
command line processor commands directly on the DB2 console
of the server.

Executable/Shell
script

The job manager logs in to the database server by using SSH as
the user ID that is defined in the database connection, and then
runs shell commands directly on the server.

Note:
To run DB2 command line processor script jobs or executable/shell script jobs on a
database, the user ID that is used to run the job must have permission to log in to the
database server by using SSH.
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6.4 Create and schedule a job
Use the Job List tab in the web console to create, schedule, and manage jobs for your
databases or to run existing jobs directly against a database without scheduling. The first
time you open the job manager, no jobs have been created, and the job manager informs
you what needs to be done to create one.

Figure 6.2 – The Job List page with no jobs created
When you create a job or open an existing job, the job details open in the job editor. If you
have more than one job open for editing, each job opens in its own tab. Within each tab
you can use the Job Components menu to drill down into the components of each job.
If you have configured the Data Studio full client for Data Studio web console, you can also
schedule a script to run as a job directly from the SQL script editor. See 6.7 Scheduling
jobs from the Data Studio client for more information.
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6.4.1 Creating jobs
To create a job using job manager:


From the Job List, click Add Job to open the Add Job wizard, where you can enter the
basic properties of the new job.

Figure 6.3 – Click Add Job to add a new job
The following list describes the basic job properties:


Name: A descriptive name for the job.



Type: The type of job you want to create. The job type decides how job
manager connects to the database to run the script.



Enabled for scheduling: Select this option to enable the job for scheduling. If
the option is not selected you cannot schedule the job, but you can still run it
manually from the job list.



Description: A short description of the job.
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Figure 6.4 – Enter the basic properties for a job
After you have entered the basic properties, an entry is created for the job in the Job List
and you can configure the remaining job components.


Click a component in the Job Components menu to configure the component.

Figure 6.5 – The job components menu


Click Script to add a script to the job. The script is the executable part of a job and
defines the actions that are done on the database when the job is run. A job must contain
a script.
Important:
The job manager does not provide a script editor and does not verify that the
scripts that you enter are valid. Run the script on a database or use other
methods to verify that the script is correct and that it produces the expected
results before you schedule the job in the job manager.
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For this example, we will use the following sample test script which will create a new
table and then immediately drop the same table, leaving the database untouched:
create table employee(c1 int, c2 int);
drop table employee;

Figure 6.6 – The script component


Optional: Click Schedules and then click Add Schedule to add one or more schedules to
the job.
A schedule defines when a job runs, whether the job is repeating, and whether the
schedule is limited in number of runs or in time. The schedule also defines one or more
databases on which to run the job. A job can have any number of schedules attached to
it, but each schedule only applies to one job.
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Complete the schedule details and databases sections and then click Apply Changes or
Save All to add the schedule to the job:


Specify the schedule details by selecting a start date and start time for the job. If you
want the job to repeat, select the Repeats option, and set the repetition parameters
for the job. A schedule must be active to run the job.

Figure 6.7 – Specify a schedule.


Specify the databases on which you want to run the job.

Important: If you need to select a database, the database must first be
added as a database connection in the web console. For information on
how to add database connections, see Chapter 4.
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Figure 6.8 – Select a database
When you schedule a job on a single database, you can define the user ID that will run
the job. If you schedule a job to run on more than one database, the job is run on each
database by the user ID that is stored in the database connection for that database.
Important:
If the user ID that is used to run the job does not have the required permissions
to perform the commands that are defined by the script for the database, the job
fails with a permissions error. If you are scheduling the job for a single database,
update the schedule with a user that has the required permissions. If you are
scheduling the job to run on more than one database, use the Databases page
to update the database connection with a user ID that has the required
permissions.



(Optional) Click Chain to add a chain of additional jobs that will run conditionally when
the main job has completed. In a chain, the main job is followed by a secondary job that
is dependent on the outcome of the main job, and then followed by a finishing job that
performs cleanup operations, such as RUNSTATS and BACKUP. You can add a chain of
subsequent jobs that run depending on the outcome of the primary job.
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Figure 6.9. – Select additional jobs that will be chained to the current job



(Optional) Click Notifications and then Add Notification to configure email notifications to
be sent to one or more users depending on the success or failure of the job. For more
information about how to set up notifications, see Section 6.6.



Click Save All to save the job and its schedule to the web console. You can now select
the job in the Job List tab to run it or edit the job components if needed.
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6.4.2 Scheduling an existing job
You can add new schedules, or modify existing schedules for a job from the Schedules tab
in the web console. Use the Schedules tab to create and manage schedules for the jobs
you have created for your databases. The schedule also defines one or more databases on
which to run the job. A job can have any number of schedules attached to it, but each
schedule only applies to one job.
To add a schedule to an existing job:


On the Job Manager page, open the Schedules tab and click Add Schedule.

Figure 6.10 – Adding a schedule to an existing job


In the Add Schedule wizard, select a job that you want to schedule and click OK. The job
opens with the Schedules component selected.
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Figure 6.11 – Selecting the job


Click Add Schedule to add one or more schedules to the job. A schedule defines when a
job will be run, whether the job is repeating, and whether the schedule is limited in
number of runs or in time.
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Complete the schedule details and databases sections:


Specify the schedule details by selecting a start date and start time for the job. If
you want the job to repeat, select the Repeats box, and set the repetition
parameters for the job. A schedule must be active to run the job.



Specify the databases on which you want to run the job.

Figure 6.12 – Adding a schedule to a job


Click Save All to save the new schedule to the web console. You can now select the
schedule in the Schedules tab to edit it if needed.
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6.5 Running a job without scheduling
You do not have to add a schedule a job to run it. You can run your jobs directly from the
Job List tab to verify that they work correctly before you schedule them.
To run a job directly:
1. From the Job List, select the job that you want to run and click Run Job.

Figure 6.13 – Running a job directly
2. Select one or more databases on which to run the job. When you select to run a job on a
single database, you can define the user ID that will run the job or use the user ID that is
stored in the database connection for that database. If you schedule a job to run on more
than one database, the job is run on each database by the user ID that is stored in the
database connection for that database.
3. Click OK to run the job on the selected databases. Open the History tab to see the job
status details and the log file for the job.

6.6 Monitoring jobs: Notifications and job history
The jobs managed by the job manager run on the databases that you select when you
attach a schedule or when you run the job directly. You can monitor the status of your jobs
without having to log in to the web console by setting up email notifications for your jobs.
You can also view the historical record for each job from the web console by browsing the
complete job history overview or by accessing the job log files.
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6.6.1 Setting up email notifications
The job manager notifications help you monitor the results for your jobs across multiple
databases and schedules without requiring access to the web console.
Each job can have any number of notifications configured, and each notification can be set
up with different conditions, a different set of users to notify, and different collections of
databases to monitor.
To set up email notifications:
1. From the Job List, select the job that you want to add email notifications for and click
Edit.
2. In the job that opens, from the Job Components menu, select Notifications.
3. In the Email Recipients field, enter an email address, or enter two or more email
addresses separated by commas.
4. Select one or more databases. Notifications will be sent when the job runs on the
database. Select the criteria for which a notification will be sent. The criteria can be
that the job fails, that the job succeeds, or that the job fails or succeeds.
5. Click Save All to save the notification for the job.
Notifications are added specifically for a job. Each job can have one or more schedules
attached to it, where each schedule has its own collection of databases that the job will run
on.

Figure 6.14 – Configure notifications for the job

Important:
To send notifications you must first configure the web console with the details about your
outbound SMTP mail server so that information can be sent to e-mail addresses. From
the web console, select Open -> Product Setup -> Services. In the Services tab, select
Email service and click Configure to configure the email service. To configure this
service, you need an SMTP host name and port number for your email server. If the
SMTP server uses authentication, you will also need the user authentication details.
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6.6.2 Viewing the history of a job
The History tab of the main Job Manager page shows a basic status overview of the jobs
that ran over the last few days. The job history is displayed for jobs that ran according to a
schedule in addition to jobs that you ran manually. The job history is accessible at two
levels of detail: the overview displayed in the History tab, and detailed job logs.

Figure 6.15 – Browsing your job history
To view more detailed information about a job, you can open the individual log for each job
by selecting the job in the job history grid and clicking View log in browser. The log
contains the output of the job script and lists any exceptions or other messages related to
the job. If a job failed for some reason, the job log can help you to troubleshoot the
problem.

Figure 6.16 – Viewing more details for your jobs
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By default, the job manager keeps the history of a job for three days. You can configure
how long the job history records are kept in the job history settings. You can also set the
type of job results that you want to keep. By default, both successful and failed job records
are kept. To change the job history settings for the Data Studio web console, from the
History tab, click Job History Settings.

Figure 6.17 – Configure the job history settings

6.7 Scheduling jobs from the Data Studio client
You can run and schedule jobs from the Data Studio client using the SQL script editor.
When you have created your script you can select to schedule the script to run as a job in
job manager. When you select the option to schedule the script, the job manager
embedded in the workbench or in the Data Studio web console in a standalone web
browser window opens.
When you schedule a job from the SQL script editor, the job manager creates a new
unique job with that automatically uses the script. You must then select one or more
databases to run the job against. You can also schedule the job to run at a specific time, or
save the job without a schedule if you want to run the job manually.
Note:
To schedule jobs from the Data Studio full client, you must first open the Data Studio
web console embedded in the client. For more information, see Appendix B.1 Integrating
Data Studio web console with Data Studio full client.
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Figure 6.18 – Schedule a script from the Data Studio client SQL editor

6.8 Exercises
In this set of exercises, you will create a job and run it on the Sample Outdoor Company
database, then schedule the job to run at a later time. You will also verify that the job ran
successfully by looking at the job history for the job.
1. Use the Job Manager page to create a new job on the Sample Outdoor Company
database using the sample script in this chapter. Do not add a schedule to the job
when you create it. You will add a schedule later.
2. Run the job manually from the Job List tab.
3. Use the History tab to verify that the job ran successfully.
4. From the Schedules tab, schedule the job to run in five minutes.
5. Use the History tab to verify that the job ran successfully.

6.9 Summary
In this chapter you have learned about the components of a Data Studio web console job,
and about the various types of jobs that can be scheduled. You have also learned how to
create and schedule jobs on your databases, and how to run a job directly without
scheduling. At the end you have learned how to view the status of your jobs by email
notification and by viewing the history of your jobs. And finally you have learned how to
schedule a job from the Data Studio full client.
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6.10 Review questions
1.

True or false: A job contains all the information that is needed to run a script on a
database server, including the script, the database information, and the date and time
when the job will run.

2.

If you want to configure the job manager to send notifications on successful job
executions, what must you configure first in the Data Studio web console?

3.

Which jobs can you run directly from the job list?
A. Only jobs that have no schedules attached.
B. Only jobs that have schedules attached.
C. All jobs.

4.

What job types are supported by the job manager?

5.

If you schedule a job to run on more than one database, you can:
A. Specify the user ID and password that will run the job for all databases.
B. Specify the user ID and password that will run the job for one of the databases
only.
C. Not specify the user ID and password that will run the job for the databases. The
user ID and password is specified in the database connection for each database.

213

Chapter 7 – Tuning queries
In this chapter, you’ll learn more about some of tools and solutions from IBM that can help
you address the bigger challenges of tuning your queries for DB2 to improve performance.
In this chapter you will learn how to:


Configure DB2 to enable query tuning



Use the SQL and XQuery editor to generate query execution plans



Capture SQL statements from various sources (such as a file or other products that
have SQL statements)



Start query tuning and how to analyze the results, run reports, and save the analysis

7.1 Query tuning: The big picture
When you first learn to write SQL statements, you are probably most concerned about
ensuring that you are writing them correctly to ensure that you’re getting the right
information back. However, if a query you write unexpectedly causes a slowdown of an
application, any end users you are supporting may be very unhappy.
It is good practice for any SQL developer to gain a basic understanding of how the SQL
they write is translated and run by DB2 and to have some idea of whether the SQL they
write is efficient. For example, if the SQL you write causes DB2 to have to scan the entire
table to return each qualifying result, that could be a major performance problem that could
be solved by including an index. To give another example, DB2 could use inaccurate
information in the system catalog to decide how to find data. Statistics about the size of
tables, about data distribution, or about other aspects of your data might be out of date, be
missing, or suffer from conflicts. Simply updating the statistics might improve performance.
The process of analyzing how a statement runs and changing the statement or
environment to improve its performance is referred to as query tuning.
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Note:
Understanding how DB2 chooses an access path and other concepts related to query tuning
are beyond the scope of this book. It’s a good idea to read up on some concepts. Here are
some sources:


DB2 information center:
http://pic.dhe.ibm.com/infocenter/db2luw/v10r1/topic/com.ibm.db2.luw.admin.perf.doc/do
c/c0054924.html



DB2 query tuning best practices:
http://www.ibm.com/developerworks/data/bestpractices/querytuning/



SQL tips for DB2:
https://www.ibm.com/developerworks/mydeveloperworks/blogs/SQLTips4DB2LUW/?lan
g=en

Data Studio can help make query tuning easier because it lets you:


See in a diagram the execution plan that DB2 uses to run a statement



Format a statement so that it is easier to read and understand.



Find out whether the existing statistics are accurate for database objects that are
involved in the execution of a statement. If the statistics are not, a tool called the
Statistics Advisor can recommend RUNSTATS control statements for fixing them.

Note that there are more extensive query tuning tools and other advisors available in the
chargeable product InfoSphere Optim Query Workload Tuner 3.1.1.

7.2 Configuring DB2 to enable query tuning
To use query tuning, you must create a database connection as given in Chapter 2 and
that database must be configured to enable query tuning. This section describes how to
use the configuration wizard to configure query tuning.
To tune queries, you must switch to the IBM Query Tuning perspective.
Open the Window menu and select Open Perspective -> Other, then choose the IBM
Query Tuning perspective, as shown in Figure 7.1.
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Figure 7.1 – Opening the IBM Query Tuning perspective
The IBM Query Tuning perspective is shown in Figure 7.2. Use the Data Source Explorer
to connect to local or remote databases.
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Figure 7.2 – The IBM Query Tuning perspective
To create a new database connection, follow the steps in Chapter 2.
After you create the connection, configure the database connection by right-clicking the
database name in the Data Source Explorer view and selecting Analyze and Tune ->
Configure for Tuning -> Guided Configuration as shown in Figure 7.3. When you select
Guided Configuration, DB2 for Linux, UNIX, and Windows databases are configured
automatically. This configuration includes the creation of the DB2 EXPLAIN tables, if they
don’t already exist. To learn more about EXPLAIN tables in DB2 V10.1, read the following
document:
http://pic.dhe.ibm.com/infocenter/db2luw/v10r1/topic/com.ibm.db2.luw.admin.perf.doc/doc/
c0005134.html
Note:
If EXPLAIN tables exist on a database, you might need to migrate them to the current
version or format. You must have certain authorities and privileges to migrate EXPLAIN
tables. See the following topic in the Data Studio Information Center for the required
authorities and privileges:
http://publib.boulder.ibm.com/infocenter/dstudio/v3r1/topic/com.ibm.datatools.qrytune.
configothers.doc/topics/authmigrateluw_ds.html
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You can use advanced configuration, as shown in Figure 7.3.

Figure 7.3 – Configuring tuning for a database connection
When you select Advanced Configuration and Privilege Management, the Advanced
Configuration and Privilege Management window opens, as shown in Figure 7.4. If the
EXPLAIN tables are not created in the DB2 instance, you can create them from the
Advanced Configuration and Privilege Management window by clicking the Create button.
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Figure 7.4 – Advanced configuration view
After you create the EXPLAIN tables, a green check mark appears to let you know that you
can continue tuning your database. An example of this check mark is shown in Figure 7.5.

Figure 7.5 –Advanced configuration view of enabled EXPLAIN tables
Review the features that are available by opening the Features tab in the Advanced
Configuration and Privilege Management window. The available features open as in Figure
7.6. The available features include:


The Statistics Advisor, which analyzes the existing statistics on database objects that
are involved in the execution of SQL statements and can recommend RUNSTATS
control statements for improving those statistics
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Query formatting, which displays a query’s syntax in a structured format



The Access Plan Graph, which display access plans that DB2 uses to execute SQL
statements



Summary reports, which tie the output of the preceding features together in a report
that you can share

Figure 7.6 – Advanced configuration view of the available query tuning
features

7.3 Start tuning
There are two ways to start tuning:


Right-click the database connection in the Data Source Explorer view. In the menu, as
shown in Figure 7.7, select Analyze and Tune -> Start Tuning.
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Figure 7.7 – Opening the query tuning features


Another way to start query tuning is from the SQL and XQuery editor. To open the
editor, select New SQL Script.

As described in Chapter 5, the SQL and XQuery editor lets you enter and run SQL
statements. You can also create an access plan graph with Visual Explain and start query
tuning.
You can add SQL statements to the editor, as shown in Figure 7.8.

Figure 7.8 – SQL and XQuery editor
You can start query tuning by highlighting a statement in the editor, right-clicking it, then
selecting Start Tuning as shown in Figure 7.9.
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Figure 7.9 – Opening the query tuning features from the SQL and XQuery editor

7.4 Tuning an SQL statement
This section leads you through the typical workflow of tuning an SQL statement, from
selecting the statement to be tuned all the way through analysis.
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7.4.1 Selecting statements to tune (Capture view)
When you select Start Tuning, the Query Tuner Workflow Assistant opens to the Capture
section, which lets you obtain a statement from various sources such as. An example of
the Capture view is shown in Figure 7.10:


The query editor



A file



An Optim Performance Manager repository



The package cache



A bound package



The statements from an SQL procedure

In this case, we are tuning the statement entered in the statement editor area for the query
editor.
Select Input Text from the list of tuning sources, then enter a statement and click the
Invoke Advisors and Tools button as shown in Figure 7.10.

Figure 7.10 – Specifying the statement to be tuned in the Query Tuner Workflow
Assistant (Capture section)
The Invoke section opens.
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7.4.2 Run the Statistics Advisor and tools (Invoke section)
In the Invoke section, show in Figure 7.11, you will see the SQL statement that is to be
tuned. You can edit the statement. You can also change the CURRENT SCHEMA used to
explain the statement by changing the value in the Schema area.
1. To run the Statistics Advisor and tools, select the Select What to Run button as shown
in Figure 7.11.

Figure 7.11 – Opening the advisors and tools in the Query Tuner Workflow Assistant
(Invoke section)
A new window opens, where you can select query tuning advisors and tools that are to
be run, as shown in Figure 7.12. You cannot select features that are not available to
IBM Data Studio.
Note:
To tune SQL statements with the full set of tuning features, you must
activate a license for IBM® InfoSphere® Optim™ Query Workload Tuner
on the DB2 databases that you work with.

2. Select the features that you want to run. After you have selected the features to run,
click OK in the Select Activities window.
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Figure 7.12 – Specify what query tuning tools should run
When the query tuning features that were selected above are completed, you will be
placed into the Review section where the results and recommendations are displayed.
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7.4.3 Review the results and recommendations (Review section)
When the query tuning activities you selected are complete, the Review section opens, as
shown in Figure 7.13.

Figure 7.13 – Review section after the Statistics Advisor and tools finish running
On the left side, there is a list of options for a single query:


Open Single-Query Advisor Recommendations displays the Statistics Advisor
recommendations.



Open Formatted Query displays a formatted query, as shown in Figure 7.14. The
formatting will place each column, table and predicate on separate lines with
indentation so that you can analyze the syntax of the statement to determine if it
makes sense. You can select a column, predicate or table in the formatted view
and all column and predicate references as well as the table will be highlighted.
The highlighting allows you to quickly identify how the table is being used and if
it’s being used properly in the statement.
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Figure 7.14 – Open Formatted Query view


Open Access Plan Graph shows a visual representation of the access plan that
DB2 uses to run a statement, select as shown in Figure 7.15. The access plan
graph is a collection of connected operators that depict the access plan for the
statement.

Figure 7.15 – Open Access Plan Graph view
In the graph area, you can hover over any operator and summary information will
popup including the operator’s estimated cardinality, and the total cost estimated by the
DB2 optimizer.
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For more operator details, you can click or double click on the operator to see that
information under Description of Selected Node.
Note: You can also generate the plan graph by using the Open Visual Explain
option from the SQL and XQuery editor as shown in Figure 7.9. More details on
using Visual Explain option are provided in Section 7.5.

3. Open the Statistics Advisor summary by selecting Open Single-Query Advisor
Recommendations as shown in Figure 7.16.

Figure 7.16 – Open Single-Query Advisor Recommendations view
4. To see details of the recommendation, you can double click on the recommendation in
the Summary tab, or you can right-click the Statistics row and select View Details, as
shown in Figure 7.17.
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Figure 7.17 – Viewing Statistics Advisor options or recommendations
An example of the Statistics Advisor recommendation details are shown in Figure 7.18.


RUNSTATS commands stored on data server contains the previous RUNSTATS
commands stored in the statistics profile; otherwise, this area will be blank.



Recommended RUNSTATS commands contains new recommended RUNSTATS
commands. The advisor is able to recommend statistics it deems to be missing that the
DB2 optimizer can make use of to improve the query access plan. These
recommended statistics can include distribution statistics and column groups for base
tables and materialized query tables.



Statistics Advisor report contains more details on the recommendation.
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Figure 7.18 – Statistics Advisor recommendations
When you are satisfied with the recommendation and want to proceed with executing on it,
you can select the green “run” icon (
) as shown in Figure 7.18 to run the RUNSTATS
commands.

7.4.4 Review the query tuner report
You can view a text version of these advisors and tools in HTML format by selecting Open
Summary Report as shown in Figure 7.19. The information in this report includes access
plan information, such as the tables accessed, all columns of that table, statistics, indexes,
and predicates. Also included are the RUNSTATS recommendations from the Statistics
Advisor. You can pass this report to other users to share and compare results.
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Figure 7.19 – IBM Query Tuner Report

7.4.5 Save the analysis results
You can exit a tuning session by selecting the X in the view title for the tuning session that
you’re in.

When you exit the query tuner workflow assistant, you will be prompted (as shown in
Figure 7.20) to save the analysis result into a project in the Project Explorer area. The
project you are saving is a Query Tuner project and will let you archive previous analysis
results and compare them if needed.
Recommendation: Create a project for each different connection. The analysis result will
be saved under a query group name in that project.
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To save the result, select Save and Exit.

Figure 7.20 – Prompt to save the results from a tuning session

The analysis result is stored under the query group name as shown in Figure 7.21. You
can store multiple results under this name for the same or different queries. When you
want to view the analysis results again, simply double click the result you want to review.
The query tuner workflow assistant opens with the analysis result. You can rerun query
tuning features by using the Invoke view, or you can view the analysis results under the
Review view. You can even re-capture a statement in the assistant from this previous
result.

Figure 7.21 – Project Explorer area under the IBM Query Tuning perspective
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7.5 Opening Visual Explain from the SQL editor
If you are developing SQL statements and quickly want to see a visualization of the access
plan, you can start Visual Explain directly from the SQL editor.
1. From the SQL editor, right-click the query and select Open Visual Explain.
2. Specify how data should be collected. An example of this window is shown in Figure
7.22. You should indicate the statement delimiter and whether to retain the explain
information on the data server (that is, store the data in the explain tables).

Figure 7.22 – Specifying how data is collected
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3. Optionally, click Next to change the default special registers that are used by the
optimizer to generate the access plan, as shown in Figure 7.23. These include the
CURRENT SCHEMA and QUERY OPTIMIZATION LEVEL. If you do not specify a
value for a special register, the default value is used. Click Finish to run Visual Explain.

Figure 7.23 – Setting default values for special registers
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The Visual Explain has the same appearance as the Access Plan Graph, as shown in
Figure 7.24.

Figure 7.24 – Visual Explain display

Chapter 7 – Tuning queries 235

7.6 Summary
In this chapter, you learned about the query tuning capabilities that are included in Data
Studio and how to configure your DB2 system to enable query tuning. You learned how to
select SQL statements to tune, how to run the advisors and tools, and how to review the
output and recommendations.
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7.7 Review questions
1. After creating a database connection, what one-time activity do you need to do to
enable the query tuning features?
2. What are the query tuner features available with IBM Data Studio 3.1?
3. Name the two places in which you can start the query tuner workflow assistant?
4. What are the two ways you can customize the query tuner features?
5. Where are query tuner analysis results stored?
6. Which query tuning feature will give you the query syntax output in a readable fashion:
A. Statistics Advisor
B. Visual Explain
C. Access plan graph
D. Query Formatter
7. Which query tuner feature provides the query execution plan:
A. Statistics Advisor
B. Visual Explain and Access plan graph
C. Summary Report
D. Query Formatter
8. Which button in the Invoke view of the Query Workflow Assistant will start the query
tuner features:
A. Select What To Run
B. Open Single-Query Advisors and Tools Recommendations
C. Invoke Single-Query Advisors and Tools
D. Set Advisor Options
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Chapter 8 – Developing SQL stored
procedures
Stored procedures provide an efficient way to run business logic by reducing the overhead
of SQL statements and result sets that are passed back and forth through the network.
Among the different languages that DB2 supports to write stored procedures, SQL is the
language of preference because of its efficiency and simplicity. Moreover, SQL stored
procedures are simpler to develop and manage.
Data Studio supports stored procedure development and debugging. In this chapter, you
will learn:


Why stored procedures are so popular and useful



An overview of the steps to develop and debug a stored procedure



How to create, test, and deploy a sample SQL stored procedure using Data Studio



How to edit, and debug a sample SQL stored procedure using Data Studio

Note:
DB2 for Linux, UNIX and Windows supports stored procedures written in SQL (SQL PL),
PL/SQL, Java, C/C++, COBOL, and CLR. However, from Data Studio you can only
develop stored procedures using SQL, PL/SQL and Java. In this chapter, we focus on
writing SQL procedures. Learn more by reading the following document:
http://pic.dhe.ibm.com/infocenter/db2luw/v10r1/topic/com.ibm.db2.luw.apdv.sqlpl.doc/do
c/c0024289.html
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8.1 Stored procedures: The big picture
Stored procedures can help improve application performance and reduce database access
traffic. All database access must go across the network, which, in some cases, can result
in poor performance. Figure 8.1 illustrates the stored procedure data flow..

Figure 8.1 Stored procedure data flow
As shown in Figure 8.1, an application must initiate a separate communication with the
DB2 database server for each SQL statement. So, SQL #1, SQL #2, and SQL #3 require
individual communication traffic.
To improve application performance, you can create stored procedures that run on your
database server. A client application can then simply call the stored procedures
(MYPROC in Figure 8.1) to obtain results of all the SQL statements that are contained in
the stored procedures. Because a stored procedure runs the SQL statements on the
server for you, the overall performance is improved. In addition, stored procedures can
help to centralize business logic. If you make changes to a stored procedure, the changes
are immediately available to all client applications.
Stored procedures are also very useful when deleting or updating large numbers of rows.
You can specify a cursor in a stored procedure, and then loop through the result and
delete or update rows. This reduces locking activity and is useful in an OLTP environment.

8.2 Steps to create a stored procedure
The recommended perspective for stored procedure development is the IBM SQL and
Routine Development perspective. To switch to this perspective, select Window -> Open
Perspective -> Other -> IBM SQL and Routine Development from the main menu.
As discussed in Chapter 5, you must create a data development project to store routines.
Each data development project is associated with a single database connection. In this
chapter, we’ll be connecting to the GSDB sample database that has been used in previous
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chapters. See Chapter 1 to learn how to download and create the GSDB database, and
Chapter 2 to learn how to connect to that database.
Data Studio provides helpful templates, editors and views to productively create, deploy,
run, view, edit, and debug stored procedures. The overview of the steps to develop a
stored procedure in Data Studio is shown in Figure 8.2.

Figure 8.2- Steps to develop a stored procedure
To develop a stored procedure:
1. First, create the stored procedure. With Data Studio, you can create template-based
stored procedures, including the required input and output variables, and SQL
statements. The stored procedure’s source code is saved in your project workspace.
The stored procedure is stored in the data design project in which you created it, and
you can open it from the Stored Procedures folder in the Data Project Explorer.
2. Next, deploy the stored procedure. When you deploy a stored procedure, Data Studio
submits the CREATE PROCEDURE statement to the DB2 database server, which
compiles it. If it is successfully deployed on the database server, you can locate it in
the database when you drill down through the structures in the Data Source Explorer.
3. Next, run the stored procedure so that you can test it by providing data for input
variables.
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4. View the output or results from your test run. When you run the stored procedure, you
can determine whether it ran successfully, and whether its result sets are what you
expect. You can also test the logic of the routine and the accuracy of output arguments
and result sets. When you run a stored procedure from Data Studio, the results of the
stored procedure are displayed in the SQL Results view.
5. At this point, you could optionally use the routine editor to make changes to the stored
procedure depending on your business requirements. The routine editor is a tool to
view and edit the source code. You need to redeploy the stored procedure whenever
there are any changes.
6. Finally, the last step is to optionally debug the stored procedure, which requires that
you actually deploy the stored procedure for debugging. In other words, there is an
option on deployment that you must specify, to enable the integrated debugger. By
stepping through your code while you are running in debug mode and viewing the
results, you can discover problems with your stored procedure or better understand the
functional behavior of your stored procedure in certain scenarios.

8.3 Developing a stored procedure: An example
In the following example, you will walk through the steps to create, test, deploy, debug and
edit a DB2 SQL stored procedure in Data Studio. In this example, we will create the stored
procedure illustrated in Listing 8.1. This stored procedure accepts one input parameter and
returns one output parameter with the objective of testing a conditional IF statement.
CREATE PROCEDURE SP1 (IN p_in INT, OUT p_out INT)
-- DECLARE an input and output parameter
P1: BEGIN
-- Code an IF statement
IF p_in = 1 THEN
SET p_out = 2;
ELSEIF p_in = 2 THEN
SET p_out = 3;
ELSE
SET p_out = 4;
END IF;
END P1

Listing 8.1 – A sample SQL stored procedure

8.3.1 Create a data development project
In this example, we use the same workspace and database that was used in previous
chapters.


Open IBM SQL and Routine Development perspective by selecting Window -> Open
Perspective -> Other, then select IBM SQL and Routine Development in the Open
Perspective window.
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From the Data Source Explorer view, connect to the GSDB database, and expand
Database Connections -> GSDB -> GSDB -> Schemas -> GOSALESCT to view the
schema that you will use in this chapter.



In the Data Project Explorer view, right-click the white space within the view and select
New -> Data Development Project as shown in Figure 8.3.

Figure 8.3 – Opening the New Data Development Project wizard
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4. On the Data Development Project page, type Stored Procedure Project as the
project name, then click Next. This step is shown in Figure 8.4.

Figure 8.4 – Specify a project name
5. On the Select Connection page, select the GSDB connection as shown in Figure 8.5,
and select Next.
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Figure 8.5 – Associate the data development project with GSDB connection
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6. In the Default Application Process Settings window, select GOSALESCT as the
default schema as shown in Figure 8.6, and click Finish.
Note:
If you don’t change the schema here, the default schema will be a schema under
the name you logged in as, such as DB2ADMIN.

Figure 8.6 – Specify a default schema for the stored procedure
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7. In the Data Project Explorer view, expand the hierarchy tree of Stored Procedure
Project, to view its folders as shown in Figure 8.7.

Figure 8.7 – View project resources

8.3.2 Create a stored procedure
Data Studio includes many routine templates that allow the user to create stored
procedures easily. A routine template is a predefined text with some standard code,
comments, best practices, and other code that makes it easy for developers to start
creating new stored procedures.
To create a stored procedure using Data Studio:
1. In the Data Project Explorer, right-click the Stored Procedures folder under Stored
Procedure Project, and select New -> Stored Procedure as shown in Figure 8.8.

246 Getting Started with IBM Data Studio for DB2

Figure 8.8 – Create a new stored procedure
2. Data Studio supports creating stored procedures in three languages on DB2 for Linux,
UNIX, and Windows: Java, SQL and PL/SQL. In this example, you will create a SQL
stored procedure. Type STOREDPROCEDURE1 in the Name field, and select SQL as the
language, as shown in Figure 8.9.
3. Select the Deploy & Run: Return a result set template. You can open the Template
Details tab to preview the template, and you can use the DDL tab to preview the
generated code. This window is shown in Figure 8.9.
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Figure 8.9 – Specify the procedure’s name, language, and template
4. Click Finish to open the routine editor with the contents of the template pre populated
for further editing. The new stored procedure STOREDPROCEDURE1 is also added to
the Stored Procedures folder in the Data Project Explorer, as shown in Figure 8.10. For
this example, do not make any additional changes in the routine editor.
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Figure 8.10 – View the stored procedures folder and the routine editor
Note:
For more information about using Data Studio for template based routine development,
refer to the following developerWorks article:
http://www.ibm.com/developerworks/data/library/techarticle/dm1010devstudioroutines/index.html.
This article uses an earlier version of the Optim Development Studio product, but the
information is the same for Data Studio.

8.3.3 Deploy the stored procedure
At this point in the stored procedure development process, the stored procedure source
code exists as a file in your workspace. Before you can run your stored procedure against
your database, you must deploy it to the database server. When the stored procedure is
deployed, the DB2 database server compiles the source code, and creates a new stored
procedure object in the database with the compiled code. If the server cannot compile the
code, the deployment will fail and an error will be returned to the client.
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To deploy the stored procedure:
1. Expand the stored procedure project in the Data Project Explorer view, right-click
STOREDPROCEDURE1 from Stored Procedures folder, and select Deploy as shown
in Figure 8.11.

Figure 8.11 – Deploy the stored procedure
2. In the Deploy Routines window, make sure that the target schema is GOSALESCT.
Use the Target database options to either deploy on the current database or on a
different database. Specify how Data Studio handles duplicate objects in the Duplicate
handling options. Accept all of the defaults, and select Finish as shown in Figure 8.12.
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Figure 8.12 – Specify deployment options
3. Data Studio provides several views which provide quick access to informational output.
Look at the entry for your Deploy GOSALESCT.STOREDPROCEDURE1 operation in
the SQL Results view. Wait until the operation completes, then verify that the deploy
operation shows Succeeded as shown in Figure 8.13. The Status tab on the right
shows more detailed output.
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Figure 8.13 – View the deployment status
4. When you successfully deploy a stored procedure to the DB2 database server from the
Data Project Explorer, this new stored procedure object is also stored in the Stored
Procedures folder of the parent database and schema in the Data Source Explorer as
well. To verify that the stored procedure deployed successfully, open the Data Source
Explorer, then expand the folders to locate the stored procedure: Database
Connections -> GSDB -> Schemas -> GOSALESCT -> Stored Procedures. The
STOREDPROCEDURE1 stored procedure should be listed. The location of the stored
procedure is shown in Figure 8.14. If you do not see the new stored procedure in the
folder, right-click the Stored Procedures folder, and select Refresh.

Figure 8.14 – The new stored procedure is found in the Data Source Explorer

8.3.4 Run the stored procedure
After you deploy your stored procedure to the database, you can run the stored procedure.
From the Data Project Explorer, navigate to the Stored Procedures folder in Stored
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Procedure Project, right-click STOREDPROCEDURE1, and select Run as shown in Figure
8.15.

Figure 8.15 –Run the stored procedure
A window opens that lets you specify whether you want to commit the changes to the
database and capture database performance statistics. Accept the defaults and click Run.
When you capture database performance statistics, the statistics appear in the SQL
Results view.
Note:
When you test your stored procedure, you can create routine test configurations. Test
configurations contain settings that are used when you run the routine. The routine test
configurations can help test routines and validate changes you make to a routine. You
can create multiple test configurations that pass different input values to test different
portions of a routine.
When you run a routine with a test configuration, you can compare the result output and
output parameter values with a predefined set of values. The results of the comparison
appear in the SQL Results view.
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8.3.5 View the output
The SQL Results view shows the status of running your stored procedure. The Status
column of this view indicates success or failure of the operation. The Operation column
shows the command type or the actual command itself. The Status tab on the right shows
detailed output. In this case, since the stored procedure returns a result set, its
corresponding rows are shown in a separate tab, Result1. This is illustrated in Figure 8.16.

Figure 8.16 – View results of the stored procedure

8.3.6 Edit the procedure
In Data Studio, a stored procedure can be viewed and edited in the routine editor. To open
a stored procedure in the routine editor, double-click the stored procedure in the Data
Project Explorer or right-click and select Open as shown in Figure 8.17.

Figure 8.17 – Open an existing stored procedure in the routine editor
The routine editor provides syntax checking and context sensitive semantic help that is
similar to the one in SQL editor that was discussed in Chapter 5. In addition, the routine
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editor provides few useful options through a task bar on the top right corner of the editor,
for deploying, running, and debugging a stored procedure or to edit the routine template
preferences. This is shown in Figure 8.18.

Figure 8.18 – Routine editor’s layout
To edit STOREDPROCEDURE1 using Data Studio:
1. Open the stored procedure STOREDPROCEDURE1 in the routine editor as shown in
Figure 8.17.
2. Modify the stored procedure as shown in Figure 8.19 by following the code snippet in
Listing 8.1. The updated stored procedure has an input and output parameter, and an
IF statement.

Figure 8.19 – Edit the stored procedure
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3. In the IBM SQL and Routine Development perspective tool bar, click the Save
button(

). Alternatively, select File -> Save from the main menu.

8.3.7 Deploy the stored procedure for debugging
Data Studio includes an integrated stored procedure debugger which steps you through
your stored procedure code to resolve problems. Before you can debug a stored
procedure, you must deploy it for debugging. To deploy a stored procedure for debugging
from Data Studio:
1. Follow the steps to deploy a stored procedure as described in 8.3.3 as shown in Figure
8.11 to Figure 8.12. However, instead of selecting Finish, select Next.
2. On the Routine Options page, select the Enable debugging option as shown in Figure
8.20, and click Finish.

Figure 8.20 – Enable debugging
3. As before, you can use the SQL Results view to verify the deployment result.

8.3.8 Run the stored procedure in debug mode
To run the stored procedure in debug mode:
1. In the Data Project Explorer, navigate to the Stored Procedures folder, right-click
STOREDPROCEDURE1, and select Debug as shown in Figure 8.21.
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Note:
If you have not deployed the stored procedure for debugging as described in the
previous section, the Debug option in the menu is not available. Go back and
deploy the stored procedure with the Enable debugging option selected.

Figure 8.21 – Debug a stored procedure
The Debug STOREDPROCEDURE1 window opens.
2. Specify the initial value of the input parameter in the Parameter values tab. Doubleclick the cell in Value column of P_IN parameter, and enter a numerical value (in this
case, 1), as shown in Figure 8.22.
You can click the Set to Null button to set the input value as NULL. Alternatively, you
can also click the Save Values and Load Values buttons to save the input values in
XML format and load them for future executions of the stored procedure. Data Studio
remembers the values you specify. The next time you run the routine, the values you
previously specified appear. The Reset Values button sets all parameter values to the
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default values for the data type of the parameter. The Revert button reverts the
changes in the window to the values of the current session.

Figure 8.22 – Specify any input parameter values for the stored procedure
3. Open the Run and Performance Options tab. In this tab, you can specify whether you
want to commit the changes to the database. Accept the default options and click
Debug.
4. Eclipse has a standard Debug perspective that is the default for debugging programs.
A new window opens asking you to confirm the perspective switch. In the Confirm
Perspective Switch window, click Yes to switch from the IBM SQL and Routine
Development perspective to the Debug perspective.

Figure 8.23 – Confirm perspective switch
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5. A debug editor similar to the routine editor shows up with the debugger positioned on
the first line of the stored procedure, which is the CREATE PROCEDURE statement. The
current line where the debugger is positioned is always highlighted and a small arrow
will be shown on the left margin. This is shown in Figure 8.24.

Figure 8.24 – Debugger positioned on the first line of the stored procedure
6. Set break points: In the Debug perspective there is a Debug task bar, as shown in
Figure 8.25.

Figure 8.25 – Debug task bar
The arrow icons on the Debug task bar provide the Step Into, Step Over, Step Out and
other features while debugging a program (in this case, a stored procedure):


The Step Into arrow (
) positions you inside the next routine call at the
currently executing line of code.



The Step Over arrow (
) positions you after the next routine call (without
entering it) at the currently executing line of code.



The Step Return arrow (
stepped into.



The Resume icon (



The Suspend icon ( ) halts the currently selected thread and temporarily
stops it from running in a debug target. Once the selected thread is suspended
you can then examine its stack frames.



The Terminate icon (

) positions you outside a routine which has been

) lets a suspended debug target continue running.

) terminates the debug session

While in the Debug perspective, in the debug editor for STOREDPROCEDURE1,
double-click on the left vertical margin on the IF, ELSEIF, ELSE, and END IF
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statement code lines to set breakpoints as shown by the circles in the left margin in
Figure 8.26.

Figure 8.26 – Set breakpoints in left margin of the editor
7.

Click Step Over (
) to position the debugger on the first statement of the stored
procedure body, which is the IF statement.

8.

Change the variable value: The Variables view in the Debug perspective lets you
change the value of your input parameters, monitor the values of output parameters,
observe and change the values of any local variables of the stored procedure, etc. For
this example, even though we started to run the stored procedure with an input value
of 1, let’s change it to 2 while in debug mode. To do this, in the Variables view for the
parameter p_in, left-click the value 1 and enter value 2 as shown in Figure 8.27.

Figure 8.27–Change the value of input parameter in debug mode
9.

Resume the debugger: From the Debug task bar, select the Resume icon (
). This
will position the debugger on the ELSEIF statement in the stored procedure as shown
in Figure 8.28. If there are breakpoints, the resume will always progress to the next
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breakpoint and stay there for user’s next action. As mentioned before, in the debug
editor, the highlighted line and the arrow in the left margin indicate the current line of
code being debugged.

Figure 8.28 – Resume will position the debugger on the next break point
10. From the debug task bar, select Step Into icon (
); this will step you into the next
routine call at the currently executing line of code. In STOREDPROCEDURE1 debug
editor view, the current line will be the SET statement in the ELSEIF condition as
shown in Figure 8.29.

Figure 8.29 – Step into the logic
11. Resume the debugger: From the debug task bar, select Resume icon (
running the stored procedure.

) to finish
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12. View the results: The Debug perspective provides the same SQL Results view as in
the IBM SQL and Routine Development perspective so that you can see the status
and results of running the stored procedure. The Parameters tab on the right in the
SQL Results view will show your stored procedure’s input and output parameters. This
is shown in Figure 8.30. The value of p_in is 1, since that is the value that caused
the stored procedure to run (even though you changed it to 2 while in the debug mode
before executing the IF condition). The value of p_out is 3.

Figure 8.30 – View the debug results

8.4 Exercises
Now that you have gone through the process of creating, deploying, testing, debugging and
running a stored procedure, it is time for you to test this yourself by creating the following
procedure. Note the procedure has one intentional bug for you to discover. The output of
the procedure should be 2, 3 or 4.
CREATE PROCEDURE SP1 (IN p_in INT, OUT p_out INT)
P1: BEGIN
IF p_in = 1 THEN
SET p_in = 2;
ELSEIF p_in = 2 THEN
SET p_out = 3;
ELSE
SET p_out 4;
END IF;
END P1

8.5 Summary
In this chapter, you learned the value of using stored procedures to improve performance
of SQL access by being able to process a set of SQL on the database server rather than
sending each request over the wire separately. In addition, by encapsulating the database
logic, those stored procedures can be called and used by multiple applications.
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You also learned about the typical process for developing, deploying, and debugging
stored procedures. Using a simple stored procedure, you learned that stored procedures
are stored in the Stored Procedures folder of a data development project, and you also
learned how to edit an existing stored procedure using the routine editor.
Before a stored procedure can be run against the database, it must be deployed, which
means the source code is compiled on a connected DB2 server. After being deployed to
the target schema, the stored procedure is created in the Data Source Explorer for that
database connection. To debug a stored procedure, you must first deploy it for debug,
which will activate the debugger. A key fact to remember is that the integrated debugger is
only activated when a stored procedure is specifically deployed for debug. Using the
Debug perspective, you learned how to set breakpoints and how to resume running a
stored procedure after reaching a breakpoint. You also learned how to change the value of
a variable using the Variables view of the Debug perspective.

8.6 Review questions
1. What is one likely reason that the Debug option would not be available?
2. If you don’t specify a target schema, into which schema will new stored procedures be
deployed?
3. Which view in IBM SQL and Routine Development perspective contains the status of
the operation you performed?
4. Which Debug perspective view allows you to change a variable value?
5. Which Debug perspective view lists your breakpoints by line number?
6. Which procedure languages does Data Studio support when you connect to DB2 for
Linux, UNIX, and Windows?
A. Java, Cobol and PL/SQL
B. Java, SQL and PL/SQL
C. Java, C++ and SQL
D. Cobol, SQL and PL/SQL
E. None of the above
7. Deploying a stored procedure in Data Studio means which one of the following:
A. Source code exists as a file on the DB2 server
B. Source code exists as a file in your workspace
C. Compiling the source code in your workspace
D. Compiling the source code on the DB2 server
E. All of the above
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8. Which is the correct order to develop a stored procedure in Data Studio?
A. Create a procedure, view the output or results, deploy a procedure, run a
procedure, debug a procedure
B. Create a procedure, debug a procedure, deploy a procedure, run a procedure,
view the output or results
C. Create a procedure, deploy a procedure, run a procedure, view the output or
results, debug a procedure
D. Create a procedure, deploy a procedure, view the output or results, run a
procedure, debug a procedure
E. None of the above
9. What is the name of the view that shows the status of running your stored procedure in
the IBM SQL and Routine Development perspective?
A. SQL Results
B. Data Source Explorer
C. Data Project Explorer
D. SQL editor
E. None of the above
10. Which of the following icons enables you to resume running the stored procedure after
a breakpoint?
A.
B.
C.
D.
E. None of the above
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Chapter 9 – Developing user-defined functions
In this chapter, you will learn how to develop user-defined functions (UDFs) by using Data
Studio.

9.1 User-defined functions: The big picture
Like stored procedures, UDFs encapsulate reusable code. Because UDFs can be used in
SQL statements, they let you extend the SQL language with your own logic. For example,
you might want to create a function that encapsulates the logic to calculate a tax value in
your country when a source value is given as input, or you can create a function that
extracts information from an XML document and returns it in a tabular form that can be
used to perform a JOIN with another table. UDFs provide a very flexible way to extend your
application.
The supported languages for UDFs that are developed using Data Studio are: SQL, and
PL/SQL. The DB2 server supports other languages for UDFs, such as Java and C++, but
those are not supported in Data Studio.
Note:
Although you can use Data Studio to create PL/SQL functions for DB2 projects, PL/SQL
support is not available in DB2 Express-C, which is the edition of DB2 used for the
examples in this book. If you wish to develop PL/SQL functions, you’ll need to upgrade
to a different edition of DB2 that contains PL/SQL support.

UDFs developed in Data Studio can have one of the following return types:


Scalar: UDFs that accept one or more scalar values as input parameters and return a
scalar value as result. Examples of such functions include the built-in length(), and
concat() functions.



Table: UDFs that accept individual scalar values as parameters and return a table to
the SQL statement which references it. You can reference table functions in the FROM
clause of a SELECT SQL statement.
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Scalar functions are widely used in SQL statements to do processing of individual or
aggregate values. UDFs that receive multiple values as input and return a scalar value are
called aggregate functions.
Here is an example of using the built-in scalar function concat():
db2 => values CONCAT('Hello', ' World')
1
----------Hello World
1 record(s) selected.
You can use table functions in several different ways. You can use a table function to
operate (with SQL language) on data that is not stored in a database table, or even to
convert such data into a table. You can use them to read data from files, from the Web, or
from Lotus Notes databases, and return a result table. The information resulting from a
table function can be joined with information from other tables in the database, or from
other table functions.

9.2 Creating a user-defined function
Data Studio supports template based user-defined function creation. There are many
predefined routine templates that allow the user to create user-defined functions easily. A
routine template is a predefined text with some standard code, comments, best practices,
etc. that makes it easy for developers to start creating new user-defined functions.
To create a UDF, follow these steps:
1. Create a new data development project as you learned to do in Chapter 8. Name the
project UDF Project.
2. Right-click on the User-Defined Functions folder under UDF Project, and select New ->
User-Defined Function as shown in Figure 9.1.
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Figure 9.1 – Creating a new user-defined function
3. In this example, you will create a SQL user-defined function. Type UDF1 in the Name
field, and select the SQL language, as shown in Figure 9.2.
4. Select the Deploy & Run: (Table) Return a result set template. View details about the
template in the Template Details tab, or preview the code by opening the DDL tab. This
window is shown in Figure 9.2.
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Figure 9.2 – Specify the UDF name, language, and template
5. Click Finish to open the routine editor. The template contents are in the editor view.
The new user-defined function UDF1 is also added to the User-Defined Functions
folder of UDF1 Project in the Data Project Explorer view, as shown in Figure 9.3. For
this example, do not make any additional changes in the routine editor.
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Figure 9.3 – View the User-Defined Functions folder and the routine editor
Note:
For more information about using Data Studio for template-based routine development,
refer to the following developerWorks article:
http://www.ibm.com/developerworks/data/library/techarticle/dm1010devstudioroutines/index.html
This article uses an earlier version of the Optim Development Studio product and stored
procedures as an example, but the information is similar for Data Studio and UDFs.

9.3 Deploy the user-defined function
At this point in the UDF development process, the UDF source code exists as a file in your
workspace. Before you can run your UDF against your database, you must deploy it to the
database server. When deployed, the DB2 database server compiles the source code, and
creates a new UDF object in the database with the compiled code. In case of any compile
errors, the deployment will fail and an appropriate error will be sent back to the client.
To deploy the UDF:
1. Expand the UDF Project in the Data Project Explorer view, right-click UDF1 from UserDefined Functions folder, and select Deploy as shown in Figure 9.4.
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Figure 9.4 – Deploy the UDF
2. In the Deploy Routines window, make sure that the target schema is GOSALESCT.
Specify a target database and schema, and specify how duplicate objects should be
handled. For this step, accept all defaults, then click Finish. This window is shown in
Figure 9.5.
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Figure 9.5 – Specify deployment options
3. Data Studio provides several views which provide quick access to informational output.
Look at the entry for your Deploy GOSALESCT.UDF1 operation in the SQL Results
view. Wait until the operation completes, then verify that the deploy operation shows
Succeeded, as shown in Figure 9.6. The Status tab on the right shows more detailed
output.
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Figure 9.6 – View the deployment status
Note:
Data Studio supports debugging of non-inline scalar UDFs, or PL/SQL UDFs for DB2
for Linux, UNIX, and Windows V9.7 and above. For more information on deploying for
debugging, and debugging a routine, see Chapter 8.

4. When you successfully deploy a UDF to the DB2 database server from the Data
Project Explorer view, this new UDF object will be reflected in the User-Defined
Functions folder of the respective database in the Data Source Explorer as well. To
verify this, expand Database Connections -> GSDB -> Schemas -> GOSALESCT ->
User-Defined Functions folder in the Data Source Explorer and observe the entry for
UDF1. This is shown in Figure 9.7. If the new object is not yet visible, right-click the
User-Defined Functions folder, and select Refresh.
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Figure 9.7 – The new UDF is stored in the User-Defined Functions folder in the Data
Source Explorer

9.4 Run the user-defined function
After you deploy your UDF to the database, you can run the UDF. From the Data Project
Explorer, navigate to the User-Defined functions folder in UDF Project, right-click UDF1,
and select Run as shown in Figure 9.8.
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Figure 9.8 –Run the user-defined function
A window opens that lets you specify whether you want to commit the changes to the
database and capture database performance statistics. Accept the defaults and click OK.
When you capture database performance statistics, the statistics appear in the SQL
Results view.
Note:
When testing your UDF, you can create routine test configurations. Test configurations
contain settings that are used when you run the UDF. The routine test configurations can
help test routines and validate changes you make to a routine.
You can create multiple test configurations that pass different input values to test different
portions of a routine. When you run a routine with a test configuration, you can compare
the result output and output parameter values with a predefined set of values. The results
of the comparison appear in the SQL Results view.

9.5 View the output
The SQL Results view shows the status of running your UDF. The Status column of this
view indicates success or failure of the operation. The Operation column shows the
command type or the actual command itself. The Status tab on the right shows detailed
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output. In this case, since the UDF returns a result set, its corresponding rows are shown in
a separate tab, Result1. This is illustrated in Figure 9.9.

Figure 9.9 – View UDF results

9.6 Edit the procedure
In Data Studio, a UDF can be viewed and edited in the routine editor. To open a UDF in the
routine editor, double-click the UDF name or right-click and select Open as shown in Figure
9.10.

Figure 9.10 – Open an existing UDF in the routine editor
The routine editor provides syntax checking, and context sensitive semantic help that is
similar to the one in SQL editor that was discussed in Chapter 5. In addition, the routine
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editor provides few useful options through a task bar on the top right corner of the editor,
for deploying, and running a UDF or to edit the routine template preferences. This is shown
in Figure 9.11.

Figure 9.11 – Routine editor’s layout
To edit UDF1 using Data Studio:
1. Open the user-defined function UDF1 in the routine editor as shown in Figure 9.10.
2. Modify the UDF as shown in Figure 9.12. The updated UDF is a scalar UDF that
accepts one input parameter and returns the count of tables in GOSALESCT schema
that match the input string pattern.

Figure 9.12 – Edit the user-defined function
3. In the IBM SQL and Routine Development perspective tool bar, click the Save
button(

). Alternatively, select File -> Save from the main menu.

4. At this point, the updated UDF is saved in your workspace. To reflect these changes on
the database server, you need to deploy this again by following the steps in Section
9.3.
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5. To run the UDF again, follow the steps highlighted in Section 9.4. However, since the
updated UDF expects an input parameter, you must specify that parameter. The Run
and Performance Options tab opens in the UDF editor view, where you can specify
whether to commit the changes to the database.
6. Specify the input parameter value, as shown in Figure 9.13, then click OK to run the
UDF.

Figure 9.13 – Specify a value for the input parameter of the UDF
7. As explained in Section 9.5, the status of running the UDF, and any returned value can
be observed in SQL Results view. In this case, the returned value will be a scalar
integer value which is the number of tables in GOSALESCT schema that starts with the
phrase CUST.

9.7 Summary
In this chapter, you learned the value of using user-defined functions to improve
performance of SQL access by being able to process a set of SQL on the database server
rather than sending each request over the wire separately. In addition, by encapsulating
the database logic, those UDFs can be called and used by multiple applications. UDFs also
provide a way to extend the SQL language with your own functions. You also learned the
most important steps in the creation and maintenance of user-defined functions using Data
Studio.

9.8 Exercise
As an exercise for this chapter, create a table UDF that returns the name and schema of all
functions that have the qualifier equal to the value passed as a parameter to the function.
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9.9 Review questions
1. Explain some of the advantages of using UDFs for database application development.
2. What is the difference between a scalar UDF and a table UDF?
3. Describe a scenario where you would use a UDF instead of a stored procedure.
4. Describe a scenario where you would use a UDF instead of plain SQL statements.
5. What is an aggregate UDF?
6. What languages are supported for user-defined function development in a data
development project associated with a DB2 Linux, UNIX and Windows connection?
A. SQL, PL/SQL
B. SQL, OLE DB, PL/SQL
C. SQL, Java, OLE DB, PL/SQL
D. SQL, OLE DB
E. None of the above
7. What result type or types are supported for SQL user-defined functions in Data Studio?
A. scalar, list
B. table, list
C. scalar, table
D. scalar, table, list
E. None of the above
8. Which editor can be used to edit user-defined functions in Data Studio?
A. SQL and XQuery editor
B. Data object editor
C. Routine editor
D. Database table editor
E. All of the above
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9. What type of statement or statements can make up the body of a user-defined
function?
A. SQL statement
B. SQL statement, SQL expression
C. SQL expression
D. SQL expression, regular expression
E. All of the above
 Where can you see the results of running a UDF?
A. Console
B. SQL editor
C. SQL Results view
D. Data Source Explorer
E. None of the above
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Chapter 10 – Developing data web services
Data web services significantly eases the development, deployment, and management of
web services-based access to DB2 and Informix database servers. Data web services
provides a tools and runtime framework that makes it easy to create web services based
on database operations, like SQL statements and stored procedure calls, using a simple
drag and drop action. All web service artifacts are generated by Data Studio. The
generated web services can be directly deployed to an application server and tested with
the built-in Web Services Explorer.
In this chapter, after an overview of the data web services capabilities, you will learn a
basic scenario for end-to-end development of a data web service including:


How to install the WAS CE server adapter that is used by Data Studio to connect to a
WAS CE instance.



How to create a new data web service in a data development project using existing
SQL stored procedures and SQL scripts to provide the business logic.



How to deploy the web service to WAS CE.



How to use the Web Services Explorer to test the data web service..

Note:
Appendix E contains information that can help you with different situations, such as options
for consuming web services using different clients, customizing the messages, and much
more.
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10.1 Data web services: The big picture
Web services, in general, are standards that allow applications to share information
through services on the web. There are a multitude of materials on the web about web
services, and you can also refer to the ebook entitled Getting Started with Web 2.0 for
more information. In summary, however, web services are designed to allow for
communication between machines in a loosely coupled fashion. This can be accomplished
by use of a Web Services Description Language (WSDL) XML document that provides the
description required by the invoker to call the service (where is the service, what binding to
use, etc) and to understand the messages (in XML) returned by the service.
Data web services, in particular, refer to the ability to wrap web services around the logic
provide by the database. For example, you might already have a SQL script or stored
procedure that provides business logic for returning the current price of a particular item in
inventory from the database. Using data web services, you are simply making it much
easier for a web application (or other client) to start that capability, perhaps even as simple
as putting the HTTP request in a web browser.
This approach to creating a web service based on existing database operations/business
logic is called “bottom up” as opposed to a to ”top down” approach in which the web
services description is defined first and then logic is provided to map to that particular
description.
Data Studio (and Optim Development Studio) supports the development and deployment of
data web services without you having to write a single line of code. Figure 10.1 provides an
overview of data web services using Data Studio.

Figure 10.1 - Developing data web services with Data Studio
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On the left side of Figure 10.1, you can see different database operations. For example,
there is a query to return all information about an employee when an employee number is
provided. There is an update statement to update the first name of an employee based on
an employee number; there is a stored procedure that does some bonus calculations, and
there is an XQuery that is retrieving information from an XML document. Using Data
Studio, these operations can be converted to data web services without any coding on your
part. A few clicks are all you need to have the data web service created for you. On the
right side of the figure, you can see that Data Studio automatically creates the artifacts
needed to deploy this web service, including the WSDL document, and the JAVA EE
runtime artifacts such as a configuration file and the runtime package.

10.1.1 Web services development cycle
Just like developing a JAVA EE application, the data web service development cycle
consists of the following steps, as shown in Figure 10.2:
1. Create the service
2. Deploy the service to a JAVA EE application server
3. Test the service.

Figure 10.2 – Development and deployment of a data web service
As shown in Figure 10.2, after you drag and drop an operation to create a web service,
Data Studio generates the corresponding web service definitions that make a data web
service. The service runtime artifacts are packaged as a Java EE web application. The
Java EE application is ready to be deployed into a Java EE application server. You can
apply additional settings for security, monitoring, logging, and more during the deployment
phase.

10.1.2 Summary of the data web services capabilities in Data Studio
Here is a summary of data web services features provided by Data Studio:
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Using data web services, you can take Data Manipulation Language (DML)
statements, such as select, insert, update, delete, and XQuery, and stored procedures,
and generate web service operations by dragging and dropping those operations into a
web services.



Data web services provide a full web-service interface, which includes support for
SOAP and HTTP(RPC)/REST-styled bindings.



Web service artifacts like the WSDL and the runtime application are created
automatically. There is no manual coding necessary.



Data web services supports an integrated test environment that lets you deploy and
test the generated services with a few clicks of the mouse.



Data web services can apply server-side Extensible Style-sheet Language
Transformation (XSLT) to generate different formats like HTML.

Note:
In the web services world data is represented as XML. IBM Data Studio generates a default
XML schema describing the input and output messages for each operation. You can
manipulate the XML message format by assigning an XSL script, perhaps if your messages
need to follow a particular industry standard format or if you want to generate an HTML
document from the contents of the message. Appendix E shows you how to use XSL to
transform the output of a web service operation into an HTML document.
Data web services support these runtime environments:



Apache Tomcat, Version 5.5 or Version 6 (all releases)
WebSphere® Application Server, Version 8.0 (all releases)



WebSphere Application Server, Version 6 (all releases) or Version 7 (all releases)



WebSphere Application Server Community Edition, Version 2.1



WebSphere DataPower® XML Integration Appliance XI50, supported for the following
databases only:
o

DB2 for Linux, UNIX, and Windows, Version 9 (all releases)

o

DB2 for z/OS®, Version 10

o

DB2 for z/OS, Version 8 (all releases) or Version 9 (all releases)

DataPower is not supported in some products.

10.2 Install WAS CE server adapters in Data Studio
Before you can develop web services in Data Studio, you install the server adapter to
connect to an application server. The following procedure installs the server adapter for the
WebSphere Application Server Community Edition (WAS CE) application server. When
installing the adapters, Data Studio installs the server adapters as well as the software
required by the adapters.
To install the server adapter, you perform these tasks:
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1. Configure the workbench to search software sites when installing the server
adapter.
2. Install server adapter.
Note:
The WAS CE 2.1 server adapter supports both WAS CE 2.1.x.x and WAS CE 2.0.0.x
servers.
For information about WAS CE v2.0.x and v2.1.x server adapters, see Installing the WASCE
WTP Server Adapter.
To configure Data Studio to install the server adapter:
1.

From the Window menu, click Preferences. The Preferences window opens.

2.

Navigate to Install/Update -> Available Software Sites.

3.

Click Add. Add Sites opens

4.

Enter the name site and the URL for the WAS CE 2.1.x update site and click OK.
Name: WAS CE 2.1.x
URL:
http://public.dhe.ibm.com/software/websphere/wasce/updates/

5.

To make installation quicker, you limit the sites that Data Studio searches to only
the sites required to install the server adapter software.
a.

In the list of available software sites, select all software updates sites and
click Disable.

b.

In Available Software Sites, select the following sites:
http://public.dhe.ibm.com/software/websphere/wasce/updat
es/
http://download.eclipse.org/release/helios
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Data Studio determines plugin dependencies for the WAS CE server adapter based on
information from the Helos site. Data Studio installs the plugins required for the server
adapter based on the dependencies.
You can enable other sites, however the two required site must be selected.
6. Click OK.
To install the WAS CE v2.1.x server adapter:
1. From the Help menu, click Help -> Install new software.
2. In the Install window, select Contact all update sites during install to find all
required software.
3. In Work with, select WAS CE 2.1.x the update site for the server adapter.
After you select the software site, the software available in the update site is listed.
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4. Select the WASCE v2.1 Server Adapter to install and click Next.

5. Complete the Install wizard steps to install the server adapter and software
required for the server adapter.
Installing the server might require restarting Data Studio.
The WAS CE v2.1.x server adapter is installed in Data Studio.

10.3 Configure a WAS CE instance in Data Studio
Data Studio supports the direct deployment of a web service to WebSphere Application
Server Community Edition (WAS CE). The following steps show the setup required to hook
up Data Studio with a WAS CE instance. This procedure assumes that you have already
installed WAS CE on your system. See the ebook Getting Started with WAS CE or the
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WebSphere Community Edition documentation for more information about installing WAS
CE.
To configure a WAS CE instance in Data Studio:
1. Make sure you are in the SQL and Routine Development perspective of Data Studio.
Select Task Navigator -> SQL and Routine Development.
Then open the Server view by selecting Window -> Show View -> Other…
Expand Server and select Servers as shown in Figure 10.3.

Figure 10.3 – Selecting the Server view in the Show View window
The Servers view opens in your workspace.
2. Right-click in the Servers view and select New -> Server as shown Figure 10.4.

Figure 10.4 – Creating a new server
The New Server window opens.
3. Do not change any of the defaults, as shown in Figure 10.5. The server’s host name is
set to localhost because WAS CE has been installed on your machine where Data
Studio is also installed. Click Next.
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Figure 10.5 – Defining a new server
4. If you have not yet configured a WAS CE Runtime server, you need to configure it on
the New IBM WASCE v2.1 Runtime page, as shown in Figure 10.6. You are asked to
provide a Java Runtime Environment (JRE™) and the absolute path to the WebSphere
Application Server Community Edition installation. We select the default workbench
JRE, which comes with Data Studio. You will receive a warning message, because this
version is a 1.6 JVM™ and WAS CE V2.1 is only certified for the 1.5 JVM. However,
you can ignore the warning since you will use WAS CE for testing purposes only, and
the V1.6 JRE works with the 1.6 JVM.
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Figure 10.6 – Configuring the Server runtime
The New IBM WASCE v2.1 Server page is already completed for you, as shown in
Figure 10.7.
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Figure 10.7 – Configuring the server connectivity information
The administrator ID and administrator password are the credentials of the WAS CE
administrative user. By default, the administrator ID is system, and the password is
manager. You might need the administrator ID and administrator password at a later
time when you try to log on to the Administration Console from within or outside of Data
Studio.
The Web Connector defines the TC/IP port for the HTTP protocol, which, by default, is
8080.
The Remote Method Invocation (RMI) Naming defines the port that is used by Data
Studio to perform administrative tasks at the application server. By default, this port is
1099. Both port values need to match according to the definitions in the WAS CE
configuration.
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5. Click Finish. You have successfully added the WebSphere Application Server
Community Edition instance to your Data Studio, and the server definition is also listed
in the Servers view, as shown Figure 10.8.

Figure 10.8 – The new server instance in the Servers view

10.4 Create a data development project
After all the preparation is done you can start creating your first web service. All you need
is an active connection to your DB2 instance and a data development project based on that
connection.
Using the instructions shown in Chapter 2, connect to the GSDB sample database and
create a new data development project called WebServices. We will be using tables and
stored procedures from the GSDB database to create a new data web service.
Figure 10.9 shows the new data development project and the connection to the GSDB
sample database.

Figure 10.9 – The WebServices data development project
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10.5 Define SQL statements and stored procedures for web service
operations
Now it’s time for you to decide what database data and logic should be exposed as web
service operations. Typically a web service represents a set of operations with business
logic which are grouped together because they are related – mainly from a business level
perspective, but also for other reasons like security requirements, data structures, quality of
service, and so on.
In the database world, stored procedures are the prime candidates to become web service
operations since they can contain a significant amount of business logic. However, an SQL
statement can also be seen as a set of business logic – for example a SELECT statement
that retrieves customer information.
The SQL statements and stored procedures used for this example are relatively simple.

10.5.1 Stored procedures used in the web service
Although you usually create web services using existing database operations, we need to
create a couple of stored procedures here so we can show you how to use them in data
web services. If you want to follow along with the steps in the chapter, you will need to
create the following procedures as well:


GET_CUSTOMER_NAME has input and output parameters



PRODUCT_CATALOG returns a result set.

The logic is kept simple since we focus on how to add a stored procedure to a web service
rather than the stored procedure programming itself. We use SQL stored procedures here,
but you can add procedures written in any language to a web Service.
GET_CUSTOMER_NAME
This procedure returns customer information for a given customer ID. It is created under
the GOSALESCT schema. It has only input and output parameters. Using the information
you learned in Chapter 8, create the following procedure (you can cut and paste the text
below into the SQL procedure editor). Be sure to deploy it into the GOSALESCT schema.
CREATE PROCEDURE GOSALESCT.GET_CUSTOMER_NAME(
IN CUSTOMERID
INTEGER,
OUT FIRST_NAME
VARCHAR(128),
OUT LAST_NAME
VARCHAR(128),
OUT PHONE_NUMBER VARCHAR(128))
SPECIFIC GOSALESCT.GET_CUSTOMER_NAME
BEGIN
SELECT CUST_FIRST_NAME INTO FIRST_NAME FROM GOSALESCT.CUST_CUSTOMER
WHERE CUST_CODE = CUSTOMERID;
SELECT CUST_LAST_NAME INTO LAST_NAME FROM GOSALESCT.CUST_CUSTOMER
WHERE CUST_CODE = CUSTOMERID;
SELECT CUST_PHONE_NUMBER INTO PHONE_NUMBER FROM GOSALESCT.CUST_CUSTOMER
WHERE CUST_CODE = CUSTOMERID;
END

Listing 10.1 – GET_CUSTOMER_NAME procedure
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PRODUCT_CATALOG
This procedure is defined under the GOSALES schema. It returns a result set containing all
products from the catalog for a given product type. Using the information you learned in
Chapter 8, create the following procedure (you can cut and paste the text below into the
SQL procedure editor). Be sure to deploy it into the GOSALES schema.
CREATE PROCEDURE GOSALES.PRODUCT_CATALOG (IN PRODUCT_TYPE VARCHAR(50))
DYNAMIC RESULT SETS 1
SPECIFIC GOSALES.PRODUCT_CATALOG
------------------------------------------------------------------------- SQL Stored Procedure
-----------------------------------------------------------------------P1: BEGIN
-- Declare cursor
DECLARE CURSOR1 CURSOR WITH RETURN FOR
SELECT P.PRODUCT_NUMBER, Q.PRODUCT_NAME,
Q.PRODUCT_DESCRIPTION,
P.PRODUCTION_COST, P.PRODUCT_IMAGE
FROM GOSALES.PRODUCT AS P,
GOSALES.PRODUCT_NAME_LOOKUP AS Q,
GOSALES.PRODUCT_TYPE AS R
WHERE P.PRODUCT_NUMBER = Q.PRODUCT_NUMBER
AND Q.PRODUCT_LANGUAGE = 'EN'
AND R.PRODUCT_TYPE_CODE = P.PRODUCT_TYPE_CODE
AND R.PRODUCT_TYPE_EN = PRODUCT_TYPE;
-- Cursor left open for client application
OPEN CURSOR1;
END P1

Listing 10.2 – PRODUCT_CATALOG procedure

10.5.2 SQL statements used in the web service
We use two SQL statements for our web service:


GetBestSellingProductsByMonth



RankEmployee.

GetBestSellingProductsByMonth
The SQL statement shown in Listing 10.3 returns the top 50 products by shipping numbers
for the given month. Using the information in Chapter 5, create a new SQL script with the
name GetBestSellingProductsByMonth and copy the below statement into that
script.
SELECT PN.PRODUCT_NAME, PB.PRODUCT_BRAND_EN, SUM(IL.QUANTITY_SHIPPED) AS
NUMBERS_SHIPPED, PN.PRODUCT_DESCRIPTION
FROM GOSALES.INVENTORY_LEVELS AS IL, GOSALES.PRODUCT AS P,
GOSALES.PRODUCT_NAME_LOOKUP AS PN, GOSALES.PRODUCT_BRAND AS PB
WHERE IL.PRODUCT_NUMBER = PN.PRODUCT_NUMBER
AND IL.PRODUCT_NUMBER = P.PRODUCT_NUMBER
AND P.PRODUCT_BRAND_CODE = PB.PRODUCT_BRAND_CODE
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AND IL.INVENTORY_MONTH=:MONTH
AND PN.PRODUCT_LANGUAGE = 'EN'
GROUP BY PN.PRODUCT_NAME, IL.INVENTORY_MONTH,
PB.PRODUCT_BRAND_EN, PN.PRODUCT_NAME, PN.PRODUCT_DESCRIPTION
ORDER BY NUMBERS_SHIPPED DESC FETCH FIRST 50 ROWS ONLY

Listing 10.3 – SQL SELECT for the GetBestSellingProductsByMonth operation

Note:
You can define parameter markers in two ways – via the question mark notation (a = ?) or
via a named marker using the colon (a = :<name>) notation. For web services both
notations work, but the named parameter markers are preferable since the names will be
used for the input parameter names of the resulting web service operation. If question mark
notation is used the parameter names are just a sequence of p1, p2, …, pN. We use the
named parameter marker notation in our statement for this reason.

RankEmployee

This statement inserts a new ranking record for a given employee number and an
English ranking value term into the RANKING_RESULTS table of the
GOSALESHR schema and returns the new row. Create a new SQL script named
RankEmployee, and add the statement text as shown in Listing 10.4.
SELECT * FROM FINAL TABLE (
INSERT INTO GOSALESHR.RANKING_RESULTS (
RANKING_DATE, RANKING_YEAR, EMPLOYEE_CODE, RANKING_CODE)
VALUES (CURRENT TIMESTAMP, YEAR(CURRENT TIMESTAMP),
:EMPLOYEE_CODE,
(SELECT RANKING_CODE FROM GOSALESHR.RANKING WHERE
UPPER(RANKING_DESCRIPTION_EN) = UPPER(LTRIM(RTRIM(CAST(:RANKING AS
VARCHAR(90))))))))

Listing 10.4 – SQL INSERT for the RankEmpoyee operation

10.6 Create a new web service in the Data Project Explorer
At this point you should have all the pieces together to start creating your web service. The
following steps show how to create the web service.
1. If you’re not there already, switch to the Data perspective. Right-click on the Web
Services folder in your data development project and select New Web Service… as
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illustrated in Figure 10.10.

Figure 10.10 – Right-click web Services folder to create a new web service
2. As shown in Figure 10.11, change the name of your service to SimpleService and
use http://www.ibm.com/db2/onCampus as the Namespace URI. Note that a
namespace URI is just a way to identify a collection of XML elements and attributes
and does not need to point to an actual resource. Therefore it does not need to be a
URL.

Figure 10.11 – Provide the basic web service information
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3. Click Finish to create the web service. The Web Services folder now contains the new
web service as shown in Figure 10.12.

Figure 10.12 – The new web service in the data development project
The asterisk by the web service name means that the web service was not built and
deployed since it was created or last changed.

10.7 Add SQL statements and stored procedures as web service
operations
After creating the web service you can add SQL statements and stored procedures as web
service operations, as follows:
1. Open the GOSALES and GOSALESCT schemas in the Data Source Explorer. Select the
GET_CUSTOMER_NAME procedure from the GOSALESCT schema and the
PRODUCT_CATALOG procedure from the GOSALES schema and drag and drop them
into your newly created SimpleService web service, as shown in Figure 6.13.
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Figure 10.13 – Drag and drop stored procedures into the web service
2. Select your SQL statements in the SQL Scripts folder and drag and drop them onto
your SimpleService web service as well, as shown in Figure 10.14.

Figure 10.14 – Drag and drop SQL statements into the web service
Congratulations! You have finished your first data web service. In the Data Project
Explorer view, review the results. You should now see the two SQL scripts and the two
SQL procedures under your web service name, as shown in Figure 10.15.
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Figure 10.15 – The finished web service

10.8 Deploy the web service
The SimpleService web service can now be deployed on the prepared WAS CE
instance, as follows:
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1. Right-click the SimpleService web service and select Build and Deploy, as shown in
Figure 10.16. This opens the Deploy Web Service window (Figure 10.17).

Figure 10.16 – Opening the Deploy Web Service window from the Data Project
Explorer
2. As shown in Figure 10.17, select the WebSphere Application Server Community
Edition version 2 (all releases) web server type, and select the Server option to indicate
that you want to deploy the web service directly to an application server. From the
Server drop down box, select the WAS CE you configured previously.
3. Select the Register database connection with Web server option. This selection
triggers the automatic creation of a data source configuration for your database with
your web service and eliminates the need to perform this setup step manually.
4. Select REST and SOAP as the message protocols. You may notice that you cannot
select JMS. You need Optim Development Studio to use the JMS (Java Message
Service) binding.
5. Keep the settings in the Parameters section.
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6. Select the Launch Web Services Explorer after deployment option. This starts the web
services explorer test environment after the deployment, which allows you to test your
web service.

Figure 10.17 – Specifying options to deploy the web service
7. Click Finish.
While Data Studio deploys the web service to the WAS CE server instance you will see
the "Operation in progress..." message shown in Figure 10.18.

Figure 10.18 – The web service is being deployed
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Under the covers, Data Studio starts up the WAS CE instance (if it’s not started already). If
this is the first time you’ve deployed a data web service, you may get asked if Data Studio
should update the DB2 JDBC driver at the application server. You should confirm this
message to be sure that the latest DB2 JDBC driver is used.
In the next step Data Studio generates the web service runtime artifacts – like the WSDL
file, a JAVA EE web application project (WAR) and deploys all artifacts to the application
server. For more information on what those artifacts are and how to locate them, see
Appendix E.
In addition, because you selected the option to bring up the Web Services Explorer
automatically, it will come up automatically for testing. We’ll cover testing in the next
section.
Note:
You can also just build the web service runtime artifacts without automatically deploying
them to the application server by selecting Build deployable files only, do not deploy to a
web server.
Data Studio generates the web application project and *.war file for the web service. You
can now take the *.war file and use the application server administration tools to deploy
the application manually.

10.8.1. The location of the generated WSDL
The content of a SOAP message is usually described in the WSDL (Web Service
Description Language) document. WSDL is based on XML as well. Data Studio generates
a WSDL for each data web service. In fact, the Web Services Explorer requires the WSDL
file to be able to communicate with the web service.
To locate the WSDL file for your SimpleService web service, expand the folder XML ->
WSDL in your data development project as shown in Figure 10.19.
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Figure 10.19 – Locating the WSDL file for the SimpleService
You will find a SimpleService.wsdl file that represents the WSDL file for your service.
You can also retrieve the WSDL document using a URL after the web service was
deployed on an application server. The URL is:
http(s)://<server>:<port>//<contextRoot>/wsdl
In the case of the SimpleService, the URL would look like this:
http://server:8080/WebServicesBookSimpleService/wsdl
Explaining the structure of a WSDL document in detail is beyond the scope of this book.
You should know that the WSDL contains all the information a web service client needs to
start an operation of your web service. This includes the operation names, XML schemas
for input and output messages and, service endpoint definitions.
Note:
Data Studio also includes a WSDL editor. You open the editor by double-clicking the
WSDL document.
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10.9 Test the web service with the Web Services Explorer
There are many ways to test your new web service; one easy way is to use the built-in
Web Services Explorer of Data Studio. The Web Services Explorer is a dynamic web
services client that uses the WSDL document of the service to initialize itself.
Note:
The Web Services Explorer can test for invocations over SOAP over HTTP. For other
bindings, such as JSON or simple HTTP clients without SOAP, you will need to do a bit
more work as explained in Appendix E. The other option is to use Optim Development
Studio, which contains an HTML-based test client that supports all the data web services
bindings.

From the previous deployment step, the Web Services Explorer should already be started.
In case it is not, you can start it as follows:
1. Go to the Data Project Explorer view, open your project, and explore your web
service.
2. Click your web service name and click Launch Web Services Explorer to start the
Web Services Explorer in Data Studio, as shown in Figure 10.20.
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Figure 10.20 – Starting the Web Services Explorer from the Data Project Explorer
Figure 10.21 shows a more detailed view of the Web Services Explorer. On the left side,
there is a detailed list of all of the components that form your web service. When expanding
the SimpleService node you see three web service bindings listed:
SimpleServiceHTTPGET, SimpleServiceHTTPPOST, and SimpleServiceSOAP. The
different bindings will be discussed later in this chapter. Under each binding you find the
available operations that can be invoked for the binding. In our case, there are two SQL
scripts and two stored procedures. The endpoint to which the arrow points is the location of
the service endpoint for the selected binding – in this case, it’s the SOAP binding.
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Figure 10.21 – The Web Services Explorer

10.9.1 Testing the GetBestSellingProductsByMonth operation
Now it’s time to actually test your web service operations and inspect the results. You can
start with the GetBestSellingProductsByMonth operation and the SOAP binding.
1. As shown in Figure 10.22, expand the SimpleServiceSOAP node in the Web Services
Explorer Navigator view, and select the GetBestSellingProductByMonth operation.
2. The right-hand frame changes and presents an input field for the month. Remember
that this operation is based on an SQL SELECT statement with a named parameter
marker called MONTH. Provide any valid numeric month value – in this case we used 4
(for April).
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Figure 10.22 – Select the GetBestSellingProductsByMonth operation
3. Click Go to issue the web service request.
The Web Services Explorer generates the appropriate SOAP request message and
sends it to your web service on WAS CE. The web service invokes the SQL SELECT
statement and returns the result set formatted as XML in a SOAP response message
back to the Web Services Explorer. The Web Services Explorer parses the SOAP
response message and presents the result in the lower right Status view, as shown in
Figure 10.23. (You may need to expand the view and use the scroll bar to see the
results.) This is known as the Form view because it displays the request message
parameters in an HTML-like form.
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Figure 10.23 – The web service response in the Form view
4. You can examine the raw SOAP request and response messages by clicking Source in
the upper right corner of the Status view. The source appears as shown in Figure
10.24 in what is known as the Source view.

Figure 10.24 – The Source view of the SOAP request and response messages

10.9.2 Testing the PRODUCT_CATALOG operation
Let’s try another operation.
1. This time select the PRODUCT_CATALOG operation from the Web Services Explorer
Navigator under the SimpleServiceSOAP node.
2. This operation is based on a stored procedure that returns a product catalog excerpt by
a given PRODUCT_TYPE. Enter Irons for the PRODUCT_TYPE input parameter and
click Go to issue the request.

Chapter 10 – Developing data web services 309
3. You may notice (Figure 10.25) that the form-based response looks a bit strange. Not all
columns for a product catalog item are displayed.

Figure 10.25 – A stored procedure response with result set in the Form view
4. But when switching to the SOAP message source view (Figure 10.26) you can see that
all the data is present.

Figure 10.26 – A stored procedure response with result set in the Source view
The reason that you don’t see all the columns in the Form view is because the DB2 catalog
does not contain metadata for stored procedure result sets. Therefore data web services
can only apply a very generic result set schema, which may not contain enough information
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for web service clients to handle the data. In Appendix E, we show how you can work
around this limitation.
You can now try to test the other web service operations with the Web Services Explorer.
Figure 10.27 shows you the result of the GetBestSellingProductsByMonth operation
when using HTTP POST, which just displays the results as an XML document.

Figure 10.27– HTTP POST response is shown as an XML document

10.10 Exercises
1. Test the RankEmployee operation. All English ranking descriptions can be found in
the RANKING_DESCRIPTION_EN column of the GOSALESHR.RANKING table. You can
use any of the rankings as an input value for the RANKING parameter while testing.
Select an EMPLOYEE_CODE entry from the GOSALESHR.EMPLOYEE table. Verify that
your new ranking has been added by looking in the GOSALESHR.RANKING_RESULTS
table.
2.

Create a new web service operation that updates the ranking for a given
EMPLOYEE_CODE entry and a given YEAR entry to a given RANKING_DESCRIPTION
entry.

3. Start the GET_CUSTOMER_NAME operation by using a web browser via the HTTP GET
binding. Hint: You can run the HTTP GET binding from the Web Services Explorer,
then copy-and-paste the URL into a web browser.
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4. Change the SQL statement that represents the GetBestSellingProductsByMonth
operation to allow a user to provide the month name instead of the month number.
Hint: You can use the following expression to find the month name for the
GOSALES.INVENTORY_LEVELS.INVENTORY_MONTH column:
MONTHNAME('2009-' || TRIM(CHAR(INVENTORY_MONTH)) || '-0100.00.00')
5. Check out the behavior for binary data types. Create a new web service operation
called checkBinary with the following statement:
SELECT BLOB(CAST(:input AS VARCHAR(255)) FROM SYSIBM.SYSDUMMY1
Deploy the web service with the new operation. Run the operation by providing any
string value as input. Observe the result. Try to find out the XML data type and explain
why binary data is represented in this form. Hint: You can find the XML data type by
examining the XML schema section in the WSDL document of the web service.

10.11 Summary
In this chapter, you’ve learned about the architecture of data web services, which provides
the ability to wrap web services around business logic that is provided by SQL statements,
XQuery statements, or stored procedures. The services can be bound to either SOAP or
REST style bindings, providing the flexibility for a variety of clients to start and consume the
services. This chapter walked you through the process of creating a data web service that
includes two stored procedures and two SQL statements and binding them to both SOAP
and simple HTTP protocols. The SOAP binding can easily be tested using the Web
Services Explorer. For information about testing other bindings, see Appendix E.

10.12 Review questions
1. What are the three bindings supported for testing by the Data Studio Web Services
Explorer?
2. What does it mean when the data web service name in the Data Project Explorer has
an asterisk by it?
3. To see the SOAP request and response messages, which view do you need to open
from the Web Services Explorer?
4. As a best practice, is it better to use named parameter markers or question mark for
the SQL used in data web services?
5. The approach of creating a data web service based on existing database logic is called
________________ development.
6. You create a new data web service in:
A. A data design project
B. A data development project
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C. The Data Source Explorer
D. SQL and XQuery editor
E. None of the above
7. Business logic for a data web service can be provided by:
A. SQL procedures
B. XQuery statements
C. SQL statements
D. All of the above
E. None of the above
8. Which transport protocol is used with a data web service?
A.

FTP

B.

RMI

C.

HTTP

D.

SMTP

E. None of the above
9. What is the Web Services Explorer used for?
A. Browsing the Web
B. Editing XML files
C. Testing web services
D. Browsing the file system on a remote server
E. All of the above
10. What are the three major steps in the development of a data web service?
A. Design, develop, deploy
B. Create, deploy, test
C. Model, develop, test
D. Design, model, deploy
E. None of the above
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Chapter 11 – Getting even more done
In this book you’ve learned about how to use Data Studio to perform basic database
administration and data development tasks with DB2. But there are a wide variety of tasks
and management responsibilities involved in managing data and applications throughout
the lifecycle from design until the time that data and applications are retired. IBM is helping
organization manage information as a strategic asset and is focused on helping them
manage their data across its lifecycle.
In this chapter, you’ll learn more about some of tools and solutions from IBM that you can
use to address the bigger challenges of managing data, databases, and database
applications.
We encourage you to try these products. You may have access to some of the software as
part of the IBM Academic Initiative program at
www.ibm.com/developerworks/university/data/, or you can download the 30-day trial
versions where available.
In this chapter you will learn about:


The major phases in the data lifecycle and key tasks for each of those lifecycle phases.



Why a lifecycle focused approach provides greater value than only focusing on specific
tasks.



Some of the products that address the challenges of data management and a
summary of their capabilities.



How these products can extend the Rational® Software Delivery Platform for datadriven applications.
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11.1 Data lifecycle management: The big picture
Figure 11.1 illustrates the data management lifecycle phases and key value that a data
lifecycle management approach can bring to those phases.

Figure 11.1 -- Managing data across the lifecycle can enhance value and productivity
from requirements through retirement
As you can see in Figure 11.1, there are many considerations for effective management of
data, databases, and data applications. As described by Holly Hayes in her
developerWorks article entitled “Integrated Data Management: Managing data across its
lifecycle”, the main steps involved in the complete data lifecycle include:


Design -- Discover, harvest, model, and relate information to drive a common semantic
understanding of the business. You may need to interact with business users to track
and gather requirements and translate those requirements into a logical design to
share with application architects. A physical database model is generally used as the
way to convert a logical design to a physical implementation that can be deployed into
a database management system. If you are working with existing data assets
(databases), you need to understand what tables already exist, and how they may
relate to other tables or new tables you may want to create. In addition, you may wish
to conform to a naming standard or enforce certain rules about what kind of data can
be stored in a field or whether data stored in a field must be masked for privacy. All of
these considerations happen during the design phase of the lifecycle.
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Develop -- Code, generate, test, tune, and package data access layers, database
routines, and data services. This step is where the data access application is built. The
data access may be part of a larger application development process, so it’s important
to collaborate closely with business developers and to ensure that application
requirement changes are reflected back to the data architect or database administrator
for changes. In addition, developers may be responsible for ensuring that the data
access they create (SQL, XQuery, Java, data web services, etc.) not only returns the
correct result but also performs efficiently. Use of representative test data and test
databases is often used. Because of regulations around how personally identifiable
information such as social security numbers and credit card numbers can be handled,
it’s critical that developers who need test data are compliant with those regulations
while still having representative test data.



Deploy -- Install, configure, change, and promote applications, services, and
databases into production. This phase includes a well-planned strategy for migrating
databases (or database schema changes), data and applications into production. The
goal is to do this as swiftly as possible and with the least amount of disruption to
existing applications and databases to avoid affecting other applications and to do it
without error. Deployment can also mean deploying changes.



Operate -- Administer databases to meet service level agreements and security
requirements while providing responsive service to emergent issues. This phase of the
lifecycle is the bread and butter of a typical database administrator’s day. They
authorize (or remove authorizations) for data access. They not only have to prepare for
possible failures by ensuring timely backups, but they must also ensure that the
database is performing well and they must be able to respond to issues as they arise.
Because many failures can be difficult to isolate (that is, is a failure occurring in the
database, the application server, the network, the hardware?), it’s critical that all
members of the IT staff have information to help them isolate the problem as quickly as
possible so that the right person can fix the problem, whether it’s the database
administrator, the network administrator, the application administrator or someone else.



Optimize -- Provide pro-active planning and optimization for applications and
workloads including trend analysis, capacity and growth planning, and application
retirement including executing strategies to meet future requirements. This phase is
where database administrators can really bring value to the business. It may take a
backseat to the constant interrupt-driven needs of day to day operations, but it is a
critical phase to ensure that costs are kept down and performance remains acceptable
as the business grows and as more applications drive more users against the
databases. It’s critical that performance trends and data growth trends are analyzed
and accommodated. A strategy for archiving old data is required for two reasons: 1) to
manage data growth to ensure performance is not adversely affected and 2) to comply
with regulations for data retention.



Govern -- Establish, communicate, run, and audit policies and practices to
standardize, protect and retain data in compliance with government, industry, or
organizational requirements and regulations. Not limited to a single phase, governance
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is a practice that must infuse the entire lifecycle. Governance can include the data
privacy regulations mentioned previously as well as using techniques such as data
encryption to guard against data breach or accidental loss. [1] In fact, data lifecycle
management is just one aspect of Information Governance. IBM has collaborated with
leading organizations to identify a blueprint and maturity model for Information
Governance. Find more information here: http://www01.ibm.com/software/info/itsolutions/information-governance/
Although many products and technologies exist today to help with the phases of the data
lifecycle, IBM is focusing on creating an infrastructure in which specifications made in one
phase can be disseminated through other phases of the lifecycle and automatically
maintained.
Why is this important? Although you may be in school or in a small development shop
where there are very few people other than yourself managing data and applications, there
are real problems as organizations grow and responsibilities become dispersed among
different people and in different locations. For example, data privacy requirements
identified in the design phase may get lost or forgotten as developers start pulling down
data from production for testing purposes. It becomes more and more difficult to identify
how a database schema change will affect the many applications that may be using the
database. And not identifying dependencies properly can result in serious outages.
With an integrated approach, the tools can actually help facilitate collaboration among
roles, enforce rules, automate changes while identifying dependencies, and in general
speed up and reduce risk across the lifecycle. This integrated approach cannot be
achieved by unrelated tools. It requires common infrastructure and shared metadata such
that actions in one tool are reflected down the line when another person uses their tool to
support their particular responsibilities. InfoSphere Optim solutions for data lifecycle
management are built to take advantage of such integrations. So, as an example, if a data
architect defines a column as containing private data (such as credit card numbers or
social security numbers), a developer who is viewing this table in their development tool
should see the column marked as ‘private’ and be able to use the proper masking
algorithms should data be required for testing.

11.2 Optim solutions for data lifecycle management
Let’s look at some of the data lifecycle management solutions from IBM, many of which are
offered under the family name “InfoSphere”
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Figure 11.2 – InfoSphere Optim solutions for Data Lifecycle Management
Figure 11.2 shows some of the key products that help IT staff manage the various phases
of the data lifecycle. We won’t cover all the products in great detail here, but will cover a
few key ones that you may wish to download and use to expand the capabilities of Data
Studio as you learn more about working with DB2 Express-C and other databases.

11.2.1 Design: InfoSphere Data Architect
The data architect’s key tool is InfoSphere Data Architect, used for discovering, modeling,
relating, and standardizing data. Like any good data modeling offering, it supports logical
and physical modeling and automation features for diverse databases that simplify tasks
such as reverse engineering from existing databases, generating physical models from
logical models, generating DDL from physical models, and visualizing the impact of
changes. For warehouse development, it includes automatic discovery and annotation of
facts, measures, dimensions and outriggers and denormalization into star, snowflake, and
starflake schema.
InfoSphere Data Architect is more than a data modeling tool because it provides a
framework for understanding your data, and can be used as a basis of understanding in
other tools. Because it integrates with InfoSphere, InfoSphere Optim, and Rational
offerings, as well as supporting heterogeneous environments, InfoSphere Data Architect is
a central component in information governance strategies.
Figure 11.3 shows a screenshot of a model in InfoSphere Data Architect.
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Figure 11.3 – InfoSphere Data Architect for data modeling
For more information about InfoSphere Data Architect, see the ebook Getting Started with
InfoSphere Data Architect which is part of this book series.

11.2.2 Develop: Data Studio and InfoSphere Optim pureQuery Runtime
For data-oriented developers or database administrators, Data Studio contains all the
database administration and data development capabilities a database developer needs.
But is goes beyond the basics for Java development when used with InfoSphere Optim
pureQuery Runtime.
Data Studio ramps up Java development to new levels for heterogeneous databases. The
data access layer generation includes support for the standard Data Access Object (DAO)
pattern and leverages the pureQuery API, an intuitive and simple API that balances the
productivity boost from object-relational mapping with the control of customized SQL
generation. It also simplifies the use of best practices for enhanced database performance
such as statement batching and static execution. InfoSphere Optim pureQuery Runtime is
used with pureQuery data access layers.
For both pureQuery and other Java applications that might be using Hibernate, JPA, or
some other framework, you can take advantage of the great features in Data Studio, as
shown in Figure 11.4.
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Figure 11.4– Data Studio has advanced features for Java database development and
tuning
As shown in Figure 11.4, one great feature is the ability to correlate SQL with the data
sources and with the Java source code, even if the SQL is generated from a framework.
This can really help you understand the impact of changes, and can also aid database
administrators and developers in identifying and tuning SQL when using output from the
DB2 package cache during QA or production.
You can start learning about SQL performance issues by visualizing SQL “hot spots” within
the application during development by viewing performance metrics about how many times
a statement is run and the elapsed times. Adding InfoSphere Optim Query Workload Tuner
to your environment can help you tune you SQL by providing expert guidance and rationale
to build your tuning skills.
In addition, because of the integration with other products, Data Studio helps developers
be cognizant of sensitive data. For example, developers can readily identify sensitive data
based on the privacy metadata captured in InfoSphere Data Architect. They can create test
databases directly from test golden masters or can generate extract definitions for
InfoSphere Optim Test Data Management and InfoSphere Optim Data Privacy solutions to
create realistic fictionalized test databases. The physical data model is shareable among
InfoSphere Data Architect, Data Studio, and InfoSphere Optim Test Data Management
Solutions to enable collaboration and accelerate development.
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Developers can spend considerable time isolating performance issues: first to a specific
SQL statement, then to the source application, then to the originating code. Three-tier
architectures and popular frameworks make this isolation more difficult as the developer
may never see the SQL generated by the framework. Data Studio makes it easier to isolate
problems by providing an outline that traces SQL statements back to the originating line in
the source application, even when using Java frameworks like Hibernate, OpenJPA,
Spring, and others.
Be sure to read the Getting Started with pureQuery book of this series to read about the
capabilities of Data Studio and pureQuery Runtime.

11.2.3 Develop and Optimize: InfoSphere Optim Query Workload Tuner
InfoSphere Optim Query Workload Tuner is focused on enabling developers to tune
queries and query workloads by providing them with advice on how to achieve better query
performance [2]. See Figure 11.5 for a screenshot.

Figure 11.5 – InfoSphere Optim Query Workload Tuner provides help for tuning
queries and workloads
InfoSphere Optim Query Workload Tuner provides advice for statistics, queries, access
paths, and indexes. As you learned in Chapter 7, the tabs along the left side help step you
through tuning steps, and the tool can format the queries for easy reading and include
associated cost information, an access plan graph, access plan explorer, and access plan
comparison.
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InfoSphere Optim Query Workload Tuner can provide either single query analysis and
advice , but can take as input an entire SQL workload (such as all SQL used in an order
processing application) as input, which enables database administrators to determine for
example what indexes or what statistics might provide the most benefit for the overall
performance of the workload.

11.2.4 Deploy and Operate: Data Studio, InfoSphere Optim Configuration
Manager, and DB2 Advanced Recovery Solution
Managing availability is often job number one for database administrators. When your
database goes down and the data is unavailable to the end users, it can look bad for you
and your organization. If you’re supporting a business, that can have a direct impact on the
bottom line.
Data Studio, as you have learned in this book, provides all the basic database
administration capabilities required for managing a DB2 deployment. However, when
managing many deployments, more capability is desirable to manage, synchronize, and
govern configuration across hundreds of databases.
InfoSphere Optim Configuration Manager discovers databases, clients, and their
relationships and tracks configuration changes across them. It assists with application
upgrades to determine that all clients have been changed correctly, and lets organizations
quickly visualize and report on inventory and configuration changes. Such changes can
also be correlated to performance degradation via contextual links in InfoSphere Optim
Performance Manager, see section 11.2.5 for more information.
DB2 Advanced Recovery Solution is focused on reducing time to recover by aligning
backup strategies with outage related Service Level Agreements providing faster methods
to recovery and is comprised of the following:
 InfoSphere Optim High Performance Unload provides a high-speed unload utility as
an alternative to the DB2 export feature. This product significantly reduces the time
required to migrate databases, manage within batch windows, capture data for test
environments, and move data without impacting production systems.
Because unloads are so fast, you can use this as a means for migration, moving large
amounts of data from one system to another or for backup.
The product is fast because it can o go directly to the data files, bypassing the
database manager altogether. The tool does not interfere with or slow down production
databases or impact CPU resources as it is completely outside of the database. It can
also perform unloads from multiple database partitions, and it provides repartitioning
capability in a single step for rapid data redistribution on the same or different system.
This is particularly useful in warehouse environments where repartitioning can be very
much a manual process.


DB2 Merge Backup lets you avoid full database backups by merging incremental and
delta backups into a full backup. Thus, it reduces resource requirements to maintain a
full backup for large databases and it shortens recovery times on production servers
ensuring full backups are always available when needed.
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This is very helpful where it just takes too long to take a full backup and in some cases
it is not viable because of the amount of time it takes and because of the impact
backup has to end users, who cannot access the database while it is being backed up.
DB2 Merge Backup lets you have full backups available at a more consistent and up to
date point in time. DB2 Merge Backup also gives you the capability to run the merge
processing on a computer outside of your DB2 database, thus reducing the amount of
resources being consumed on the production computer.


DB2 Recovery Expert optimizes recovery processes. It helps organization minimize
recovery times by isolating recovery to just the impacted objects without having to
resort to full database recovery. This means that you can recover faster and with
greater granularity than what is available with traditional database recovery. Think
about the situation where you have multiple tables in a table space. If a user deletes
some data from one of those tables by accident, you can identify which data was
deleted and recover just that data rather than having to recover the whole table space.
DB2 Recovery Expert log analysis capabilities enables single object recovery as well
as recovery from data corruption caused by flawed applications. This allows database
administrators to quickly restore or correct erroneous data using fewer resources. Log
analysis also lets database administrators monitor activity to sensitive DB2 tables.
Database administrators can view data changes by date, users, tables, and other
criteria. Administrators may institute tighter controls over the data to ensure that the
data is no longer compromised.

11.2.5 Optimize: InfoSphere Optim Performance Manager and InfoSphere
Optim Data Growth Solutions
Organizations not only want their applications to run, but to run well. While DB2 provides
advanced self-tuning features, it can only optimize within the constraints of the resources it
has available. Organizations still need to monitor database performance to detect
performance erosion that can lead to missed service level agreements and declining staff
productivity. Beyond health monitoring in Data Studio, InfoSphere Optim Performance
Manager provides 24 x 7 monitoring and performance warehousing to give database
administrators and other IT staff the information needed to manage performance
proactively to:


Prevent problems before they impact the business



Save hours of staff time and stress



Align monitoring objectives with business objectives

In addition, when using Data Studio for query development, developers can use the
InfoSphere Optim Performance Manager integration to see the actual performance
improvements across iterations of query refinements and executions. Application metadata
such Java packages and source code lines can be shard with InfoSphere Optim
Performance Manager to accelerate problem resolution. Problematic workloads can be
easily transferred to InfoSphere Optim Query Workload Tuner for expert recommendations.
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InfoSphere Optim Data Growth Solution is central to managing data growth, archival, and
retention. Archiving in-active data support higher performing applications, yet archival must
be managed to meet ongoing access requirements for customer support or for audit and
compliance. InfoSphere Optim Data Growth provides such capabilities enabling data
archival with ingoing access through the native application or though standard reporting or
query facilities. Selective restore enables audit database to be created as needed.

11.2.6 Job responsibilities and associated products
In Chapter 1, we mentioned that Data Studio can provide a way to grow your skills
horizontally across different database platforms. Data Studio can also serve as a stepping
stone for the rest of the data lifecycle management products. Because the portfolio focuses
on collaboration among different roles, these products can help you work with and learn
tasks that can help you become a production database administrator, a high performing
Java developer, a Data Architect, or even a Data Governance officer.
Table 11.1 includes some job roles and appropriate products that can help with those roles.
Job

Related products

Developer (data access)

Data Studio, InfoSphere Optim Query
Workload Tuner (Also helpful to learn
Rational Application Developer for
WebSphere Software)

Database Administrator (applicationfocused)

Data Studio, InfoSphere Optim Query
Workload Tuner, InfoSphere Optim Test Data
Management Solution and InfoSphere Optim
Data Privacy Solution

Database Administrator (including data
governance responsibilities)

Data Studio, InfoSphere Data Architect,
InfoSphere Optim Performance Manager,
DB2 Advanced Recovery Solution,
InfoSphere Optim Configuration Manager,
InfoSphere Optim Data Growth Solution,
InfoSphere Optim Data Privacy Solution

Data Architect

InfoSphere Data Architect (also helpful to
learn Rational Software Architect for
WebSphere Software)Table 11.1– Job roles
and suggested software

11.3 Data Studio, InfoSphere Optim and integration with Rational
Software
This section outlines how some of the key InfoSphere Optim products integrate with and
extend the Rational Software Delivery Platform. The goal of InfoSphere Optim solutions for
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Data Lifecycle Management is to create an integrated approach to data management
similar to what the Rational Software Delivery Platform does for the application lifecycle.
Therefore, the InfoSphere Optim solutions in general provide data-centric capabilities that
can be used alone or installed with existing Rational products (assuming they are on the
same Eclipse level).
Note: Data Studio Version 3.1 is built on Eclipse 3.4. For more information about which
products can shell share together, scroll to the Eclipse 3.4 section of the technote here:
http://www.ibm.com/support/docview.wss?rs=2042&uid=swg21279139
For known shell-sharing issues, see this technote:
http://www.ibm.com/support/docview.wss?rs=3360&uid=swg27014124

This ability to install together and share artifacts enables better collaboration among
various roles in the organization, as shown in Figure 11.7.

Figure 11.7– InfoSphere Optim Solutions extend Rational for data-driven
applications
Let’s look at a few particular examples shown in the above figure of how InfoSphere Optim
solutions can help developers who are ‘data-centric’ extend the capabilities of Rational
Application Developer for WebSphere Software (RAD).
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Example 1: In the database modeling world we usually create logical and physical
database models. In the software development world we usually create UML diagrams to
portray our application architecture. You can take a UML diagram in Rational and convert
that to a logical data model in InfoSphere Data Architect. You can also do the inverse and
take a logical data model in InfoSphere Data Architect and convert that to a UML
application model in Rational.
Example 2: Many developers have RAD on their desktops. RAD extends base Eclipse with
visual development capabilities to help Java developers rapidly design, develop, assemble,
test, profile and deploy Java/J2EE™, Portal, Web/Web 2.0, web services and SOA
applications.
Adding Data Studio also takes your Java persistence layer development capabilities into
high gear. Your Java editor will be enhanced with SQL Content Assist, which means that
you can use CTRL-Space to see available tables or columns when building your SQL
statements in Java. You can use all the other capabilities in Data Studio that can
significantly reduce development and troubleshooting time, such as:


Correlating a particular SQL statement with a particular line of Java source code. This
can help you narrow in on problem SQL statements.



Seeing which tables and columns are being used in the Java program and where,
making it much easier to see if a schema change will impact the Java program.



Searching through SQL statements for particular strings



Gathering performance statistics on individual SQL statements in your Java program
and even comparing performance with an earlier performance run.

In addition, by extending the development environment with InfoSphere Optim Query
Workload Tuner, you can get query tuning advice, a task which often falls to the database
administrator or to a specialized performance management role. InfoSphere Optim Query
Workload Tuner can help you avoid simple mistakes when writing queries so that the code
is of higher quality and performance before moving into a test environment.
Furthermore, Data Studio can automate database changes. You may need to modify local
development databases to reflect changing requirements, and being able to automate this
process as well as back out those changes, without requiring the assistance of a database
administrator can be a great timesaver.
No two organizations are exactly alike and the responsibilities of people working in those
organizations can vary significantly, even if they have the same job title. Thus, the modular
nature of these capabilities and products make it easy for people to customize their
desktops with the capability they need.

11.4 Community and resources
A great resource for learning more about Optim and its solutions is developerWorks, which
includes a page from which you can find downloads, forums, technical articles, and more at
https://www.ibm.com/developerworks/data/products/optim/.
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You can also join the Optim fan page on Facebook to connect with others interested in
Optim solutions and to get the latest announcements, at: www.facebook.com/pages/IBMOptim/37213992975 or follow Optim on Twitter at www.twitter.com/IBM_Optim,

11.5 Exercises
1.

Learn more about IBM InfoSphere Optim solutions for Data Lifecycle Management by
visiting the web page at: www.ibm.com/software/data/optim/ which is organized by
solution. Click through at least two of the solutions listed on this page to see which
products are used to accelerate solution delivery and facilitate integrated database
administration.

2.

View the demo on the DB2 Advanced Recovery Solution
http://www.ibm.com/developerworks/offers/lp/demos/summary/imoptimbackuprecovery.html.

3.

For a good introduction to InfoSphere Data Architect, see the video entitled
Introduction to InfoSphere Data Architect on developerWorks at:
www.ibm.com/developerworks/offers/lp/demos/summary/im-idaintro.html

11.6 Summary
In this chapter, we reviewed the concept of a data and data application lifecycle and some
of the key tasks associated with the phases of that lifecycle. We described how an
integrated approach to data management can make these tasks more efficient and less
risky by facilitating collaboration among roles and automatically enforcing rules from one
lifecycle phase to the next. We reviewed some of the IBM offerings for data lifecycle
management and their key capabilities.
Finally, we closed with a description of how the InfoSphere Optim solutions can extend the
capabilities in Rational for data-centric application development.

11.7 Review questions


What are the six phases of data lifecycle management, as described in this chapter?
Which phase must be considered across all other phases of the lifecycle?



Which phase of the data lifecycle is most concerned with translating business
requirements into a physical database representation? Which IBM product is primarily
used in this phase?



Which products are used together to create a high performance data access layer
using the data access object (DAO) pattern.



Which IBM InfoSphere Optim product is designed to help database administrators and
developers improve SQL queries so that they can perform faster?
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Which IBM InfoSphere Optim product is designed to help identify performance
bottlenecks before they impact the business?



How does DB2 Merge Backup help organizations minimize downtime after a failure?



Which of the following is not a primary goal of an integrated approach to data lifecycle
management:
A. Reduce risk
B. Improve collaboration among roles
C. Exchange metadata
D. Improve efficiency of development and deployment
E. Enforce rules and improve governance
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When developing queries in Data Studio, what additional products can you use to
help you test and tune the performance of the queries? Choose the best answer
below.
A. InfoSphere Data Architect and InfoSphere Optim pureQuery Runtime.
B. InfoSphere Optim Query Workload Tuner and InfoSphere Optim Performance
Manager.
C. InfoSphere Optim Performance Manager and InfoSphere Optim High
Performance Unload.
D. DB2 Merge Backup and DB2 Recovery Expert
E. None of the above



The integration of data-centric capabilities with the Rational Software Delivery
Platform is important because (select all that apply):
A. It improves collaboration among people involved in application development
lifecycle
B. It enhances application development with data-centric expertise and
capabilities to improve productivity for data-centric development
C. It’s important to install as many tools as possible into your Eclipse workbench
D. The similar look and feel can help grow skills across roles
E. None of the above

 Which one of the following tasks is least likely to occur in the Optimize phase of the
data lifecycle?
A. Capacity planning
B. Planning for application retirement
C. Controlling the growth of data by archiving data appropriately
D. Creating a Java data access layer
E. None of the above.
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Appendix A – Solutions to the review questions
Chapter 1
1. The Data Studio client is built on Eclipse, which is an open source platform for building
integrated development environments.
2. DB2 (all platforms) and Informix. Other databases are also supported. For a list of
supported databases, see http://www01.ibm.com/support/docview.wss?uid=swg27022147.
3. In Eclipse, perspectives are a grouping of views and tools based on a particular role or
task. Integrated data management.
4. The default perspective is the Database Administration perspective.
5. True, Data Studio can be used at no charge with supported databases.
6. C. If you want to do .NET development, you must use the Visual Studio add-ins for
DB2. (See http://www.ibm.com/software/data/db2/ad/dotnet.html for more information)
7. E
8. B
9. C
10. B, the results appear in a separate tab in the Properties view.
11. The default user ID of the default administrative user is admin.
12. True. The Data Studio web console can be viewed by itself within a browser or
embedded within the Data Studio full or administration client.
13. B. Deploying data web services is not supported from the Data Studio web console.
14. The Task Launcher is the default view that opens the first time you log into Data Studio
web console.
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15. E. No additional steps are required to start using Data Studio web console after you
have added your first database connection.

Chapter 2
1. Select Add to Overview Diagram, and then select the list of tables you want to be
shown in the diagram and click OK.
2. Schema
3. Sharing connection information with others by the ability to export and import
connection information into a workspace.
4. Privileges tab.
5. D
6. B
7. A
8. D
Chapter 3
1. System-managed, database-managed, automatic storage.
2. Delimited (DEL), Worksheet format (WSF), and Integrated Exchange Format (IXF)
3. IXF, because structural information about the table is included with the export.
4. The two types of logging are circular and archive. Circular logging is only for
uncommitted changes. To restore, you need to go to the last backup image. Archive
logging logs all changes, committed and uncommitted and thus recovery can include
changes made up to a specified point in time.
5. Recover is a combination of restore and roll forward.
6. A
7. B
8. A
9. C
10. B
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Chapter 4
1. Yes, we can modify the default thresholds. You need to go to the Health Alerts
Configuration page and select a database and then edit the threshold for each alert
type.
2. The following alerts are supported:
o

Data server status: Creates an alert for different data server states including:
available, unreachable, quiesced, quiesce pending, and rollforward.

o

Connections: An alert is generated when the number of connections to the
database exceeds the threshold. This alert is disabled by default.

o

Storage: An alert is generated for the following situations:

o



The table space utilization exceeds the threshold.



The table space container utilization exceeds the threshold. This alert
is disabled by default.



The table space container is inaccessible.



The table space is in quiesced state.



The table space is offline.

Recovery: An alert is generated for the following situations:


The table space is in restore pending or rollforward pending state.



The table space is in backup pending state.



The table space is in drop pending state.



Primary HADR is disconnected.

o

Partition Status: An alert is generated when the status of a partition is
OFFLINE.

o

Status of DB2 pureScale members: An alert is generated if any of the DB2
pureScale members is in any of the following states: ERROR, STOPPED,
WAITING_FOR_FAILBACK, or RESTARTING.

o

Cluster Facility status of DB2 pureScale: An alert is generated if the pureScale
cluster facility is in any of the following states: ERROR, STOPPED, PEER,
CATCHUP, or RESTARTING.

o

Cluster Host Status of DB2 pureScale: An alert is generated if the DB2
pureScale cluster host status is INACTIVE.

3. You can share alerts with others by adding your comments using the Comment button
on the Alert List page and then sending an email to your colleague with those
comments.
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4. You need to configure the Data Studio web console in the Preferences in the Data
Studio client and then click on any of the integration points such as the Health
Summary, or Current Application
Chapter 5
1. Data development project and data design project
2. Default schema, used to set the database CURRENT SCHEMA register. Default path,
used to set the database CURRENT PATH register.
3. B
4. A
5. DB2 for Linux, UNIX and Windows (V10.1)
DB2 for Linux, UNIX and Windows (V9.8)
DB2 for Linux, UNIX and Windows (V9.7)
DB2 for z/OS (V10)
DB2 for z/OS (V9)
DB2 for i
Informix
6. Yes
7. C
8. JDBC and command line processor are the two available Run methods.
9. No
10. D
11. E
12. B
13. C
14. The SQL and XQuery editor has the following features: SQL statement syntax and
semantic validation, preferences for running SQL statements (Commit, Rollback), special
registers and the ability to start Visual Explain, Query Tuning and Job Manager for a
current script in the editor.
Chapter 6
1. FALSE. A job does not contain the database information or the date and time that the
job will run. This information is stored in a schedule. A job might have many schedules
associated with it, but each schedule can only be associated with one job.
2. To send notifications you must first configure the web console with the details about
your outbound SMTP mail server so that information can be sent to e-mail addresses.
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3. All jobs. When you run a job directly you assign the databases to run the job on.
Running the job directly also means that you do not need to set a date and time in a
schedule.
4. The job manager supports the following types of jobs:
o

SQL-only script

o

DB2 command line processor script

o

Executable/Shell script

5. Not specify the user ID and password that will run the job for the databases. The user
ID and password is specified in the database connection for each database.
Chapter 7


After a connection is set up, to enable the connection for query tuning, you need to:
A. Switch to the IBM Query Tuner perspective.
B. Connect to the database.
C. Right-click the database name and select Analyze and Tune -> Configure for
Tuning.
D. Configure the connection to create explain tables, either with the Guided
Configuration or Advanced Configuration and Privilege Management.





The no-charged query tuner features with IBM Data Studio 3.1 are:
A.

Query formatter

B.

Access plan graph and visual explain

C.

Statistics advisor

D.

Query tuner report

The query tuner can be started from:
A.
B.



The SQL and XQuery editor
A drop-down menu from the database connection in the Data Source
Explorer view

Query tuning features can be tailored using:
A.

Global preferences

B.

Advisor options



Analysis results are stored in a query tuner project in the Project Explorer.



D



B



A
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Chapter 8
1. You forgot to first Deploy the stored procedure with the Enable debugging option
selected.
2. The default schema, which is administrator ID (such as db2admin).
3. SQL Results
4. Variable
5. Breakpoints
6. B
7. D
8. C
9. A
10. A
The answer to the exercise is that the line SET p_in = 2;

should be SET p_out = 2

Chapter 9
1. Some advantages of using UDFs include: 1) Encapsulate reusable code and 2) extend
the SQL language with user-defined logic.
2. Scalar UDFs return a scalar value as a result. Table UDFs return a relational table as a
result.
3. One in which the result of the routine needs to be joined with an existing table
4. To encapsulate commonly used logic.
5.

UDF that receives multiple values as input and returns a scalar value as a result.

6. B
7. C
8. C
9. B
10. C

Chapter 10
1. HTTPGET, HTTPPOST, SOAP
2. The data web service has been modified but not yet deployed.
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3. Source view.
4. Named parameter markers
5. Bottom up
6. B.
7. D One in which the result of the routine needs to be joined with an existing table
8. C
9. C.
10. B.
Chapter 11
1. The five phases of the data lifecycle are: design, develop, deploy, operate, optimize
and govern. Governance is the aspect that needs to be considered across all phases
of the lifecycle.
2. The design phase is most is most concerned with translating business requirements
into a physical database representation? The main product for doing this is InfoSphere
Data Architect, perhaps in conjunction with other modeling tools such as Rational
Software Architect for WebSphere Software.
3. IBM Data Studio and InfoSphere Optim pureQuery Runtime can be used together to
create a high performance data access layer. You can develop with pureQuery on your
own computer with Data Studio. To deploy a pureQuery application on another
computer, you need to acquire InfoSphere Optim pureQuery Runtime.
4. InfoSphere Optim Performance manager is designed to find performance problems
before they become serious issues.
5. InfoSphere Optim Query Workload Tuner extends the basic query tuning capabilities in
Data Studio with additional tools and advisors to help SQL developers and database
administrators improve the performance of their queries.
6. DB2 Merge Backup minimize downtime by making it easier to create full backups (by
merging incremental and delta backups), which can shorten downtime when it is
necessary to recover the database.
7. The answer is C. Although metadata exchange is a key implementation approach to
integrated tools, it is not a goal.
8. The answer is B. The integration with Data Studio and InfoSphere Optim Performance
Manager enables you to see actual performance improvements and you develop and
tune queries. InfoSphere Optim Query Workload Tuner provides you with the tools and
advice to tune a single query or a set of related queries.
9. The answer is A, B, and D.
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10. The answer is D. Although Java data access should be developed with efficiency and
performance in mind, the optimize phase of the lifecycle generally reflects activities
around optimizing existing applications and resources.
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Appendix B – Advanced integration features for Data
Studio web console
This appendix is included for those who would like to use the advanced integration features
of Data Studio web console, such as embedding Data Studio web console in the Data
Studio full client, using a repository database to store configuration data, enable multi-user
configuration and privileges requirements for web console actions, and sharing database
connections between Data Studio client and Data Studio web console.

B.1 Integrating Data Studio web console with Data Studio full client
By integrating the web client with the full client you can access the Data Studio web
console health monitoring and job management features without leaving the Data Studio
client environment. You can use the health pages of the web console to view alerts,
applications, utilities, storage, and related information. You can also use the embedded job
manager pages to create and manage script-based jobs on your databases, as well as
schedule scripts as jobs directly from the SQL script editor.
To embed Data Studio web console you must install the product and point Data Studio full
client to the web console URL. See Chapter 1
1. In Data Studio client, select Window -> Preferences and then go to Data Management
-> Data Studio Web Console to configure the connection.
2. Enter the following information in the Preferences window, as shown in Figure B.1:
Data Studio web console URL: This is the URL that you use to connect to the web
console. The URL is of the form http://<server>:<port>/datatools, where
<server> is the name or IP address of the computer on which you installed Data
Studio web console, and <port> is the http or https port that you specified when you
installed the product, see Chapter 1.
User name: Enter the name of a user that can log into on the web console. If you have
not configured Data Studio web console for multi-user login you must log in as the
default administrative user that you created when you installed the product.
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Password: Enter the password of the user that you specified.
Specify how to open the web console. By default, the web console opens embedded in
the workbench. You can select to open the web console in an external browser instead.
Note:
If you decide to open the web console embedded in the Data Studio client, the web console
will not have all the features that the web console opened in a web browser has. Only the
job manager interface and health monitoring pages are included in the embedded interface.
In addition, the Task Launcher and Open menu are not included in the embedded web
console. To get the full featured web console interface you must open the web console in an
external browser. However, these extra configuration tasks are normally not needed for the
day to day use of web console.

Figure B.1 – Configure Data Studio full client for Data Studio web console
3. Open the Data Studio web console. From within the workbench, you can open the Data
Studio web console from the Administration Explorer, the Task Launcher, or the SQL
and XQuery editor.
User interface in the workbench

How to open the Data Studio web console

Administration Explorer

Right-click a database and select Monitor. Then select
the monitoring options, such as Health Summary or
Current Applications.

Task Launcher

Open the Monitor tab. Then select one of the monitoring
tasks, such as View a health summary or View alerts list.

SQL script editor

Click
in the menu bar to open the job manager and to
schedule the script that you are editing as a job.

Table 1 – Opening the web console from the Data Studio client
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4. If prompted, enter the Data Studio web console URL and login information. The Data
Studio web console opens on the selected page.

B.2 Using a repository database to store configuration data
When you install Data Studio web console, all user information and configuration settings
such as database connections, alert settings, and job management settings are stored
locally in system files.
By storing this data locally you can quickly get up and running with Data Studio web
console in a test environment with only one user. If you plan to use Data Studio web
console in a production environment, or if you plan to share the web console with other
users, you need to set up a repository database.
Using a repository database provides significant advantages over storing the information
locally:


A repository database can be accessed by multiple servers to allow for clustered
environments and scalability.



A repository database provides tools to help maintain transactional integrity, back up
and restore data, roll back data to a consistent state, replicate data, and more.



A repository database provides access control through database privileges.

To set up Data Studio web console to use a repository database:
1. Create a DB2 for Linux, UNIX, and Windows database to use as the repository
database. For information, see Chapter 2.2.1 Creating a new database.
2. Log in to Data Studio web console using the default administrative user ID.
3. If you have added database connections that you want to keep, you must manually
export these, and then import them to the repository database. To do this, in the web
console, click Databases, and then click Export All to export the existing database
connections to a text file on your computer. Note that other settings, such as alert
thresholds, notifications, and so on, are not retained when you move to a repository
database. To retain these settings you must manually reconfigure these.
4. Set up the repository database:
In the web console, select Open -> Setup -> Configuration Repository and then click
Select Repository Database to select the relational database that you created in step
1 as a repository for the Data Studio web console data. Note that the user ID that
you enter to connect to the repository database must have the authority to create
new tables and schemas on the database. Test the connection to the database and
then click OK to configure the repository database by having Data Studio web
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console install the required schemas.

Figure B.2 – Configuring the repository database
5. Import any existing database connections that you exported to a text file.
In the web console, click Databases, and then click Import to import the database
connections from the text file that you saved on your computer.
The Data Studio web console is now using the repository database to store database
connections, alert settings. You can now configure the Data Studio web console to run in
multi-user mode by configuring the product to use repository database authentication and
granting the users of the repository database access to the web console.
Note:
The repository database is not listed among the other database connections on the
Databases page. You can only connect to one repository database at a time. To see the
settings for the current repository database, select Open -> Setup -> Configuration
Repository and then click Select Repository Database.

B.3 Enabling console security and managing privileges in the web
console
If only one person will log in to Data Studio web console, you can continue using the
default administrative user that you have used to log in to the web console, but if more than
one user will share the web console and you want each user to have a unique log in user
ID you must set up the web console for multi-user mode.
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When you install Data Studio web console you enter the credentials for a default
administrative user that is used for login to the server. However, for day-to-day use in a
production environment where you should set up Console Security so that you can grant
appropriate privileges to users, groups, and roles that are defined on the repository
database.
You grant access to the repository database users in three steps:
1. Configure the web console for repository database authentication and grant the
users of the repository database web console access. You will also give them web
console roles such as Administrator or Viewer depending on if they will perform other
web console administrative tasks or just view the information in the web console.
2. Grant the web console users database privileges to perform tasks such as setting
alert thresholds on each of the connected databases.
3. Grant repository database privileges to web console users to perform tasks such as
managing jobs for the connected databases.

B.3.1 Configure the web console for repository database authentication
The Data Studio web console comes with two main authentication mechanisms:


Default administrative user login
This is the install-time default security mechanism. User login is limited to the default
administrative user ID that was created when you installed the product.
Administrators can use this option to temporarily restrict user login without stopping
the product.



Repository database authentication.
This is the multi-user security mechanism. Any user who can connect to the
repository database can be given access to the web console. The user's credentials
are authenticated directly against this database.

To use the repository database authentication mechanism:
1. Set up a repository database. For information, see B.2 Using a repository database to
store configuration data.
2. In the web console, select Open -> Setup -> Console Security.
Select Repository database authentication and click Apply. If prompted, log in with a
database administrator user ID and password for the repository database.
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Figure B.3 – Selecting repository database authentication for the web console
3.You can now grant web console access rights to the users of the repository
database. Click Grant, and then specify an ID and select the type for an existing
user, group, or role. You can then select the following types of privilege to grant the
ID on the web console:
Administrator
A user with the Administrator role can do any task in the web console, including
setup tasks, such as configuring logs, managing privileges, and adding database
connections.
Operator
This role is not used with Data Studio web console
Viewer
A user with the Viewer role has limited rights on the web console. The user can
view all pages, but cannot add database connections, configure logs, or manage
privileges.
Note:
The console security page only lets you configure access to the web console for users that
already exist on the repository database. To add users, groups, and roles to that database
you must have the appropriate access to the database. For information on how to add new
users to the repository database, see Chapter 2.5.1 Creating users.

B.3.2 Granting privileges to users of the web console
When you have granted web console access to the users, groups, and roles that need
access, you can configure Can Do privileges to perform tasks using the web console
individually for each user, group, or role of the repository database. The privileges are set
on either the database on which a task such as health monitoring is done, or on the
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repository database for tasks that require modifying data on the repository database, such
as job management.
The Can Do privileges on the connected database are required by default, and the Can Do
privileges on the repository database are not required. For example, only users with the
Can Manage Alerts privilege can modify the thresholds on the Health Alerts Configuration
page, but any user can schedule a job on a database. To configure the privilege
requirements for the web console, see B.3.2.3 Enable and disable privilege requirements.
B.3.2.1 Grant database privileges to the web console users
The Data Studio web console server typically monitors multiple databases from different
organizational units in an enterprise, so it is important that the users and privileges
boundaries defined in these databases are respected.
Data Studio web console lets you control the following privileges for users on each
database:
Can Monitor
This privilege is not used by Data Studio web console.
Can Manage Alerts
This privilege gives the user the right to set the alert thresholds and enable and disable
alert monitoring for a database. By default, this privilege is required.
To configure the web console to not require this privilege, see B.3.2.3 Enable and disable
privilege requirements.
For example, there are two databases called SALES and PAYROLL defined in a system.
Just because the database administrator for PAYROLL is able to log in to the web console
doesn’t mean that she should have the ability to modify alert settings for the SALES
database.
However, if the database administrator for the SALES database would like to allow other
database administrators to edit alert configurations for the SALES database, he can grant
the Can Manage Alerts privilege to another database administrator using the Manage
Privileges page under Open -> Product Setup, as shown in Figure B.4 .
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Figure B.4 – Granting user privileges on a database
B.3.2.2 Grant repository database privileges to the web console users
Two sets of privileges are set on the repository database, and apply to all connected
databases. Both of these privileges handle job management:
Can Manage Jobs
Any user with web console access can create and schedule jobs. By default, this privilege
is not required, and all web console users can manage jobs.
Can Run As Default User
When multiple databases are targets for a scheduled job the job will be run as the default
user ID that is stored with the database connection for each database. If the privilege is
enabled, the user that schedules the job must have the can Run As Default User privilege.
By default, this privilege is not required, and all web console users can run jobs as the
default user.
To configure the web console to require these privileges, see the next section.
B.3.2.3 Enable and disable privilege requirements
Depending on your environment, you might want to be more or less strict in limiting the
tasks that your users can perform. For example, you might want to allow all web console
users to be able to configure alerts on a database, but at the same time only allow subset
of your users to schedule jobs.
Data Studio web console lets you disable the privileges requirements for your databases
and for the repository database.
For example, to allow all users of the web console to configure alerts on a database, you
can disable the Can Manage Alerts privilege requirement under the Enable and Disable tab
on the Manage Privileges page. See Figure B.5.
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Figure B.5 – Enable and disable privileges requirements

B.4 Sharing database connections between Data Studio client and
Data Studio web console
If you plan to connect more than one instance of Data Studio full client to the same Data
Studio web console server it is advantageous to synchronize the database connection
profiles on the clients to the database connections that are stored on the Data Studio web
console. In this way the web console acts as a central repository for the database
connections and is accessible to all client users that have configured their clients to access
Data Studio web console for health monitoring or job management.
The database connection sharing is two-way. Just as the Data Studio client user can
import existing database connections from the web console, that user can also
automatically add existing database connection profiles to the web console by opening the
Current Application Connections, Current Table Spaces, or Current Utilities page for the
selected database. You can also manually add your database connections directly in the
Data Studio web console by opening the Databases page.
To synchronize the database connection profiles between two clients by using the Data
Studio web console as a database connection repository:
1. From the first Data Studio full client, in the Administration Explorer, select the database
whose connection you want to add to the web console.
2. Right-click the database and select any monitoring task from the menu. You can select
any one of these tasks:
- Application Connections
- Table Spaces
- Utilities
Data Studio web console opens to the page that corresponds to the selected task and
you are prompted for the login credentials to connect to the database.
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3. Supply the login credentials.
If the selected database does not exist in the Data Studio web console list of database
connections, a new database connection for that database is added.
4. In Data Studio web console, select Open -> Databases to see a list of the Data Studio
web console database connections and to verify that the database was successfully
added.
5. In the second Data Studio client, verify that your client is configured to work with the
Data Studio web console. Select Window -> Preferences and then go to Data
Management -> Data Studio Web Console to verify the configuration.
6. To import the shared database connections from the web console, from the
Administration Explorer, click
.
7. In the Import Connection Profiles wizard, verify that the URL for the Data Studio web
console server is the same that you used when you configured Data Studio full client to
connect to Data Studio web console, then click OK.
The database connections that are defined in the Data Studio web console are
imported to the Data Studio client, and are listed in the Database Connections folder in
the Administration Explorer view.
For more information about managing database connections in Data Studio, see the
developerWorks article entitled Managing database connections with the IBM Data Studio
web console at http://www.ibm.com/developerworks/data/library/techarticle/dm1111datastudiowebconsole/index.html
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Appendix C – Installing the Data Studio administration
client
This Appendix is included for those people who would like to use the Data Studio
administration client. As described in Chapter 1, the administration client is designed for
database administrators who have no need for Java, web services, or XML development
capabilities and who like the smaller footprint provided by this package.

C.1 Before you begin
Please remember to read the system requirements before you download. It references
important information like Java Runtime versions, Linux download tips, etc. For example,
for machines that have never run Java, you will need a JRE of 1.6 or higher for the
installer, which is InstallAnywhere (ISMP)-based. This allows the installer to launch.
Also, you can check out the discussion forum if you have questions.
To download the Data Studio administration client, find the link here:
http://www.ibm.com/developerworks/downloads/im/data/
After you register, you can select your platform – Windows or Linux, as shown in Figure
C.1.
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Figure C.1 – Select your platform from the download site
Select your platform, register, accept the license, and download the package.
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C.2 Installation procedure (assumes Windows)
1. After you unzip the package, double click on
ibm_data_studio_admin_client_v31_windows\install.exe The window
that is shown in Figure C.2 opens. Accept the license agreement and click Next.

Figure C.2 – Accept the license agreement
2. Specify the installation directory, or accept the default: C:\Program
Files\IBM\DSAC3.1 as shown in Figure C.3 and click Next.
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Figure C.3 – Select an installation directory
3. If all goes well, you will see the screen shown in Figure C.4 below, and you simply
need to click Done to start Data Studio. (If you would rather start Data Studio later from
the Start menu, simply deselect the Start IBM Data Studio box.)
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Figure C.4 – Select your platform from the download site
4. The Task Launcher is shown below in Figure C.5.
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Figure C.5 – Welcome screen for Data Studio administration client
You are immediately launched into the Database Administration perspective in a default
Workspace as shown in Figure C.6. (Note: You can use File -> Switch Workspace if you
have an existing project and workspace you want to use.)
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Figure C.6 – Default workspace for Data Studio administration client
Congratulations, you’ve successfully installed Data Studio stand-alone and are ready to get
to work!
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Appendix D – The Sample Outdoor Company
The Sample Outdoor Company is a fictional company used to help illustrate real-world
scenarios and examples for product documentation, product demos, and technical articles.
The sample database for the Samples Outdoor Company is used to illustrate many
different use cases, including data warehousing use cases. This book uses only a subset
of that database.
This appendix provides an overview of the schemas and tables that are used in many of
the examples and exercises used in this book.
Note:
The sample database can be downloaded from the Data Studio information center at:
http://publib.boulder.ibm.com/infocenter/dstudio/v3r1/topic/com.ibm.sampledata.go.doc/topi
cs/download.html

D.1 Sample Outdoor database data model (partial)
Figure D.1 shows the relationship among the tables used in the examples in this book.
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Figure D.1- Sample Outdoor data model
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D.2 Table descriptions
D.2.1 GOSALES schema
The GOSALES schema includes information about products and inventory.

D.2.1.1 GOSALES.BRANCH table
Row count: 29
The BRANCH table contains address information of each branch. Each branch has a
collection of employees with different roles, including sales representatives operating from
a regional base.
Not all branches have warehouses. The warehouse branch code is a repeating value of
the branch code, identifying the regions covered by a particular warehouse.

D.2.1.2 GOSALES.INVENTORY_LEVELS table
Row count: 53730
This table shows inventory for all warehouses. Only 11 of the 29 branches have
warehouses that maintain inventory.

D.2.1.3 GOSALES.PRODUCT table
Row count: 274
The company supplies sport gear for camping, climbing, and golfing. There are five product
lines, further subdivided into 21 product types. There are a total of 144 unique products, or
274 products when including color and size.

D.2.1.4 GOSALES.PRODUCT_BRAND table
Row count: 28
Products of the same brand are associated by a style or price point.
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D.2.1.5 GOSALES.PRODUCT_COLOR_LOOKUP table
Row count: 27
Product colors provide analysis by attribute. GO Accessories is the richest data source for
attribute analysis including color and size.

D.2.1.6 GOSALES.PRODUCT_LINE table
Row count: 5
There are five product lines, with each covering a different aspect of outdoor activity. Each
line is further subdivided into product types and products:


Camping Equipment



Mountaineering Equipment



Personal Accessories



Outdoor Protection



Golf Equipment

D.2.1.7GOSALES.PRODUCT_NAME_LOOKUP table
Row count: 6302
This lookup table contains the name of each product.

D.2.1.8 GOSALES.PRODUCT_SIZE_LOOKUP table
Row count: 55
Product sizes provide analysis by attribute. The GO Accessories company is the richest
data source for attribute analysis including color and size.

D.2.1.9 GOSALES.PRODUCT_TYPE table
Row count: 21
Each product line has a set of product types that define a functional area for outdoor
equipment. The product type lookup table contains the names of 21 product types.
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D.2.2 GOSALESCT schema
The GOSALESCT schema contains customer information.

D.2.2.1 GOSALESCT.CUST_COUNTRY table
Row count: 23
This table defines the geography for the online sales channel to consumers. The addition
of Russia and India make it different from the country table in the GOSALES schema.
There are no sales regions for India or Russia.

D.2.2.2 GOSALESCT.CUST_CRDT_CHECK table
Row count: 900
The customer credit check table contains the credit scores of consumers that make online
purchases.

D.2.2.3 GOSALESCT.CUST_CUSTOMER table
Row count: 31255
The customer table contains the name, address, and contact information of each customer.
All customers in this table are online shoppers paying the retail price for items sold by the
company or one of its partners.

D.2.2.4 GOSALESCT.GO_SALES_TAX table
Row count: 94
The Sample Outdoor sales tax table contains sales tax rates at a country level, or state
level if applicable.
Tax rates are for example only.

D.2.3 GOSALESHR schema
The GOSALESHR schema includes information used by the Sample Outdoor company
Human Resources department.
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D.2.3.1 GOSALESHR.EMPLOYEE table
Row count: 766
The employee table contains the static information that repeats for each detail in the
employee history table.
D.2.3.2 GOSALESHR.RANKING table
Row count: 5
The ranking dimension contains text descriptions of an employee's ranking. Ranking is
done annually and is one of the following values:
Poor
Satisfactory
Good
Very good
Excellent

D.2.3.3 GOSALESHR.RANKING_RESULTS table
Row count: 1898
This fact table maintains ranking data for each employee. Rankings are published in the
month of March based on the previous year.
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Appendix E – Advanced topics for developing data web
services
This appendix shows you how to take advantage of more capabilities with data web
services, including the following topics:


Consuming web services – using different bindings



Simplifying access for single row results



Handling stored procedure result sets



Using XSL to transform input and output results



Understanding data web services artifacts



Selecting a different SOAP engine framework

E.1 Testing additional web service bindings
You may have clients that require a different binding in order to consume the web service
response and which are not supported for testing in the Web Services Explorer. In this
section, we’ll review a couple of basic items you need to understand for using and testing
these additional bindings, including more detail on the location of the WSDL and the default
message XML schema. Then we’ll explain how to use each of the following bindings:


SOAP over HTTP: This is the binding described in Chapter 10. It is used with WSDLbased clients like SOAP frameworks, Enterprise SOA environments, and with service
registries such as the WebSphere Service Registry and Repository. We include it here
for completeness.



Web Access: HTTP GET: This is used for quick access from Web 2.0 clients and for
direct access from web browsers.



Web Access: HTTP POST URL-encoded: Used with more “traditional” HTML, such
as for submitting HTML forms.



Web Access: HTTP POST XML: Web 2.0, used by AJAX clients and JavaScript
frameworks using the asynchronous HTTPXMLRequest JavaScript method from a web
browser.



Web Access: HTTP POST JSON: Web 2.0, provides a direct way to parse messages
into JavaScript objects.

All service bindings are based on HTTP and, for demonstration purposes, we use cURL as
a lightweight, simple to use HTTP client.
Note:
cURL is a command-line tool for transferring files with URL syntax. Using the cURL
command line, a URL must be used to define where to get or send the file that is specified in
the command line. cURL is free software that is distributed under the MIT License and
supports several data transfer protocols. cURL compiles and runs under a wide variety of
operating systems. cURL uses a portable library and programming interface named libcurl,
which provides an interface to the most common Internet protocols, such as HTTP/HTTPS,
FTP/SFTP, LDAP, DICT, TELNET, and FILE.
Consult and download all documentation and binaries from the cURL Website at the URL
address:
http://curl.haxx.se/

E.1.1 Default XML message schemas
To test the SOAP over HTTP and HTTP POST (XML) binding you need to know the
structure (XML schema) of the request message. This information is contained in the
WSDL file, but you can also separately generate the XML schema for every operation in
the web service, as follows:
1. Right-click on the web service operation from within the Data Project Explorer and
select Manage XSLT…. Figure E.1 shows this for the RankEmployee operation
used in Chapter 10.
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Figure E.1 – Managing XSL transforms from the Data Project Explorer
2. From the Configure XSL Transformations window, click Generate Default. You will
be asked for a location to store the XML schema file as shown in Figure E.2. Keep
the default location, which points to your data development project folder. Keep the
proposed name SimpleService.RankEmployee.default.xsd.
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Figure E.2 – Saving the generated XML schema
3. Click Save. Data Studio generates the XML schema for the selected operation.
Close the Configure XSL Transformations window and refresh the data
development project by right-clicking the project and selecting Refresh. A new
generated XSD file is stored under the project's XML -> XML Schema folder. The
XSD extension may not be displayed.
4. Now you can use the Data Studio XML tools to create an XML instance document
from the XML schema using the XML instance generator. Locate the generated
XSD file in the XML -> XML Schema folder. Right-click the XSD file and select
Generate -> XML File.
5. In the New XML File window, select a name and destination for the XML file
instance. In Figure E.3, we select SimpleService.RankEmployee.default.xml as the
file name, since we want to create the XML request message for the
RankEmployee operation.
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Figure E.3 – Selecting an XML file name and location
6. Click Next. On the Select Root Element page, shown in Figure E.4, you need to
select the root element for your XML message from the XML schema. In this case,
there are two root elements available – RankEmployee and
RankEmployeeResponse. Select RankEmployee as the root element name, since
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this represents the element for the request message. Click Finish.

Figure E.4 – Select the root element from the XML schema
Note:
Data Studio always uses the operation name as the root element for the
request message and the operation name with “Response” as the suffix for the
response message.

7. Data Studio generates the XML instance document and opens it in the XML editor.
As shown in Figure E.5, switch to the Source view by clicking the Source tab in the
middle of the panel, and then change the value of the EMPLOYEE_CODE tag to
10004 and the RANKING value to Excellent.
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Figure E.5 – The generated XML instance document
8. Save the file. It is stored in the XML -> XML documents folder after refreshing your
data development project. When executing the SOAP binding for the
RankEmployee operation with the Web Services Explorer, you can see that the
generated SOAP request message content looks very similar, since both match
the same XML schema.
Repeat these steps for all operations you want to test using cURL.

E.1.2 SOAP over HTTP Binding
The first service binding we look at is SOAP over HTTP. We described how to test this
binding in Chapter 10 using the Web Services Explorer. In this section, we show you how
to re-create what the Web Services Explorer did for you before.
Start by assembling the SOAP request message by creating a new XML file called
RankEmployeeSOAP.xml. Into that file, copy and paste the SOAP request message
from the Source view of the Web Services Explorer (as shown in Listing E.1.)
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
xmlns:q0="http://www.ibm.com/db2/onCampus"
xmlns:xsd="http://www.w3.org/2001/XMLSchema"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<soapenv:Body>
<q0:RankEmployee>
<EMPLOYEE_CODE>10004</EMPLOYEE_CODE>
<RANKING>Excellent</RANKING>
</q0:RankEmployee>
</soapenv:Body>
</soapenv:Envelope>

Listing E.1 - The SOAP request message
Start the SOAP binding using the cURL command. To do this, you need to know the SOAP
over HTTP endpoint URL. Data web services has the following rules to get to the SOAP
endpoint URL:
http(s)://<server>:<port>/<contextRoot>/services/<ServiceName>
For the SimpleService example, the endpoint URL is:
http://server:8080/WebServicesSimpleService/services/SimpleServi
ce
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The cURL command to send the request to the web service should look like this:
curl.exe -d @RankEmployeeSOAP.xml
-H "Content-Type: text/xml"
-H "SOAP-Action:
\"http://www.ibm.com/db2/onCampus/RankEmployee\""
-v
http://localhost:8080/WebServicesSimpleService/services/SimpleService

Note:
Argument used:
-d @<filename>
Name of the file with the SOAP request message. This also forces cURL to use HTTP POST
for the request.
-H
Additional header fields need to be specified for the request. The server needs to know the
Content-Type, which is XML and the SOAPAction header, which can be found in the in the
binding section for the SOAP endpoint in the WSDL document. Note: The SOAPAction
String needs to be included in double quotes.
-v
The verbose switch to show detailed messages.
<url>
The URL to send the request to. This needs to be the SOAP over HTTP endpoint URL of
your web service. It can be found in the WSDL document or by using the Web Services
Explorer.
The output of the command should look similar to what is shown in Listing E.2:
* About to connect() to localhost port 8080 (#0)
*
Trying 127.0.0.1... connected
* Connected to localhost (127.0.0.1) port 8080 (#0)
> POST /WebServicesSimpleService/services/SimpleService HTTP/1.1
> User-Agent: curl/7.18.2 (i386-pc-win32) libcurl/7.18.2 OpenSSL/0.9.8h
libssh2/0.18
> Host: localhost:8080
> Accept: */*
> Content-Type: text/xml
> SOAPAction:"http://www.ibm.com/db2/onCampus/RankEmployee"
> Content-Length: 389
>
< HTTP/1.1 200 OK
< Server: Apache-Coyote/1.1
< Content-Type: text/xml;charset=utf-8
< Transfer-Encoding: chunked

Appendix E – Advanced topics for developing data web services

369

< Date: Sun, 28 Jun 2009 04:21:21 GMT
<
<?xml version="1.0" encoding="UTF-8"?><soapenv:Envelope
xmlns:soapenv="http://sc
hemas.xmlsoap.org/soap/envelope/"
xmlns:xsd="http://www.w3.org/2001/XMLSchema" x
mlns:xsi="http://www.w3.org/2001/XMLSchemainstance"><soapenv:Body><ns1:RankEmpl
oyeeResponse xmlns:ns1="http://www.ibm.com/db2/onCampus"
xmlns:xsi="http://www.w
3.org/2001/XMLSchema-instance"><row><RANKING_DATE>2009-0627T21:21:21.312Z</RANK
ING_DATE><RANKING_YEAR>2009</RANKING_YEAR><EMPLOYEE_CODE>10004</EMPLOYEE_C
ODE><R
ANKING_CODE>5</RANKING_CODE></row></ns1:RankEmployeeResponse></soapenv:Bod
y></so
apenv:Envelope>

Listing E.2 – The service response
If successful, the SOAP response message is displayed together with the HTTP header
fields for the request and response.
Note:
SQL NULL values are represented via the xsi:nil attribute; that is, xsi:nil=”true”
indicates an SQL NULL value.
When using the SOAP binding, your request gets routed through the SOAP framework at
the application server. Depending on the framework used, you can add additional
configuration artifacts – like SOAP handlers or WS-* configurations – to your web service.
But you can also use one of the more “simple” HTTP RPC (remote procedure call) bindings
described in the following sections.

E.1.3 HTTP POST (XML) Binding
The HTTP POST (XML) binding is similar to the SOAP binding. The difference from the
SOAP binding is that it does not get routed through a SOAP framework on the server side,
and the messages are not following the SOAP specification. Only the “plain” XML payload
is exchanged without the SOAP Envelope and SOAP Body tags. A simple HTTP POST
request is used to send the XML request to the server.
You can reuse the SimpleService.RankEmployee.default.xml file you created
before as the request message document.
You also need to know the REST endpoint URL in order to send your request. Data web
services has the following rules to get to the SOAP endpoint URL:
http(s)://<server>:<port>/<contextRoot>/rest/<ServiceName>/<Operati
onName>
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To start the RankEmployee operation of the SimpleService example, your endpoint
URL looks like this:
http://server:8080/WebServicesSimpleService/rest/SimpleService/Rank
Employee

Note:
The REST endpoint URL is used for all HTTP RPC bindings:
- HTTP POST (XML)
- HTTP POST (application/x-www-form-urlencoded)
- HTTP POST (JSON)
- HTTP GET
You can enable or disable all HTTP Bindings for a web service by selecting or deselecting
the REST (web access) option in the Deploy Web Service window described in Chapter
10.
The cURL command to send the request to the web service should look like this:
curl.exe -d @ SimpleService.RankEmployee.default.xml
-H "Content-Type:text/xml;charset=utf-8"
-v
http://localhost:8080/WebServicesSimpleService/rest/SimpleService/RankEmpl
oyee

E.1.4 HTTP POST (application/x-www-form-urlencoded) Binding
This binding can be used with HTML forms using the POST action. In this case, the
parameters are sent as key/value pairs, where each pair is separated by an ampersand
(‘&”).
You can also use cURL to test this binding. Create a new text file called
RankEmployeeUrlEncoded.txt. The content of your file should look like this:

EMPLOYEE_CODE=10004&RANKING=Excellent
The cURL command to send the request to the web service should look like this:
curl.exe -d @"RankEmployeeUrlEncoded.txt"
-H "Content-Type:application/x-www-form-urlencoded"
-v
http://localhost:8080/WebServicesSimpleService/rest/SimpleService/RankEmpl
oyee

The response message is the same as for the HTTP POST (XML) binding.
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Note:
The HTTP POST (application/x-www-form-urlencoded) binding is listed in the WSDL file
and can be tested using the Web Services Explorer as well. In case of the SimpleService
the binding is called SimpleServiceHTTPPOST.
SQL NULL values are treated as absent. This means parameter values that are not
present in the key/value string are set to SQL NULL. A parameter with an empty value is
treated as an empty string.

E.1.5 HTTP GET Binding
This binding uses the HTTP GET verb with a URL to start the web service operation. Since
there is no content sent to the server, all input parameters must become part of the URL.
This is done using the URL query string. Everything that follows the question mark “?’ sign
in a URL is specified as the query string. A query string consists of key/value pairs which
are concatenated using the ampersand ‘&’ character.
The cURL command that sends the request to the web service should look like this:
curl.exe -v
http://localhost:8080/WebServicesSimpleService/rest/SimpleService/RankEmployee?
EMPLOYEE_CODE=10004&RANKING=Excellent

Note:
The HTTP GET binding is listed in the WSDL file and can be tested using the Web Services
Explorer as well. In the case of the SimpleService, the binding is called
SimpleServiceHTTPGET.

Note:
Multi-byte characters in URL strings:
If your data contains multi-byte characters, you need to consider the following:


Multi-byte characters need to be provided in UTF-8


The UTF-8 bytes need be URL-encoded to follow the URI/URL specification. For
example, if you have a parameter value in Chinese like 日本語 your URL must look
like this:
http://localhost:8080/JmaWebService/rest/WebService/Test?p1=%E
6%97%A5%E6%9C%AC%E8%AA%9E
Application Servers and multi-byte UTF-8 characters in URLs:

You may have to perform some additional configuration steps at your application server to
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treat multibyte UTF-8 characters in URLs correctly.
Tomcat
With Tomcat, you need to add the attribute URIEncoding="UTF-8" to your <Connector>
configurations in the server.xml file. More details can be found here:
http://wiki.apache.org/tomcat/FAQ/Connectors
WebSphere Application Server Community Edition (WAS CE):
WAS CE ships Tomcat as its web container - but there is no server.xml file. Instead,
there is a Tomcat configuration section in the $WASCE_HOME/var/config/config.xml
file. You need to add <attribute name="uriEncoding">UTF-8</attribute> to the
<gbean name="TomcatWebConnector"> section. More details can be found here:
http://publib.boulder.ibm.com/wasce/V2.1.1/en/tomcat-configuration.html
SQL NULL values are treated as absent. This means parameter values that are not
present in the key/value string are set to SQL NULL. A parameter with an empty value is
treated as an empty string.
You can also easily test the HTTP GET binding with your web Browser. Simply enter the
URL into your browser to start the web service operation. Figure E.6 shows what the
RankEmployee operation looks like when you open it with Firefox.

Figure E.6 – The service response in a web browser window

E.1.6 HTTP POST (JSON) Binding
Finally, data web services provides you with a simple JSON binding that can be leveraged
from JavaScript applications –for example, when using AJAX with the XMLHttpRequest
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object. In order to test the JSON binding with cURL you need to create the JSON request
message first.
The building rules for a data web services JSON request message are as follows:
{"<operationName>":{"<parameter1>":<value1>,"<parameter1>":<value1>,...}}

Note:
JSON data type formatting:
The data type formats follow the JSON specification. Date, time and timestamp types are
expected to be provided in XSD format: xs:date, xs:time and xs:dateTime. Binary data
types are expected as base64 encoded strings. SQL NULL values are represented as JSON
null.
Create a new file called RankEmployeeJSON.txt. The content of the file should look like
this:
{"RankEmployee":
{"EMPLOYEE_CODE":10004,"RANKING":"Excellent"}
}

The cURL command to send the request to the web service should look this:
curl.exe -d @"GetBestSellingProductsByMonthJSON.txt"
-H "Content-Type:application/json;charset=utf-8"
-v
http://localhost:8080/WebServicesSimpleService/rest/SimpleService/RankEmpl
oyee

The output of the command should look similar to what is shown in Listing E.3.
...
< HTTP/1.1 200 OK
< Server: Apache-Coyote/1.1
< Cache-Control: no-cache, no-store, max-age=0
< Expires: Thu, 01 Jan 1970 00:00:01 GMT
< Content-Type: application/json;charset=UTF-8
< Content-Length: 129
< Date: Sun, 28 Jun 2009 04:48:26 GMT
<
{"RankEmployeeResponse":[{"RANKING_DATE":"2009-06-27T21:48:26.203Z","RANKING_YEA
R":2009,"EMPLOYEE_CODE":10004,"RANKING_CODE":5}]}

Listing E.3 – The service response
The response is also formatted as JSON.
Note:
Switching output format from XML to JSON:
For all HTTP RPC bindings, if the response should be returned as XML or JSON, you can
specify the _outputFormat control parameter (the initial underscore character marks it as
a control parameter) in the URL to define. For all bindings except HTTP POST (JSON), the
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output format is XML by default.
Example (HTTP GET with JSON response):
http://localhost:8080/WebServicesSimpleService/rest/SimpleService/RankEmployee?EMPLYE
E_CODE=10004&RANKING=Poor&_outputFormat=JSON

E.2 Simplify access for single-row results
You can use the Fetch only single row for queries option for query operations that you
know will return only a single row to reduce the complexity of the service response data
structure. It simplifies the message response by removing the <row> tag around the single
row result. Since it’s known that the query operation only returns one result row, the data
web services runtime can skip the row delimiter tag in the response.
The RankEmployee operation for example always returns a single row only. To remove
the <row> tag:
1. From the Data Project Explorer, right-click the operation in your web service and
select Edit, as shown in Figure E.7.

Figure E.7 – Editing options for an operation
2. Select the Fetch only single row for queries option and click Finish as shown in
Figure E.8.
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Figure E.8 – Specifying options for an existing operation
3. Re-deploy the web service to propagate your changes to the application server, as
described in Chapter 10.
When you open the RankEmployee operation, you will see that there is no <row> tag, as
shown in Listing E.4.
<?xml version="1.0" encoding="UTF-8"?>
<ns1:RankEmployeeResponse xmlns:ns1="http://www.ibm.com/db2/onCampus"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<RANKING_DATE>2009-06-27T21:57:08.109Z</RANKING_DATE>
<RANKING_YEAR>2009</RANKING_YEAR>
<EMPLOYEE_CODE>10004</EMPLOYEE_CODE>
<RANKING_CODE>5</RANKING_CODE>
</ns1:RankEmployeeResponse>

Listing E.4 – The RankEmployee response message without a <row> tag
Data web services also changes the XML schema for the response message in the WSDL
accordingly.

E.3 Processing stored procedures result sets
As was discussed in Chapter 10, there are some special considerations for stored
procedures that return result sets. Data Studio uses DB2 catalog information to generate
the XML schema file for the operation’s input and output messages. But the DB2 catalog
does not contain metadata information about result sets returned by stored procedures.
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Only the maximum number of result sets returned is known, which forces Data Studio to
assign a very generic result set definition represented by the
anonymousResultSetType, as shown in Listing E.6.
<complexType name="anonymousResultSetType">
<sequence>
<element maxOccurs="unbounded" minOccurs="0" name="row">
<complexType>
<sequence maxOccurs="unbounded" minOccurs="0">
<any processContents="skip"/>
</sequence>
</complexType>
</element>
</sequence>
</complexType>

Listing E.6 – The anonymousResultSetType
You can see the reference to the anonymousResultSetType in the XML schema definition
for the PRODUCT_CATALOG stored procedure response message, as shown in Listing E.5.
<element name="PRODUCT_CATALOGResponse">
<complexType>
<sequence>
<element maxOccurs="1" minOccurs="0" name="rowset"
type="tns:anonymousResultSetType"/>
</sequence>
</complexType>
</element>

Listing E.5 – Reference to the anonymousResultSetType
The generic result set information can cause problems with web service clients that rely on
the message schema provided with the WSDL file – as you could see in Chapter 10 with
the Web Services Explorer, where the result set content was not displayed correctly
(Figure 10.25).
Data Studio provides a way to circumvent this problem, but your stored procedure must
match the criteria that it always returns the same number of result sets with the same
metadata information for every possible invocation. If this is the case, you can add a
more detailed result set XML schema. Follow these steps to add the additional result set
information for the PRODUCT_CATALOG procedure:
1. From the Data Project Explorer, right-click the PRODUCT_CATALOG operation
and select Edit to open the Edit Operation window.
2. Click Next to open the Generate XML Schema for Stored procedure page, then
click Generate, as shown in Figure E.9.
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Figure E.9 – Generate XML schema for stored procedure
3. You will be prompted for input parameters in case the procedure has one or more
input parameters defined. Use Irons as the value for the PRODUCT_TYPE
parameter, as shown in Figure E.10.

Figure E.10 – Provide stored procedure input parameter
4. Click Finish and re-deploy your web service.
If compare the result from the Web Services Explorer shown in Figure E.11 with that shown
in Figure 8.25, you can see that the response is now displayed correctly.
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Figure E.11 – Stored procedure results now accurately mapped in the response
Note:
The result set XML message did not change. The only difference is the more verbose XML
schema for the operation response message.

If you look at the XML schema for the PRODUCT_CATALOG response message as shown
in Listing E.6, you can see that the reference to the anonymousResultSetType is gone.
Instead, there is now the actual column information for the result set.
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<element name="PRODUCT_CATALOGResponse">
<complexType>
<sequence>
<element name="rowset">
<complexType>
<sequence>
<element maxOccurs="unbounded" minOccurs="0" name="row">
<complexType>
<sequence>
<element name="PRODUCT_NUMBER" nillable="true" type="xsd:int"/>
<element name="PRODUCT_NAME" nillable="true" type="xsd:string"/>
<element name="PRODUCT_DESCRIPTION" nillable="true"
type="xsd:string"/>
<element name="PRODUCTION_COST" nillable="true"
type="xsd:decimal"/>
<element name="PRODUCT_IMAGE" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
</sequence>
</complexType>
</element>
</sequence>
</complexType>
</element>

Listing E.6 – Schema with verbose result set information

E.4 Transform input and output messages using XSL
You can assign an Extensible Stylesheet Language Transformation (XSLT) to one or more
of your operations to change the default XML input and output message format. This
feature allows you to customize the format of the messages that the client sees; for
example, to support industry standards or to changing or hiding default tag names in the
request and response messages. You can even generate non-XML outputs – like HTML
pages.
To give you some hands-on experience about stylesheets and what they can do for you,
we show you an easy way to transform your web service response into a service message
that is written in HTML format. All web browsers can interpret HTML code. As a result, you
can start your web service directly through a web browser and receive a formatted
response.
We use the GetBestSellingProductsByMonth operation and change its output into
HTML. You can simply use the HTTP GET binding to start the operation from a web
browser and verify the HTML response.

E.4.1 Creating an XSL stylesheet
Data Studio provides an XSL editor as well as the ability to test your XSL script. To create
a new XSL file:
1. Select File -> New -> Other -> XML.
2. Select your data development project as the parent folder and use the name
GetBestSellingProductsByMonthToHTML.xsl.
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3. Click Finish to create the XSL file. The new XSL file should appear in the XML ->
XSLT folder of your project as shown in Figure E.12.

Figure E.12 – XSL document in data development project
4. Double-click the file to open it with the XSL editor. For testing purposes we use a
rather simple XSL script shown in Listing E.7. Save the file.
<?xml version="1.0" encoding="UTF-8" ?>
<xsl:stylesheet xmlns:xsl="http://www.w3.org/1999/XSL/Transform" version="1.0">
<!-- use html as method to indicate that we generate HTML -->
<xsl:output method="html" encoding="UTF-8" media-type="text/html" />
<xsl:template match="/*">
<html>
<head>
<title>Best Selling Products</title>
</head>
<body>
<table border="1">
<tr bgcolor="#9acd32">
<!-- use XML tag names of the first row as table header -->
<xsl:if test="//row">
<xsl:for-each select="//row[1]/*">
<td style="width:150px">
<b>
<xsl:value-of select="local-name()" />
</b>
</td>
</xsl:for-each>
</xsl:if>
</tr>
<!-- iterate over all rows and fill the table -->
<xsl:for-each select="//row">
<tr>
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<xsl:for-each select="*">
<td style="width:150px">
<xsl:value-of select="text()" />
</td>
</xsl:for-each>
</tr>
</xsl:for-each>
</table>
</body>
</html>
</xsl:template>
</xsl:stylesheet>

Listing E.7 – XSL script transforming GetBestSellingProductsByMonth response
5. To assign the XSL stylesheet, right-click at the GetBestSellingProductsByMonth
operation and select Manage XSLT… as shown in Figure E 13.

Figure E.13 – Managing XSL transforms for a web service
6. Click the Browse button under Transformation of Output Messages and point to
your XSL stylesheet, as shown in Figure E.14.

382 Getting Started with IBM Data Studio for DB2

Figure E.14 – Configuring the XSL transformation
7. Click Finish and re-deploy your web service.
When you open the GetBestSellingProductsByMonth operation now from a
browser, you can see that the response is formatted as HTML. The URL to get the best
selling products for April looks like this:
http://server:8080/WebServicesSimpleService/rest/SimpleService/GetBestSell
ingProductsByMonth?MONTH=4

The response is shown in Figure E.15.
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Figure E.15 – Response transformed as HTML
Note:
When looking at the WSDL file you will recognize that
GetBestSellingProductsByMonth is missing in the SOAP binding. This is due to the
fact that now HTML is produced, but a SOAP message needs to be XML.

E.4.2 Data web services XSL Extensions
The data web services runtime provides a few XSL extension functions that allow you to
access the request URL, the request HTTP header fields, and set the HTTP response
header fields, shown in Table E.1.
Extension function
getHTTPRequestHeader(header)
getHTTPRequestURL()

Description
Returns the value for a given HTTP request
header
Returns the request URL
Returns the query string of the URL

getHTTPRequestQueryString()
setHTTPResponseHeader(header,
value)

Sets the value for a given HTTP response
header field

Encodes the string as JSON string – can be
used to generate custom JSON output
encodeJSON(value)
Table E.1 – Available XSL Extension functions
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The XSL stylesheet shown in Listing E.8 demonstrates some of the extension functions.
<?xml version="1.0" encoding="UTF-8" ?>
<xsl:stylesheet xmlns:xsl="http://www.w3.org/1999/XSL/Transform" version="1.0"
xmlns:xalan="http://xml.apache.org/xslt"
xmlns:java="http://xml.apache.org/xalan/java"
exclude-result-prefixes="xalan java">
<xsl:output method="html" encoding="UTF-8" media-type="text/html" />
<xsl:template match="/*">
<html>
<head><title>XSL Extension Test</title></head>
<body>
<table border="1">
<tr bgcolor="#9acd32">
<td colspan="2"><h2>Request URL</h2></td>
</tr>
<tr>
<td colspan="2"><xsl:value-of
select="java:com.ibm.datatools.dsws.rt.common.XSLExtensions.getHTTPRequestURL()"/></td>
</tr>
<tr bgcolor="#9acd32">
<td colspan="2"><h2>Request URL Query String</h2></td>
</tr>
<tr>
<td colspan="2"><xsl:value-of
select="java:com.ibm.datatools.dsws.rt.common.XSLExtensions.getHTTPRequestQueryString()"/></td>
</tr>
<tr bgcolor="#9acd32">
<td colspan="2"><h2>Request HTTP Header</h2></td>
</tr>
<tr>
<td>Content-Type</td>
<td><xsl:value-of
select="java:com.ibm.datatools.dsws.rt.common.XSLExtensions.getHTTPRequestHeader('ContentType')"/></td>
</tr>
<tr>
<td>User-Agent</td>
<td><xsl:value-of
select="java:com.ibm.datatools.dsws.rt.common.XSLExtensions.getHTTPRequestHeader('UserAgent')"/></td>
</tr>
<tr>
<td>Host</td>
<td><xsl:value-of
select="java:com.ibm.datatools.dsws.rt.common.XSLExtensions.getHTTPRequestHeader('Host')"/></td>
</tr>
<tr>
<td>Accept</td>
<td><xsl:value-of
select="java:com.ibm.datatools.dsws.rt.common.XSLExtensions.getHTTPRequestHeader('Accept')"/></td>
</tr>
<tr>
<td>Content-Length</td>
<td><xsl:value-of
select="java:com.ibm.datatools.dsws.rt.common.XSLExtensions.getHTTPRequestHeader('ContentLength')"/></td>
</tr>
</table>
<table border="1">
<tr bgcolor="#ffff44">
<td colspan="2"><h2>GET_CUSTOMER_NAME RESPONSE</h2></td>
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</tr>
<tr>
<td>First Name:</td>
<td><xsl:value-of select="//FIRST_NAME/text()"/></td>
</tr>
<tr>
<td>Last Name:</td>
<td><xsl:value-of select="//LAST_NAME/text()"/></td>
</tr>
<tr>
<td>Phone Number:</td>
<td><xsl:value-of select="//PHONE_NUMBER/text()"/></td>
</tr>
</table>
</body>
</html>
</xsl:template>
</xsl:stylesheet>

Listing E.8 – XSL script to test extension functions
1. Using the steps described in the previous section, create a new XSL file with the
name TestXSLExtensions.xsl and copy the information in Figure E8 into that
script.
2. Assign the TestXSLExtensions.xsl to transform the output message of the
GET_CUSTOMER_NAME operation and re-deploy the web service.
3.

Now, you can run the GET_CUSTOMER_NAME operation with HTTP GET using a
web browser. A URL to retrieve the information for a customer with the ID 126911
looks similar to this:

http://localhost:8080/WebServicesSimpleService/rest/SimpleService/GET_CUST
OMER_NAME?CUSTOMERID=126911

As you can see in Figure E.16, the response contains some information from the HTTP
request – like the request URL, some HTTP request headers, and the result of the
GET_CUSTOMER_NAME operation.
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Figure E.16 – XSL extension functions provide additional information to the result

E.5 A closer look at the generated runtime artifacts
Explaining all artifacts in detail is beyond the scope of this book. Here is a brief glimpse at
the files and structures. More information can be found in the documentation for JAVA EE,
WTP, Servlets, WebSphere Application Server Community Edition, and the SOAP
frameworks.
The data web services tools hook into the Web Tools Platform (WTP) framework, which is
an Eclipse-based JAVA EE development environment. Data Studio contains WTP. The
JAVA EE perspective is part of WTP.
http://www.eclipse.org/webtools/
Switch to the JAVA EE perspective to take a closer look at the generated runtime artifacts.
As shown in Figure E.17, the Project Explorer shows three projects. One is your
WebServices data development project whereas the other two are JAVA EE projects
representing the runtime artifacts for your SimpleService.
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Figure E.17 – The generated web service project in the JAVA EE perspective
Let’s take a brief look at those two generated projects for the SimpleService web
service:
WebServiceSimpleServiceEAR
This project represents an “Enterprise Application Archive” (EAR). It can be seen as a
container project for the actual web service. You can see that the
WebServiceSimpleServiceWeb is referenced under Modules. In addition, you can find
configuration files to define settings like context root or data source definitions.
WebServiceSimpleServiceWeb
This “Web Application Archive” (WAR) project contains the actual web service logic and
configuration. The structure of the project follows the Servlet specification.
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E.5.1 JAVA EE artifacts
File name
WebServiceSimpleServiceEAR/EarCo
ntent/META-INF/application.xml
WebServiceSimpleServiceWeb/WebC
ontent/WEB-INF/web.xml

Description
Contains configuration information about the
contained modules, like the context root.
Contains configuration information about the
web Application, including Servlet class names,
URL mappings, resource references, security
settings, etc.

Table E.2 – JAVA EE artifacts

E.5.2 SOAP framework artifacts
The configuration files for the SOAP engine vary depending on the selected SOAP
framework.
File name
Description
WebServiceSimpleServiceWeb//WebC Deployment descriptor file for the Apache Axis
ontent/WEB-INF/server-config.wsdd
1.4 SOAP engine.
Table E.3 – Apache Axis 1.4 deployment descriptor file

E.5.3 WAS CE artifacts
The configuration files for the application server may vary depending on the selected
application server. The WebSphere Application Server Community Edition Documentation
can be found here: http://publib.boulder.ibm.com/wasce

File name
WebServiceSimpleServiceEAR
/EarContent/META-INF/geronimoapplication.xml

Description
WAS CE extension configuration file for
Enterprise applications. It contains metadata
about the data source configuration, required
Java libraries, and other information.
WebServiceSimpleServiceWeb//WebC WAS CE extension file for web applications. It
ontent/WEB-INF/geronimo-web.xml
contains metadata about data source
references, required Java libraries, and other
information.
Table E.4 – WAS CE deployment descriptor files
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E.5.4 Data web services artifacts
File name
WebServiceSimpleServiceWeb//WebC
ontent/WEB-INF/config.xml

WebServiceSimpleServiceWeb//WebC
ontent/WEB-INF/lib/dswsRuntime.jar
WebServiceSimpleServiceWeb//WebC
ontent/WEBINF/wsdl/SimpleService.wsdl
WebServiceSimpleServiceWeb
/WEB/WebContent/WEB-INF/xslt

Description
Data web service configuration file. You can
find the mapping between operation names
and SQL statements as well as references to
XSL scripts and namespace declarations in
here.
The generic data web service Java runtime
library.
The generated WSDL file for your web service.

A folder which holds the XSL stylesheet you
assigned to your operations for input/output
message transformation.

Table E.5 – Data web services artifacts
If you are familiar with the generated artifacts you can start to do some customization –for
example, adding Servlets, JSPs, HTML pages, and advanced configuration like setting up
authentication/authorization, security, etc.

E.6. Selecting a different SOAP framework
The supported SOAP framework depends on the selected application server. You may
have the choice between multiple SOAP frameworks. For WAS CE, the following SOAP
frameworks are supported:


Apache Axis 1.4 (default) (http://ws.apache.org/axis/)



Apache Axis 2 (http://ws.apache.org/axis2/)



JAX-WS (http://jcp.org/en/jsr/detail?id=224)

You can select the SOAP framework by selecting the artifact.soapEngine property in the
Parameters table of the Deploy Web Service window, as shown in Figure E.18.

Figure E.18 – Selecting a SOAP framework in the Deploy Web Service window
The data web services tools do not add any SOAP framework libraries to the web
application. It is expected that the SOAP engine libraries are present at the application
server.
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